
Welcome to SureThingÒ CD Labeler!
www.surething.com 

Welcome to SureThing CD Labeler! With CD Labeler, you’ll be designing eye-catching CD labels, jewel 
case inserts and more in just a few minutes! 

CD Labeler includes a variety of unique features that allow you to quickly produce professional-looking 
designs. With features such as SmartDesigns, Design Sets, Text Effects and others, you can 
concentrate on the creativity of your design instead of the mechanics involved in producing it.

And if you’re a new user, check out our SureThing Tutorials to get started fast.

SureThing Tutorials: Learning to Use CD Labeler 
How to Use This Help
Menus and Commands
Keyboard Reference
Tools and Toolbars
Glossary



Purchasing SureThing CD Labeler
MicroVision Development, Inc.

Thank you for your interest in SureThing CD Labeler! You can easily contact us to order SureThing 
CD Labeler and Label Refill Packs either via the World Wide Web or by phone. Here’s how:

Ordering Online

For secure online ordering go to our web site at www.surething.com You’ll also find a wealth of 
information about the entire SureThing family of CD labeling products and accessories.

If you would like to email inquires, address them to: sales@surething.com

Ordering by Phone

To contact us by phone or fax, please select the most convenient option below:

 (800) 998-4555 Toll Free (U.S. Orders Only)
(760) 438-0305 Voice
(760) 438-7406 Fax



Help on Help

To find out how to use this Help file:

Review the instructions below. 
Press F1 with the Help file open.

 Contents Tab
Click the Contents tab to display topics organized by category. Double-click a book icon to see what 
topics are in that category. To see a topic, double-click it.

You can close a book by double-clicking it.

 Index Tab
Click the Index tab to display the Help Index. Type a topic you want to find or scroll through the list of 
index entries. Click the index entry you want, and then click Display.

 Find Tab
Click the Search tab to search for words or phrases that may be contained in a Help topic. You can 
type a few characters and use the word list below to see if any words match what you type.

For additional search options, click on the Find tab and press F1.

Using Context-Sensitive Help

You can click the Help button, if one is 
available, to view Help on the feature you 
are using. For example, click the Help button 
in the Print dialog box to view Help about 
printing and using the options in the Print 
dialog box. If a Help button is not available, 
press F1.

And speaking of F1, you can use this key in 
a variety of unique ways to view context-
sensitive Help. For example, open a menu 
and move the cursor to highlight a 
command. Then press F1 to see Help on that 
command!

CD Labeler provides help tips in some areas, 
such as wizard screens, to help explain more 
complicated procedures and helpful hints to 
make your work with CD Labeler more 
productive.

SureThing Tutorials
Learning to Use CD Labeler

Use these tutorials whether you're just getting started or learning more advanced features. Each 
tutorial should take only a few minutes to complete. Many contain step-by-step instructions you can 
try out yourself in CD Labeler.

Quick Start: Creating a New Design
Using SmartDesigns
Working in the Design Area
Using Backgrounds
Using Layouts 
Using Fonts 
Adding Images 
Working with Text Frames 
Working with Objects 
Creating Text Effects 



Creating Labels Sets by Duplicating Designs 
Printing 
Scanning Images and Backgrounds 
Creating a Custom Label Template
Working with Playlists



QuickStart: Creating a New Design

{button Tutorials,JI(`',`Tutorials')} {button Start >>,Next()} 

The CD Labeler New CD Wizard lets you create a new design quickly and easily¾just by answering a 
few questions. CD Labeler automatically fills in everything for you when it creates the design. After 
that, you can modify text, backgrounds and so on for your own specific needs.

Getting started couldn't be any quicker or easier!

 

This tutorial covers the following topics. You 
can select them individually, if you wish. 
However, we recommend advancing 
through the topics in order by clicking the 
Start button above.

Using the New CD Wizard 
Selecting the Label Stock 
Selecting a Custom Background 
Selecting the Label Type and SmartDesign 
Finishing the New CD Wizard 
Customizing with the SmartDesign Variation Bar
Using the SmartDesign Variation Controls
Customizing Your Design with the Design Bar
Changing Text on the SmartDesign
Editing a Text Frame
Editing a Text Effect Object
Saving Your Design
Printing Your Design



Using the New CD Wizard

{button Tutorials,JI(`',`Tutorials')}    {button 
Beginning,JI(`',`Tutor_Create_Design00')}    {button << Prev 
Page,Prev()}    {button Next Page >>,NEXT()} 

 Click 

 on the Command Bar. The CD Labeler New CD Wizard is displayed. 
Note: As you progress through the wizard, you can click Finish at any time to create the 

design based on the selection you have made up to that point.



Selecting the Label Stock

{button Tutorials,JI(`',`Tutorials')}    {button 
Beginning,JI(`',`Tutor_Create_Design00')}    {button << Prev 
Page,Prev()}    {button Next Page >>,NEXT()} 

 If the type of product you are using is not already selected under Product Types, select it from 
the list.

 
Select the label you are using under Label Products. Click Next.
Note: Some manufacturers have more than one product, so be sure to choose the correct 

one. A preview of the label is displayed as you select a product, which should help you choose. Consult 
your product packaging for details about your label, if necessary.

Click Next.



Selecting a Custom Background

{button Tutorials,JI(`',`Tutorials')}    {button 
Beginning,JI(`',`Tutor_Create_Design00')}    {button << Prev 
Page,Prev()}    {button Next Page >>,NEXT()} 

 To select or change the label background, click Browse and select from the backgrounds that 
come with CD Labeler. 

 Use the tree structure in the left pane to narrow your search of background types. Use the 
scroll bars to see additional choices. Double-click on the one you wish to use.

Note: Click Clear if you wish to clear the background.
 Click Next.



Selecting the Label Type and SmartDesign

{button Tutorials,JI(`',`Tutorials')}    {button 
Beginning,JI(`',`Tutor_Create_Design00')}    {button << Prev 
Page,Prev()}    {button Next Page >>,NEXT()} 

 Click on the type of label you wish to print, such as Audio CD. 
 Use the SmartDesigns Variation Bar to select a label layout:

 
Click on the 

 arrow to advance to the next selection. Notice how your design changes. 
Click on the 

 arrow to move back to the previous selection. 
Click and hold the 

 or 
 arrow to scroll through the selections. 

Click on the name in the control to pop up a menu with the available choices. 
Note: Uncheck the SmartDesigns checkbox if you wish to design your own label. You should use 
SmartDesigns unless you have a compelling reason to customize your own design. The 
background will be included in the design but will not have any SmartDesign objects added to it.

 Click Next.



Finishing the New Label Wizard

{button Tutorials,JI(`',`Tutorials')}    {button 
Beginning,JI(`',`Tutor_Create_Design00')}    {button << Prev 
Page,Prev()}    {button Next Page >>,NEXT()} 

 If you are creating an audio or data CD, you can check the Import Playlist option to get audio 
or data information from your CD and add it to your label. If there is no CD data, you'll have the 
option of getting it from the Internet (audio CDs), creating your own, or skipping it.

Working with Playlists
 Click Finish. 

CD Labeler creates the design based on your selections. You can customize your design by continuing 
this tutorial.



Customizing Your Design with the SmartDesign Variation Bar

{button Tutorials,JI(`',`Tutorials')}    {button 
Beginning,JI(`',`Tutor_Create_Design00')}    {button << Prev 
Page,Prev()}    {button Next Page >>,NEXT()}

You may wish to make a few changes to your new design, such as selecting a different layout or 
perhaps you would like to change the font used in the design. SmartDesigns makes this easy to do.

SmartDesigns are "intelligent templates"¾built into CD Labeler¾which aid you in creating a distinctive 
and consistent look to your design. Unlike traditional templates, which simply place a few objects on a 
page and leave the rest up to you, SmartDesigns allow you to modify your design using the Variation 
Bar at the bottom of the design area.

 
Note: If you don't see the Variation Bar, open the View menu, choose View Options, then select the 
Show Variation Bar command.
The Variation Bar controls three different aspects of your design:

Background Picture
Layout Style (shown above)
Font Style

We suggest you make your SmartDesign choices in that order. First, find a background, if you plan to 
use one. Second, choose a layout that utilizes the type of information you want on your design. And 
third, choose a font set, which changes all the text in your design.

Using SmartDesigns



Using the SmartDesign Variation Controls

{button Tutorials,JI(`',`Tutorials')}    {button 
Beginning,JI(`',`Tutor_Create_Design00')}    {button << Prev 
Page,Prev()}    {button Next Page >>,NEXT()}

Follow these steps to learn the different ways you can use the SmartDesign variation controls:

 Decide which effect you wish to change, such as Layout Style. 

 
 To advance to the next variation, click the 

 arrow. Notice how your design changes.
Note: If you have already made formatting changes before you click on a SmartDesign choice, 

you may be warned that your formatting changes will be lost. You may wish to make your final 
SmartDesign selections before you begin customizations.

 To move back to the previous variation, click the 
 arrow. You can also click and hold the 
 or 
 arrow to scroll through the selections.

 You can pop up a list of all variations by clicking on the name in the control. Use the scroll bar 
to see all the choices.

 
Using Layouts



Customizing Your Design with the Design Bar

{button Tutorials,JI(`',`Tutorials')}    {button 
Beginning,JI(`',`Tutor_Create_Design00')}    {button << Prev 
Page,Prev()}    {button Next Page >>,NEXT()}

The CD Labeler Design Bar makes trying out new design effects incredibly easy. 

To see what a design tool does, hold the mouse cursor over the icon. A brief explanation 
appears.

To use the design tool, click on it to display a menu of related options. Click on any option in 
the menu.

Pick from a wide variety of backgrounds 
that are applied to your design 
instantaneously. They're all built right in to 
CD Labeler.

Using Backgrounds 

Browse through thumbnails of logos, 
clipart and CD and media symbols¾or go 
straight for the filename of your own 
pictures.

Adding Images 

Make your designs stand out with Text 
Effects. Wrap text around curves, set it on 
an angle or an arch, rotate it, etc. Create 
full-colored text fills and drop shadows.

Creating Text Effects 

While we recommend browsing CD 
Labeler's layouts first, you may need to 
add a text frame from time to time. You 
can do so with this button.

Adding Text Frames

Add audio playlist and data lists to your 
label design using a variety of local and 
online sources.

Adding Playlists

Note: You can change the appearance of the Design Bar icons so that they appear in full color or 
blend in with your desktop appearance. From the Tools menu, choose Program Options, and then click 
the Appearance tab. Select either Full Color or Blend to Desktop under Icon Color Treatment. 

You can also access this by right-clicking over the Design Bar area and choosing Program Options from 
the menu that appears.



Changing Text on the SmartDesign

{button Tutorials,JI(`',`Tutorials')}    {button 
Beginning,JI(`',`Tutor_Create_Design00')}    {button << Prev 
Page,Prev()}    {button Next Page >>,NEXT()}

SmartDesigns places generic text in frames when you first create a design. You can then change the 
information in the text frames to whatever is appropriate for the label you are printing. You may not 
need to change all of the information on the label, but most likely some of it. 

There are two different types of text, which you'll find on most SmartDesign labels:

 
A simple text frame, such as the "Subtitle or Other Info" text frame shown above. You can edit 

this text by clicking anywhere in the text frame.
A text effect object, such as the "Your CD Title" text shown above. You can edit the properties 

of this object to change the actual text that is displayed.
You'll learn how to edit these text frames later in this tutorial.



Editing a Text Frame

{button Tutorials,JI(`',`Tutorials')}    {button 
Beginning,JI(`',`Tutor_Create_Design00')}    {button << Prev 
Page,Prev()}    {button Next Page >>,NEXT()}

 Click the 

 tool. 
Click on the text frame you wish to edit. 

 
For example, you may wish to select the existing text by highlighting it with the cursor and 

then typing your own text to replace it.

 
Repeat Step 2 to edit any other text frames.

Note: You may wish to use the Tab key to move through all the SmartDesign text frames when 
changing data. This ensures you won't miss anything!

Working with Text Frames



Editing a Text Effect Object

{button Tutorials,JI(`',`Tutorials')}    {button 
Beginning,JI(`',`Tutor_Create_Design00')}    {button << Prev 
Page,Prev()}    {button Next Page >>,NEXT()}

 Click on the text effect object. A "red box" with sizing handles is displayed.

 
 Double-click anywhere on or inside the red box. The Text Effect dialog box is displayed.
 On the Effect tab in this dialog box, edit the text in the window (shown below) to whatever 

you want printed on your label.

 
Click OK. Your label now shows your text in place of the generic text.

Creating Text Effects 



Saving Your Design

{button Tutorials,JI(`',`Tutorials')}    {button 
Beginning,JI(`',`Tutor_Create_Design00')}    {button << Prev 
Page,Prev()}    {button Next Page >>,NEXT()}

Now that you've created a great-looking design, you'll probably want to save it. Then you can open it 
any time you need it. 

Click the 

 button on the Command Bar. The Save As dialog box is displayed with the file name 
highlighted.

Type in a name for your design.

 
Note: CD Labeler saves all your designs in the Docs folder unless you tell it otherwise. We 

suggest you keep them all in the same folder so you won't "lose" them.
Click Save.



Printing Your Design

{button Tutorials,JI(`',`Tutorials')}    {button 
Beginning,JI(`',`Tutor_Create_Design00')}    {button << Prev 
Page,Prev()}    {button Done,JI(`',`Tutorials')} 

Now that you've created a new design, you're probably anxious to print it.

Click 

. The Print dialog box is displayed.
Since most label sheets come with two labels on them, we'll show you how to print either one 

label or two.
 CD Labeler always defaults to print just one copy of your label. The Sample window shows 

only one label displayed in cyan. This is the label that will be printed.

You can click on either label in the Sample window to print on that label. This is useful if you have 
already used the other label.

 If you wish to print two copies of your label, either change the number to 2 or simply click 
Pages. Notice that now both labels are displayed in cyan.

Prepare your printer with labels, and click OK.
Note: When you select the number of copies of labels or pages you wish to print, CD 
Labeler tells you how many sheets of labels you will need, depending on the product you 
are using.

 
CD Labeler provides many more printing options, which are described in greater detail in the Printing 
tutorial. You can also click Help in the Print dialog box to see a complete description of all your printing 
options.



Using SmartDesigns

{button Tutorials,JI(`',`Tutorials')} {button Start >>,Next()} 

SmartDesigns puts a design professional inside your computer, automatically creating designs for the 
most common tasks. Variations for layout, graphic elements and font selections are just a mouse click 
away!

 This tutorial covers the following topics. You 
can select them individually, if you wish. 
However, we recommend advancing 
through the topics in order by clicking the 
Start button above.

What are SmartDesigns? 
Why Use SmartDesigns?
SmartDesigns and the Variation Bar
Controlling Backgrounds, Layouts and Fonts
Getting the Most from SmartDesigns
Using the SmartDesign Controls
More About Using SmartDesigns
Applying a Different Label Stock to Your SmartDesign
Using the "Clip to Label" Feature



What are SmartDesigns?

{button Tutorials,JI(`',`Tutorials')}    {button 
Beginning,JI(`',`Tutor_SmartDesigns00')}    {button << Prev 
Page,Prev()}    {button Next Page >>,Next()} 

SmartDesigns are "intelligent templates"¾built into CD Labeler¾which aid you in creating a distinctive 
look to your design. Unlike traditional templates, which simply place a few objects on a page and leave 
the rest up to you, SmartDesigns allow you to modify many different aspects of the design.

SmartDesigns knows everything about the design type you select. Design factors such as physical 
dimensions, how many are laid out on a page and where they are positioned are completely built into 
SmartDesigns. 

SmartDesigns builds and positions elements such as text frames, graphic accents and pictures, which 
are placed in the design quickly and easily.



Why Use SmartDesigns?

{button Tutorials,JI(`',`Tutorials')}    {button 
Beginning,JI(`',`Tutor_SmartDesigns00')}    {button << Prev 
Page,Prev()}    {button Next Page >>,Next()}

There are a number of very good reasons to use SmartDesigns:

You’ll save time!

You’ll stop wasting labels!

You’ll actually enjoy making CD labels!

SmartDesigns adjust automatically to the selections you make¾and adjust the selections you can 
make as you make changes. You literally can't make a bad choice!

Need to change labels in the middle of a design? 

Don't worry about it! SmartDesigns keeps track of your design and adjusts to the new label you select. 
You won't waste time making incorrect adjustments and you won't waste labels with constant 
reprinting.



SmartDesigns and the Variation Bar

{button Tutorials,JI(`',`Tutorials')}    {button 
Beginning,JI(`',`Tutor_SmartDesigns00')}    {button << Prev 
Page,Prev()}    {button Next Page >>,Next()}

SmartDesigns helps you take control of the creativity of designing labels¾not the mechanics¾through 
the use of the SmartDesign Variation Bar. 

 
The Variation Bar resides near the bottom of the design area. If you don't see the Variation Bar, do 
one of the following:

From the View menu, choose View Options, then select the Show Variation Bar command. 
Right-click just beneath the design area, and choose Show Variation Bar.

The SmartDesigns variation controls let you try out different design styles simply by browsing the 
available choices in each control. 

 
You'll see the affect it has on your design as you scroll through each choice! 

Using Layouts



Controlling Backgrounds, Layouts and Fonts

{button Tutorials,JI(`',`Tutorials')}    {button 
Beginning,JI(`',`Tutor_SmartDesigns00')}    {button << Prev 
Page,Prev()}    {button Next Page >>,Next()}

The Variation Bar for CD Labeler controls three different aspects of your design. If you're unsure of 
which control to use, hold the cursor over the control and it will be identified.

Background Picture

The left variation control lets you select a background for your SmartDesign or to select No 
Background. 

 
You can pick from a wide variety of backgrounds that are instantaneously applied to your design.

Using Backgrounds

Layout Style

The center variation control lets you change the layout of text and graphic objects on your design.

 
Objects are placed in different positions depending on the layout selected. They can then be modified 
to fit your particular needs, if necessary.

Using Layouts

Font Style

The right variation control lets you select from a variety of fonts that come with CD Labeler.

 
Font styles change the overall look of your text and text effect objects. The font is applied to the entire 
design.

Using Fonts



Getting the Most from SmartDesigns

{button Tutorials,JI(`',`Tutorials')}    {button 
Beginning,JI(`',`Tutor_SmartDesigns00')}    {button << Prev 
Page,Prev()}    {button Next Page >>,Next()}

In order to get the most from the three design aspects controlled by the Variation Bar, we suggest 
refining your design in a visually logical order. You should make these selections before moving objects 
around or overriding formatting, but not necessarily before entering your own text.

 Find a background, if you plan to use one. Knowing what your background will look like will 
help you select the right layout for your design.

Using Backgrounds
 Choose a layout style. This sets the actual information and special logos that will appear on 

your design. There are many different types of objects, which are not used on all layouts. The layout 
you choose should provide the type of information you need on your label. You'll see the layout change 
as you browse through the choices.

Using Layouts
 Select a font for your overall design. You'll see how the font looks as you browse through the 

choices. You can always change individual text later, if you wish.
Using Fonts



Using the SmartDesign Variation Controls

{button Tutorials,JI(`',`Tutorials')}    {button 
Beginning,JI(`',`Tutor_SmartDesigns00')}    {button << Prev 
Page,Prev()}    {button Next Page >>,Next()}

 Choose the effect you wish to change, such as Layout. 

 
 Click on the 
 arrow to advance to the next selection. Notice how your design changes.

Note: If you have already made formatting changes before you click on a SmartDesign choice, 
you may be warned that your formatting changes will be lost. You may wish to make your final 
SmartDesign selections before you begin customizations.

 You can click on the 
 arrow to move back to the previous selection. Click and hold the 
 or 
 arrow to scroll through the selections.
 Click on the name in the control to pop up a menu with the available choices. 

 
You can select a specific entry in the list or use the up and down arrow keys to scroll through 

the list, while viewing the layouts in your design.



More About Using SmartDesigns

{button Tutorials,JI(`',`Tutorials')}    {button 
Beginning,JI(`',`Tutor_SmartDesigns00')}    {button << Prev 
Page,Prev()}    {button Next Page >>,Next()}

It's easy to get started, creating great looking designs even the first time you use it. Here are some 
more helpful tips to get you going: 

Fields created by SmartDesigns contain sample text, which gives an example of its intended 
purpose. 

Use the tab key to move through the SmartDesign text frames when changing data. This 
ensures you won't miss anything!

In some cases, where a field is applicable to your User Information, SmartDesigns inserts the 
information found in the User Information tab in the Program Options dialog box.

In 
 text mode, select and edit text just like you would in a word processor or edit box.

In 

 object mode, double-click on text boxes, pictures, drawing objects and text effect objects to edit 
the object's properties.

Double-click on text effect objects to manipulate these versatile text design features.



Applying a Different Label Stock to Your SmartDesign

{button Tutorials,JI(`',`Tutorials')}    {button 
Beginning,JI(`',`Tutor_SmartDesigns00')}    {button << Prev 
Page,Prev()}    {button Next Page >>,Next()}

Well, you bought a new box of labels and your dreading the hours you'll need to completely adjust 
your label design. But wait! You have CD Labeler with SmartDesigns! This change will take just a few 
seconds! You realize now you'll never put off trying different labels again!

 Open the design you wish to change.
 From the Edit menu, choose Change Label Stock. The Change Label Stock dialog box is 

displayed.
 Click on the label you will be using in the New Stock column.

 
Not all labels are the same. If you do not see the label listed, uncheck the blocks in the Blocks to 
apply column that do not apply to your label. Your label should appear in the New Stock column.

 Click OK to apply the new label stock to your design. SmartDesigns adjusts the design 
accordingly.



Using the "Clip to Label" Feature

{button Tutorials,JI(`',`Tutorials')}    {button 
Beginning,JI(`',`Tutor_SmartDesigns00')}    {button << Prev 
Page,Prev()}    {button Done,JI(`',`Tutorials')} 

All CDs are created equal… that is, they are all round and they all have a center hole! If you use 
custom graphics for backgrounds, the clip to label feature lets you see what your background image 
will look like when it is printed on your CD label. And you won't have to create a round graphic with a 
center hole! A rectangle will do just fine. 

Not Clipped Clipped

You won't have to waste time and labels determining where the image will be clipped. And you can 
make adjustments to your image, if necessary, just by viewing the design. And when you do get ready 
to print, you won't waste ink printing an area you're going to throw away anyway. Of course, if you 
choose from CD Labeler's wide variety of backgrounds, the designs have already been created with 
the CD label in mind.

To clip your background image:

 From the View menu, choose Clip to Label if it's not already "checked."

 
Using Your Own Custom Backgrounds
Using Layouts



Working in the Design Area

{button Tutorials,JI(`',`Tutorials')} {button Start >>,Next()} 

The CD Labeler design area lets you work with your label designs in a variety of unique ways. You'll be 
able to manipulate both text and objects, choose backgrounds and clipart, create multiple designs in 
one file and adjust the design area so it works the way you work.

 This tutorial covers the following topics. You 
can select them individually, if you wish. 
However, we recommend advancing 
through the topics in order by clicking the 
Start button above.

Switching Between Text and Object Modes 
Using the Zoom Feature
Selecting a Design Block Folder
Selecting Objects with the Mouse
How to Select a Single Object with the Mouse
How to Select Multiple Objects with the Mouse
Selecting Objects Behind Other Objects
Scrolling Through Multiple Designs
Customizing the Design Area



Switching Between Text and Object Modes 

{button Tutorials,JI(`',`Tutorials')}    {button 
Beginning,JI(`',`Tutor_Design_Area00')}    {button << Prev Page,Prev()} 
{button Next Page >>,Next()} 

In order to manipulate text and objects, you can work in one of two design modes¾text mode and 
object mode. Each mode has its own button on the Control Strip. The mode you are currently using is 
the one that is "depressed." To switch to the other mode, simply click on the button.

 
 Text Mode. Enter, edit, and format text. The cursor changes to the Windows "I-Beam" which 

lets you click anywhere in a text frame, highlight text and so on. You can still select objects while in 
text mode by clicking near their borders.

 Object Mode. Create, modify, and position graphic objects, pictures, text frames, and tables. 
This is sometimes called pointer mode because you switch to this mode by clicking the pointer button. 
Most format functions can also be applied to text frames in pointer mode.
When you select text or object mode, CD Labeler automatically knows which commands are available. 
If a command is unavailable, it is grayed out in the menu.

 Most Format menu commands (except for Borders, Lines, and Shades), for example, are not 
used to manipulate objects. 

 Likewise, most of the Object menu commands are unavailable when you are in text mode. 
 Text frames possess attributes that are edited using both modes. The text contained within a 

text frame is edited in text mode, but the frame itself¾its size, position, border, and fill attributes¾are 
edited in object mode.



Using the Zoom Feature

{button Tutorials,JI(`',`Tutorials')}    {button 
Beginning,JI(`',`Tutor_Design_Area00')}    {button << Prev Page,Prev()} 
{button Next Page >>,Next()}

As you work in the design area, you will probably need to zoom in and out of your design in order to 
work with different objects on the design. If you want to view a background for example, zooming out 
lets you see the entire label. On the other hand, if you are editing text, you may wish to zoom in to 
get a closer look at the text frame.

The easiest way to zoom in and out is by clicking the zoom buttons on the Control Strip or by using 
the shortcut keys.

Butto
n

Shortcut Function

Ctrl + Zooms in by 50% each time you click.

Ctrl - Zooms out by 50% each time you 
click.

Fits the label into the design window.

You can also zoom to a specific percentage using the Zoom command on the View menu. You can click 
on a zoom percentage or enter your own from 30 to 400%.

 



Selecting a Design Block Folder

{button Tutorials,JI(`',`Tutorials')}    {button 
Beginning,JI(`',`Tutor_Design_Area00')}    {button << Prev Page,Prev()} 
{button Next Page >>,Next()}

 

Many label sheets, especially 
media labels for products 
such as CDs, actually have 
more than one type of label 
on the sheet. 

For example, a CD label can 
have a label for the CD itself 
as well as labels for the jewel 
case spine. 

Some labels even combine 
products such as CDs and 
diskettes. This is great for you 
because you get more 
choices.

However, it would be a design nightmare if CD Labeler and SmartDesigns didn't come to the rescue! 
With SmartDesigns, each label type is separated onto a design "block" or "folder." To choose a block, 
just click on its folder tab. Whew that was tough wasn't it!

 
And of course, SmartDesigns helps with the technical stuff of layout, fonts, backgrounds and so on for 
each design block.



Selecting Objects with the Mouse

{button Tutorials,JI(`',`Tutorials')}    {button 
Beginning,JI(`',`Tutor_Design_Area00')}    {button << Prev Page,Prev()} 
{button Next Page >>,Next()}

Designs are typically made up of several different types of objects, such as text frames, text effect 
frames, pictures and so on. In order to work with objects to do things such as move them, delete 
them or change their properties, you will need to select the object first. 

 
As you learned previously, objects are selected in the pointer, or object mode. You can select a single 
object or multiple objects, and you can select objects behind other objects.

Switching Between Text and Object Modes 
Working with Objects



How to Select a Single Object with the Mouse
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 If you are in 
 object mode, move the cursor over the object you wish to select.

 
If you are in  text mode, move the cursor near the boundary of the object you wish to select 
until it changes from an I-beam to a pointer.

 
 Click once. A "red box" highlights the object's boundaries.

 
Notice that the cursor changes to reflect an action you can perform. You can move the cursor over 
different parts of the object to perform different functions, such as moving it or resizing it.

A lighter colored line may also appear around the outside of the object. This is the object's wrap 
margin. Wrap margins determine how close text in your document will appear to the object before 
wrapping over or below the object. This feature can be turned on or off in Program Options.

Changing Wrap Margins with the Mouse



How to Select Multiple Objects with the Mouse
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Selecting multiple objects lets you perform such tasks, such as moving several objects at the same 
time to preserve their position relative to each other or perhaps to delete several objects at once.

 Switch to 
 object mode.
 Click on the first object with the mouse. Then hold down the Shift key and click on the second 

object. Both objects are now selected.

 
 Now you can perform an action, such as moving the objects to a different location.

 
Note: Another way to select multiple objects is to click and drag the cursor in the document at a 
position where no objects exist. As you drag, a rectangle is drawn. 

 
When you release the mouse button, all objects that intersect with the rectangle are selected.



Selecting Objects Behind Other Objects
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Many designs require objects to overlap each other. CD labels, for example, make good use of text 
effect frames for labeling your CDs. The way the text effect object works, it ends up covering most of 
the design area. The result is several other objects appear "underneath" the text effect object.

 
Selecting one of these objects works slightly differently, depending on if you are in text mode or object 
mode.

Text mode: Click anywhere inside the text box to 
place the cursor in the frame, even if another object 
covers it.

To select the object while in text mode, hold down 
the Ctrl key and click near the outside of the object's 
boundaries.

Object mode: Hold down the Ctrl key and then click 
anywhere on the object you wish to select.

Note: Multiple Ctrl-Clicks cycle through all of the objects under the cursor. You may have to Ctrl-Click 
more than once to select the right object.

 Switching Between Text and Object Modes 



Scrolling Through Multiple Designs
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CD Labeler has this neat feature that lets you duplicate and save multiple versions of your design in 
the same file. This is much less confusing than programs that require you to save only one design per 
file. You end up with a lot more files than you can efficiently manage.

With the Command Bar, you can quickly duplicate designs and then use any one of them using the 
scroll buttons. 

 
This is great for creating similar labels that need just a bit of "tweaking" or when you're creating a 
"set" of labels with different information on each label.

 Click 

 to see the next design in the file.
 Click 

 to see the previous design.
 Continue to use these scroll buttons as needed.

Note: Using multiple labels is not the preferred method for printing multiple copies of identical labels. 
It's better to change the number of copies on the Print command, so that you don't end up 
maintaining several labels if changes need to be made later.

Creating Label Sets by Duplicating Designs 
Printing 



Customizing the Design Area
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If you need to enlarge the Design Area to maximize the amount of screen space your design occupies, 
you can hide one or more toolbars. You can hide the Command Bar, Design Bar, Variation Bar, and 
Block Folders.

Tools and Toolbars.

To temporarily hide a toolbar:

 Move the mouse over the toolbar you wish to hide.
 Click the right mouse button.
 Choose Hide Toolbar (the name of the toolbar will be used, such as Hide Command Bar).

 
Note: You can also double-click on toolbars to hide them (except for the block folders).

 The toolbars are removed for the design you are currently working on. This will not affect 
other open designs, and they will be automatically restored the next time you open the design.

To restore a toolbar:

 Move the mouse the edge of where the toolbar would begin if it were hidden. This may seem a 
bit tricky at first, but you will soon get a feel for it.

 Either click the right mouse to bring up a menu with the Show Toolbar command (such as 
Show Command Bar) or simply double-click. If you were in the right place, the toolbar will be 
restored.

To permanently hide a toolbar:

 You can permanently hide toolbars by following the above steps using the double-click 
technique. This time, however, hold the Ctrl key down while double-clicking. In addition to hiding the 
toolbar now, this will also set the toolbar to be hidden by default any time you open or create a 
design.

 Use the Ctrl key to restore a permanently hidden toolbar. This will make the toolbar visible, 
and make the toolbar visible by default whenever you open or create a design.



Using Backgrounds
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The use of backgrounds in CD Labeler is a perfect example of the creativity CD Labeler allows you in 
creating stunning designs with ease. Its power and versatility are unsurpassed for programs of its 
kind.

 This tutorial covers the following topics. You 
can select them individually, if you wish. 
However, we recommend advancing 
through the topics in order by clicking the 
Start button above.

What are Backgrounds? 
Selecting a Background Using the Design Bar 
Selecting a Background Using the Variation Bar 
Using Clipart or Custom Backgrounds 
Using "Clip to Label" On Your Background 
Changing Background Properties 
Clearing a Background 
Changing Background Shades 



What Are Backgrounds?
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Backgrounds are images you can 
place in your design, which print on 
the label as… well backgrounds. 
Backgrounds provide incredible visual 
appeal to your labels.

You can browse and select from a variety of pre-designed backgrounds, which have been 
professionally designed for the type of product you are using. These backgrounds compliment the rest 
of CD Labeler's SmartDesigns features and styles.

If you wish, however, you can use your own background images that you create in another program. 
They can be quickly adapted to your label as you'll see in this tutorial.



Selecting a Background Using the Design Bar 
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 Click on the Backgrounds icon in the Design Bar, and choose Browse SmartDesign 
Backgrounds from the menu that appears. An Explorer-style window appears.

 Use the Explorer pane to view the types of backgrounds you’re looking for, which appear in the 
right pane.

 
Double-click on the thumbnail of the background you wish to use. The background is applied 

to your design.

Adding Backgrounds to the Favorites Folder

You can add your favorite backgrounds to the Favorites folder by selecting the background thumbnail 
and then clicking the Add to favorites button. You can remove a background from the Favorites folder 
by selecting selecting the background thumbnail and then clicking the Remove from favorites button.



Selecting a Background Using the Variation Bar
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The backgrounds listed in the Variation Bar are the same as those found in the browse window when 
you select backgrounds using the Design Bar. If you've selected only Liquid backgrounds, for example, 
only Liquid backgrounds will be available in the Variation Bar. 

There are two ways to view and apply backgrounds using the Variation Bar.

 Click on the 
 and 
 arrows to scroll through the pre-designed backgrounds. As you scroll, the background on your 

design reflects the change.

 
 Click on the background name in the Variation Bar. Then use the up and down arrow keys on 

your keyboard to scroll through the list. As you scroll, the background on your design reflects the 
change.

 
 Click on the background name in the Variation Bar. Then use the scroll bar on the list box to 

find the name of the background you want. Then click on the name to select it.



Using Clipart or Custom Backgrounds
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If you have clipart on your computer or have created your own custom image to use as a background 
for your design, you can quickly add it using the Design Bar.

Click on the Backgrounds icon in the Design Bar, and choose Use Your Own Background 
Backgrounds from the menu that appears. An Explorer-style window appears. 

 Use the Explorer pane to find the drive and directory where your image file is located. 
Thumbnails of images in that folder appear in the right pane.

 
Double-click on the thumbnail of the image you wish to use for your background. The images 

is applied to your design.

Adding Images to the Favorites Folder

You can add your favorite images to the Favorites folder by selecting the image thumbnail and then 
clicking the Add to favorites button. You can remove an image from the Favorites folder by selecting 
the image thumbnail and then clicking the Remove from favorites button.



Using "Clip to Label" On Your Background
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All CDs are created equal… that is, they are all round and they all have a center hole! If you use 
custom graphics for backgrounds, the clip to label feature lets you see what your background image 
will look like when it is printed on your CD label. And you won't have to create a round graphic with a 
center hole! A rectangle will do just fine. 

Not Clipped Clipped

You won't have to waste time and labels determining where the image will be clipped. And you can 
make adjustments to your image, if necessary, just by viewing the design. And when you do get ready 
to print, you won't waste ink printing an area you're going to throw away anyway. Of course, if you 
choose from CD Labeler's wide variety of backgrounds, the designs have already been created with 
the CD label in mind.

To clip your background image:

 From the View menu, choose Clip to Label if it's not already "checked."
 
Using Your Own Custom Backgrounds
Using Layouts



Changing Background Properties
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Once a background is applied to your design, you can make adjustments as necessary to its 
properties. Just clipping the label design may not always be enough. You have several options from 
which to choose.

Click on the Backgrounds icon in the Design Bar, and choose Background Properties. The 
Background Properties dialog box is displayed.

Make adjustments as necessary, depending on the type of image you are using. For example, 
try changing the Brightness Control. You can click Apply to see how it affects your background. Click 
here for details about background properties.

 
If you wish to restore the default settings, click Restore to Defaults.
When you're done, click OK. 

A Note About Labels and Bleed Areas: For labels that typically do not have a bleed area, if you 
stretch to the edge, they will often print into neighboring labels (due to printer mechanical errors or 
the need for calibration). Therefore, CD Labeler uses backgrounds designed for these types of 
products with a built-in margin to correct this problem. However, if you select a paper that does have 
a bleed area, you can stretch the background out to provide complete coverage of the label. The 
reverse is also true going from a background designed for bleed to one that does not have it.



Clearing a Background
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There are a couple of different ways you can clear a background:

 Click on the Backgrounds icon in the Design Bar, and choose Clear Background.

 
 Click on the Backgrounds variation control, and choose No Background.

 



Changing Background Shades
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If you don't want to use an image as a background, you can use SmartDesigns' background colors, 
shades and blends feature allow you to customize your label background without having to create a 
custom graphic using another program. You'll find plenty of creative combinations at your fingertips 
using this unique feature. Try the one described in the steps below.

If you haven't already done so, click on the Backgrounds icon, and choose Clear Background.
Click on the Backgrounds icon, and choose Set Background Color. The Set Background Shade 

dialog box is displayed.
Set the Foreground Color to Magenta.

 
Click Blend. The Blend dialog box is displayed.
Click on the Blend drop-down list, and choose Radiant.

 
Your dialog box should look like this:

Click OK.
You should now have a great-looking radiant magenta background! Fast and easy, right?



Using Layouts
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Layouts are part of the SmartDesign template that include text frames and objects, allowing you to 
control the type of information you want on your label and how it will appear. 

 
CD Labeler layouts have been professionally designed ahead of time to be compatible with labels you 
purchase and use. They keep your designs consistent and easy to adjust, if necessary.

 This tutorial covers the following topics. You 
can select them individually, if you wish. 
However, we recommend advancing 
through the topics in order by clicking the 
Start button above.

What are Layouts? 
Selecting Layouts 
Scrolling with the Layout Variation Control 



What Are Layouts?
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As previously stated, layouts are part of the SmartDesign template that include text frames and 
objects, allowing you to control the type of information you want on your label and how it will appear. 
The example below shows a partial layout of a CD label.

 
CD Labeler layouts have been professionally designed ahead of time to be compatible with labels you 
use, the way you work and the information you might place on a label. Fields created in the layout 
contain sample text, which gives an example of its intended purpose. 

  

You can easily change any of this text or replace objects, such as clipart and logos. This keeps your 
designs consistent and easy to adjust, if necessary. As you edit information in the layout, you may find 
it useful to use the tab key to move through the SmartDesign text frames when changing data. This 
ensures you won't miss anything!
Note: In some cases, where a field is applicable to your User Information, SmartDesigns inserts the 
information found in the User Information tab in the Program Options dialog box.



Selecting Layouts
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Layouts are selected using the Layout Variation Control in the middle of the Variation Bar. The 
variation control lets you change the text and graphic objects that are included in your layout and 
places them in different positions, depending on the layout selected. 

 
Here are some tips about selecting layouts:

 Each layout has a name. The currently selected layout, such as Double-Arch shown in the 
example above, is displayed on the control. The name provides a clue about the layout's overall 
design. 

 You'll also see a number, such as "10 of 20," which indicates how many layouts are available 
for the label you're using.

 If you have made changes to the text and/or objects on a layout, they will carry over to the 
new layout if it includes the same frame. Not all layouts use all frames. 

 If you have already made formatting changes, you may be warned that your formatting 
changes will be lost. You may wish to make your layout (and other final SmartDesign selections) 
before you begin formatting customizations.

 The base font may also change, depending on the layout. If it does change, you'll see the new 
base font displayed in the Font Variation Control.

 



Scrolling with the Layout Variation Control
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There are two ways to scroll using the Layout Variation Control.

 Click on the 
 arrow to advance to the next selection. Notice how your design changes.

 
You can click on the  arrow to move back to the previous selection. Click and hold the 

 or 
 arrow to scroll through the selections.
 Click on the name in the control to pop up a menu with the available choices. 

 
You can select a specific entry in the list or use the up and down arrow keys to scroll through 

the list, while viewing the layouts in your design.
Using SmartDesigns



Using Fonts
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The use of fonts is important in printing professional-looking labels. You can change fonts in one of 
two types:

 Change the base font of an entire design using the Font Variation Control on the Variation Bar.
 Change the font in a text frame or in the font properties of a text or text effect object.

You'll learn how to do both in just a minute.

 This tutorial covers the following topics. You 
can select them individually, if you wish. 
However, we recommend advancing 
through the topics in order by clicking the 
Start button above.

Fonts Installed by SureThing 
Changing the Font of an Entire Design 
Changing the Font Properties of a Text Frame 
Changing the Font for Text in a Text Frame 



Fonts Installed By CD Labeler
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Your CD Labeler program comes with a set of fonts that are installed on your computer when you 
install the program. These fonts are used in the SmartDesign layouts. You can see the list by clicking 
the center of the Fonts Variation Control on the Variation Bar.

 

Does your screen font have the "jaggies"?

If the answer is "Yes", don't worry. Screen fonts can appear "jagged" or of poor quality because they 
are only representations for display purposes. They will print on your labels with the same high quality 
as any other font.



Changing the Font of an Entire Design
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The Font Variation Control is used to change the base font of the entire SmartDesign. You cannot 
change individual text or text objects using this control. (You'll learn how to do that in a minute.) 

Note: If you have already made formatting changes before you click on a SmartDesign choice, you 
may be warned that your formatting changes will be lost. You may wish to make your final 
SmartDesign selections before you begin customizations.

Here are three ways to use the Font Variation Control:

 Click on the 
 arrow to advance to the next font. Notice how your design changes.

 
Click on the 

 arrow to move back to the previous font. Click and hold the 
 or 
 arrow to scroll through the fonts.

Click on the font name in the control to pop up a menu with the available fonts. 
 

You can select a specific font in the list or use the up and down arrow keys to scroll through 
the fonts, while viewing how the font will look in your design.



Changing the Font Properties of a Text Frame
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There may be times when you wish to change the font for a specific text frame rather than the whole 
design. Follow these steps:

 Select the object. A "red box" highlights the object's boundaries.

 
 Click on the font drop-down list in the Control Strip, and choose the font.

 
All the text in the text frame is formatted in the font you select.

Would you rather browse through your fonts?

Perhaps you're not sure what a font looks like or you'd like to browse through the font list in search of 
one that catches your eye. You can do this by in a couple of different ways:

 From the Format menu, choose Character.
 Right-click and choose Object Properties from the menu that appears. Then click the Character 

button. 
This lets you scroll through the available fonts and see what they will look like in the preview window. 
It also lets you make other font changes, such as point size, color and styles.



Changing the Font for Text in a Text Frame
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If you want, you can change the font for selected text in a text frame rather than the whole text frame 
or the entire design, as previosuly described. Follow these steps:

 Highlight the text you wish to change.

 
 Click on the font drop-down list in the Control Strip, and choose the font.

 
The text is formatted in the font you select.

 

Would you rather browse through your fonts?

Perhaps you're not sure what a font looks like or you'd like to browse through the font list in search of 
one that catches your eye. You can do this by in a couple of different ways:

 From the Format menu, choose Character.
 Right-click and choose Character from the menu that appears. 

This lets you scroll through the available fonts and see what they will look like in the preview window. 
It also lets you make other font changes, such as point size, color and styles.



Adding Images
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Although CD Labeler makes creating labels easy with SmartDesigns, from time to time you may want 
to add your own logos and images to a design. You can add images in these ways:

 Select from a library of logos and clipart images that comes with the CD Labeler program.
 Select from a library of pre-designed media images and symbols relevant to the product you 

are using.
 Add your own images from image files.

You can quickly make adjustments to your images when you add them or later on, if necessary.

 This tutorial covers the following topics. You 
can select them individually, if you wish. 
However, we recommend advancing 
through the topics in order by clicking the 
Start button above.

Adding Logos and Clipart 
Adding Media Related Images 
Using the Picture Tool 
Using the Transparency Tool 
Making Advanced Settings with Properties 



Adding Logos and Clipart
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CD Labeler comes with a wide variety of logos and clipart to enhance your label, if necessary. Follow 
these steps to add this type of image:

 Click on the Logos/Clipart icon on the Design Bar, and choose Browse for Logos/Clipart from 
the menu that appears. An Explorer-style window appears.

 Use the Explorer pane to find the drive and directory where your image file is located. 
Thumbnails of images in that folder appear in the right pane.

 
 Double-click on the thumbnail of the image you wish to use. The image is added to your 

design.

 
The image is always placed at a default position on the design. You can move the image to its 

final position, if necessary. 

Moving an Object with the Mouse

Adding Images to the Favorites Folder

You can add your favorite images to the Favorites folder by selecting the image thumbnail and then 
clicking the Add to favorites button. You can remove an image from the Favorites folder by selecting 
the image thumbnail and then clicking the Remove from favorites button.



Adding Media Related Images
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In addition to logos and clipart, CD Labeler comes with a library of images and symbols related 
specifically to the program you are using. For example, CD Labeler contains images and symbols you 
would typically find on CD and jewel case labels. Since they are media specific, you won't waste time 
scrolling through a seemingly endless list of images you'll never use on your labels.

Follow these steps to add this type of image:

 Click on the Logos/Clipart icon on the Design Bar, and choose Browse for CD & Media Symbols 
from the menu that appears. A window showing thumbnail pictures of the available images is 
displayed.

 Double-click on the thumbnail of the image you wish to use. The image is added to your 
design.

 
The image is always placed at a default position on the design. You can move the image to its 

final position, if necessary. 

Moving an Object with the Mouse



Using the Picture Tool
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The Picture tool lets you insert an image file anywhere on your design. Follow these steps to add this 
type of image:

 Click on the Tools drop-down arrow in the Control Strip, and choose the 
 tool.

 Position the cursor over the design. Click and hold the left mouse button where you want the 
top-left corner of the image to be.

 
 Drag the cursor to the approximate size of the picture and release the mouse button. The New 

Picture dialog box is displayed.
 Select the image file you wish to insert. Navigate to a different drive and directory, if 

necessary. Use the Preview options to see thumbnails of the images, if you wish. 
 Click OK to insert the image in your design. By default the image maintains its aspect ratio in 

the frame.

 
 You can move the image to its final position, if necessary. 

Moving an Object with the Mouse



Using the Transparency Tool
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The Bitmap transparency tool is active when you have any kind of bitmap image selected (BMP, TIF, 
JPG, etc). You select the tool, and click on a color within the image. This color then becomes the 
transparent color.

This is typically used for logos and other types of images that are often prepared on a white 
background (all bitmaps are square, remember, and white pixels do print). When you place such an 
image on a colored background, you see the white square in addition to the actual image. 

 Select the image.
 Click on the Bitmap Transparency Tool on the Control Strip.
 Click the white area in the image. Now the image displays and prints only the actual image, 

and not the extraneous white space.

Note: The color you make transparent doesn't have to be white. But it is usually the color that 
occupies the area outside the actual shape of the logo.



Making Advanced Settings with Properties
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The Properties dialog box of an image is a powerful tool for making a wide variety of adjustments.

 Double-click on the image. The Picture dialog box is displayed.

 
 Click on any of the tabs in the dialog box to see additional settings. A partial view of the dialog 

box is shown below.

 
 Click OK.

Note: If you wish to replace this image with a different one, you can click the Change Picture button 
from the Picture dialog box and then locate the new image.

More About Inserting Your Own Images 



Working with Text Frames
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Text frames come in many shapes and sizes. They can be text frames added by SmartDesigns when 
you create or change the layout of a label. Or they can be text frames you add on your own using the 
Design Bar or the Text Frame tool. 

Text frames have many different properties, which you can adjust to fine-tune your label design. You'll 
learn how to work with text frames in this tutorial. 

Note: Text frames can also be a text effect frame that contains text displayed using one of many 
types of special effects. See Creating Text Effects to learn how to add and modify this unique type of 
text frame.

 This tutorial covers the following topics. You 
can select them individually, if you wish. 
However, we recommend advancing 
through the topics in order by clicking the 
Start button above.

Adding Text Frames 
Resizing a Text Frame with the Mouse
Changing Wrap Margins with the Mouse
Working with Tabs Using the Mouse
Formatting Bullets
Inserting Special Text
Inserting Merge Fields



Adding Text Frames
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Label designs contain some text frames that are automatically added when you create your design or 
change its layout. These text frames often contain user information and other types of sample 
information relative to your design. Of course, these text frames can be modified to fit your particular 
needs.

 
You may find, however, that you need to add a text frame for a particular purpose. There are basically 
two ways to add your own text frame:

 You can add various types of text frames to your design using the Adding Text option on the 
Design Bar. 

 You can create an empty text frame by adding it to your design with the Text Frame tool. 
The next several topics show you how to do this.



Creating a New Text Frame Using the Design Bar 
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 Click on the Adding Text icon in the Design Bar, and choose Create New Text Frame from the 
menu that appears. A text frame is created on your design with sample text in the frame.

 
 The sample text is already highlighted so you can simply begin typing in your own text.

 
Note: The text frame is always placed at a default position on the design when you use this method. 
You can move the frame to its final position, if necessary. You can also resize the frame as needed. 
You'll learn how to do this later in the tutorial.



Drawing a Text Frame Using the Text Frame Tool
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The Text Frame tool lets you draw a text frame anywhere on your design.

 Click on the Tools drop-down arrow in the Control Strip, and choose the 
 tool.

 Position the cursor over the design. Click and hold the left mouse button where you want the 
top-left corner of the text frame to be.

 
 Drag the cursor to the approximate size of the text frame and release the mouse button. A 

blank text frame is created.
 Enter your own text in the frame.

 
If your text won't fit in the frame you drew, you'll need to resize it. 

 
Continue to the next topic to learn how.



Resizing a Text Frame with the Mouse
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At times you may need to resize your text frame horizontally, vertically or both in order to fit more 
text into the frame. This can happen, for example, if you don't draw the right size frame the first time. 

As with all objects, they can be resized with the mouse using the object's sizing handles that appear 
when you select it. The example below shows how to resize the text frame vertically because the 
second line of the text frame does not fit.

 Click on the text frame boundary to select the frame.

 
 With the mouse over the resizing handle shown below, click and hold the left mouse button 

while you drag the handle down to resize the frame.

 
 Release the mouse button. Both lines of text now fit in the frame.

 



Changing Wrap Margins with the Mouse
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The wrap margin determines how close text in your document may appear above, below, or to either 
side of an object before wrapping. When you select an object, the borderline that appears around it    
represents the object's wrap margin.

Note: Wrap margins must be turned on in the Program Options dialog box. From the Tools menu, 
choose Program Options. Check the box shown below, and click OK.

 
 Click on the object.

 
 Move the mouse directly on top of the wrap margin you want to change. The pointer changes 

to a gray double-arrow: 
 depending on which wrap margin you want to change. 

 
 Click and drag in one of the directions of the double-arrows to increase or decrease the wrap 

margin.



Working with Tabs Using the Mouse
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If you need to add one or more tabs to your text frame, you can quickly do this using the mouse. Here 
are some different ways you can add and change tabs.

 Rulers must be displayed to format tabs using the mouse. If they are not already displayed, 
open the View menu, choose View Options / Show Rulers. 

 Select the 
 tool on the Control Strip.

Select the paragraph in the text frame where you want to set tabs.
 To add a new tab, click in the horizontal ruler at the position you want the tab.

When you release the mouse button, the tab will be added to all selected paragraphs.

 To move an existing tab, simply click on the tab you wish to move and drag it to a new 
location.

 
 To delete an existing tab, simply click on the tab you wish to delete and drag it downward off 

of the ruler.

 



Formatting Bullets
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With CD Labeler, you can create bullet paragraphs, which can begin with round, diamond, or character 
bullets. The bullet appears on the left side of the paragraph. You can control the size and color of the 
bullet, and also its position relative to the text.

This example shows how to format a diamond-shaped bullet:

 Highlight a paragraph in your text frame. 
From the Format menu, choose Bullets. The Bullets dialog box is displayed.
Click on the diamond bullet shown below.

 
 Click OK.

Using Other Characters for Bullets

You can use any character in any font you have on your system as a bullet. From the Bullets dialog 
box, click Character under Type, and then choose the appropriate information in the settings shown 
below. 

 
Note: If you are scrolling through characters with the arrow keys, you should select the font first in 
order to see the proper characters.

Changing the Position of the Bullet

You can make horizontal and vertical positioning selections in the Bullets dialog box to change the 
position of the bullet. The horizontal setting specifies the distance between the bullet and the 
paragraph. 

 
The default vertical setting is centered. A positive value moves the bullet up from centered; a negative 
value moves the bullet down from centered.



Inserting Special Text
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There are many different types of special text you can include in your text frames, including symbols, 
date, time, file names, sequence numbers, user information, and more. Some of these are 
automatically included when you choose from one of the many SmartDesign layouts. However, you 
may need to insert special text from time to time. You can access all of these from the Design Bar.

This example describes how to insert a Print Date field that automatically prints the current system 
date on your label:

 Select the 
 tool and place it in the text frame where you want the special text to be.

 
 Click on the Adding Text icon on the Design Bar, and choose Add User Info, Merge, Special 

Text. The Insert Special Text dialog box is displayed. The Special Fields tab should already be 
displayed.

 Under the Field Type column, select Print Date. 

 
 Under the Data column, select the auto date format (shown above).
 Click OK. The special field is inserted.

 



Inserting Merge Fields
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 Click on the 
 tool and then click in the text frame where you wish to insert the merge field.
 From the Insert menu, choose Insert Merge Field. The Insert Special Text dialog box is 

displayed with the Merge Fields tab.
 Click Set Merge File. The Set Merge File dialog box is displayed.
 Select the merge file that contains the records you wish to merge. Navigate to the appropriate 

drive and/or directory, if necessary. Click Set.
 Double-click on the merge field you wish to insert. 

Note: You can Insert additional merge fields, if you wish. You can change the insertion point 
by clicking at that point in the text frame. You can even change to a different text box. You can move 
the Insert Special Text dialog box if you can't see the where you wish to insert a field.

 When you're finished, click Close.



Working with Objects
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If you have completed some of the other CD Labeler tutorials, you may already be familiar with the 
topics described here. Although you can do just about anything with any object in CD Labeler, here are 
a few useful items that may help you while you're working with your label design.

If you don't find what you're looking for here, click the Tutorials button to see a complete list of topics.

 This tutorial covers the following topics. You 
can select them individually, if you wish. 
However, we recommend advancing 
through the topics in order by clicking the 
Start button above.

Changing an Object's Properties 
Moving an Object with the Mouse 
Resizing an Object with the Mouse 
Ungrouping Objects 
Nudging Objects 
Rotating Objects 
Formatting Borders 



Changing an Object's Properties
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The Properties dialog box of any object is a powerful tool for making a wide variety of adjustments to 
your object. Follow these steps to display the properties of an object:

 Double-click on an object. It's Properties dialog box is displayed. For example, if you select a 
text frame, the Text Frame dialog box appears.

 
Note: You can also display an object's properties by opening the Tools menu, choosing 
Object Properties or by right-clicking an object, and choosing Object Properties from the 
menu that appears.

 Make changes to the properties as needed. Here are some possibilities:
Click on any tab to display additional properties.
Click other buttons, such as Borders and Shades to make additional changes.

 
Click Help (or press F1) to see detailed help about the object's properties.
If the dialog box has an Apply button, click on it to apply changes to the object without closing 

the dialog box.
If the dialog box has any Set Default buttons, you can click on any of them to return those 

properties to their default values.

 
Click OK to apply the changes and close the dialog box.



Moving an Object with the Mouse
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 Select the 
 tool on the Control Strip.
 Click the pointer anywhere on the object and drag. 

 
 Release the mouse button. The object is moved to the new location. 

Note: Objects cannot be moved past the edges of a design. 



Resizing an Object with the Mouse
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At times you may need to resize an object. This can happen, for example, if you don't draw the right 
size text frame the first time and your text won't fit. Or you may need to resize a picture or logo. 

You can resize an object horizontally, vertically or both, using your mouse and the object's sizing 
handles that appear when you select it. The example below shows you how to resize a text frame 
vertically so the second line of text will fit.

 Click on the text frame boundary to select the frame.
 
 With the mouse over the resizing handle shown below, click and hold the left mouse button 

while you drag the handle down to resize the frame.
 
 Release the mouse button. Both lines of text now fit in the frame.
 

Note: If the object being sized is a rectangle, or ellipse, then holding down the Shift key when 
resizing the object constrains its aspect ratio to a square or a circle.



Ungrouping Objects
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As you work with objects in SmartDesigns, you may find that one or more objects in a design are 
grouped together. Usually this is done to maintain a consistent look to the design, as well as to let you 
move these grouped objects all at the same time. 

Text frames can be edited even if they are grouped. However, if you find that you need to modify one 
of the grouped objects, you'll need to ungroup them first. 

 Click on the group.

 
 From the Tools menu, choose Ungroup.
 Click on the individual object you wish to modify.



Nudging Objects
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Most of the time, moving objects with the mouse is acceptable. And you can turn on the snap to grid 
feature to help align objects consistently. However, if you need more precise movements, you can 
"nudge" objects up, down, left or right using the arrow keys. 

Follow these steps to nudge an object:

 Select the object you wish to nudge.
 Press either the up, down, left or right arrow key to nudge the object up, down, left or right, 

respectively. Use the Shift key with these arrows to move the object in larger increments.



Rotating Objects
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Any type of object¾even a text object¾can be rotated up to various degrees of rotation. Objects such 
as text effect objects and Windows metafile images can be rotated to any degree. Other objects, such 
as regular text frames and bitmap images can be rotated 0, 90, 180 or 270 degrees. 

The quickest way to rotate an object is by using the mouse:

 Select the object you wish to rotate.
 Click on the 

 tool in the Control Strip.
 Move the cursor to any of the corners of the object until you see the cursor change. Then, 

drag the object until it rotates to the desired position.

 Release the mouse button. 

Some notes about rotating objects

 If you are rotating an object that cannot be set to any degree of rotation, such as a text 
object, it is "snapped" to the closest rotation degree of 0, 90, 180 or 270. For example, you must 
rotate the object to at least 45 degrees for it to snap to 90 degrees.

 You can define more precise rotations using the object's Properties dialog box. Click on the 
Properties tab and enter the degree of rotation.

 
 You can also move an object as you normally would while the rotation tool is being used.
Moving an Object with the Mouse 



Formatting Borders
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CD Labeler lets you create border lines around objects, selecting from several different styles. You can 
also control their placement relative to the text. This example shows how to create a typical border 
above and below an object.

 Select the object. From the Format menu, choose Borders. The Frame Border dialog box is 
displayed.

 Click on the Edit Edge drop-down list, and choose Above & Below. Notice that the Sample 
window marks only these borders.

 Click on the double line border under Apply Style where the bottom line is thicker than the top 
line. Then click on the Color drop-down list, and choose Blue. The new border is shown in the Sample 
window (below left):

 Click the Lines button. The Lines dialog box is displayed. Click on the 2 pt. sample under 
Thickness. Notice how the Thickness and Separation measurements change. Click OK. The new border 
thickness is shown in the Sample window (above right).

 Click OK.

Selecting borders in the Sample window using the mouse

The Sample window displays an example of the currently selected border. You can use your mouse to 
specify which edges will be affected when the current line style is applied. Here are some tips:

 The small cursor symbols 
 are used to mark the edges that will be affected. 

 You can select an edge directly in the Sample window by clicking on it with the mouse (instead 
of using the Edit Edge drop-down list). 

 Multiple edges can be selected by holding the Shift key down while you click. 
 The outer edges (i.e. the top, bottom, left, and right) may be selected by clicking on the 

interior.



Creating Text Effects
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Text Effects allow you to apply specials effects to text, such as circular text, slanted text, perspective 
text, drop shadows and more. Text Effects add spice to CD titles, for example, but are also useful for 
more ordinary tasks such as copyright notices, trademarks or even track titles.

 This tutorial covers the following topics. You 
can select them individually, if you wish. 
However, we recommend advancing 
through the topics in order by clicking the 
Start button above.

Using the Text Effects Wizard 
Using the Text Effects Tool 
Making Text Effects Look Good 
Modifying a Text Effects Frame 
Preview Quality vs. Print Quality 



Using the Text Effects Wizard 
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The Text Effect wizard guides you through the process of creating a text effect.

 Click on the Text Effect icon in the Design Bar, and choose Use Text Effect Wizard from the 
menu that appears.

 Select the type of effect you want to create. Use the scroll bar to see additional selections. 
Click Next.

 Select a variation on the type you chose in step 2. Use the scroll bar to see additional 
selections. Click Next.

Select from the pre-set colors. Use the scroll bar to see additional selections.
The check boxes at the bottom allow you to turn certain characteristics on or off. Clicking them 

will change the samples so you can more easily decide which ones to use.

Click Next.
Replace the sample text with the text you want to appear in the text effect. Click Preview to 

see it.

Change the font and style options as desired. Select the effect variation, such as Perspective. 
Note that not all variations apply to all effects. The drop-down list displays the ones you can choose.

Note: If changes do not appear in the Preview window when you select them, click Preview.
Click Finish. The effect is created at a default position on your label. 



Using the Text Effects Tool
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The Text Effect tool can be used to draw a text effect frame on your design at the size and position 
you wish. The dialog box that is displayed has the same type of information in it as the Text Effect 
wizard.

 Click on the Tools drop-down arrow in the Control Strip, and choose the 
 tool.
 Position the cursor over the design. Click and hold the left mouse button where you want the 

top-left corner of the text frame to be.

 
 Drag the cursor to the approximate size of the text frame and release the mouse button. The 

frame is created and the Text Effect dialog box is displayed.
 Make your selections, clicking on the different tabs, if necessary. Click Preview if the Preview 

window does not show your selections as you make them.
Note: The Text Effect dialog box is a very powerful feature. Click Help on the dialog box to see a 
complete description.

 Click OK. The effect is created at the position on your label. 



Making Text Effects Look Good
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You may be surprised when you first create a Text Effect that it doesn’t look quite the way you 
intended. Text Effects can look very different depending on how they are sized, and the intial shape 
and size of the Text Effect is rarely the best choice.

For example, round effects such as a Circles or Buttons typically look best when they are sized to a 
square shape. Similarly, angled text typically looks better when shaped as a rectangle. It all depends 
on what you are trying to achieve. 

 
Fear not, however, it is quite easy to re-size a Text Effect to make the results spectacular. Just grab 
one of the corners to re-size and reshape the bounding rectangle until you like the way it looks. 

Tips for working with text effects

 If the text is tall and skinny, shorten the effect or make it wider. If the text is short and fat, 
make it taller or less wide.

 For round effects, try using the different thicknesses to achieve the desired result. For 
example, if the text in the circle is too big, try using Circle Thinner.

 Try setting the Variation setting in the properties dialog. For Circles, try Stretch and for many 
rectangular effects try Perspective.

 The text effect does not always look as good on screen as it will when it prints. Don’t be 
concerned when you see jagged edges on screen.

Resizing Objects with the Mouse 



Modifying a Text Effects Frame
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 Double-click on the text effects frame. The Text Effect dialog box is displayed.

 
 Modify your text effects, clicking on the different tabs, if necessary. Click Preview if the 

Preview window does not show your selections as you make them.
Note: The Text Effect dialog box is a very powerful feature. Click Help on the dialog box to see 

a complete description.
 Click OK. 



Preview Quality vs. Print Quality
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Text effects may not appear on your design to be of very high quality. The edges may appear jagged 
and too faint. 

 
This is because they are simply representations of the text effect. When you print your label, you'll see 
that your text effects print with the same high quality as the rest of your design.

Using the Text Effect Dialog 
Printing 



Creating Label Sets by Duplicating Designs
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In this section you will learn how to create files with multiple labels, known as Label Sets. This is 
convenient when you need to create a number of different labels that are normally printed together. 
You should not confuse this with printing multiple labels, you can do that more easily by printing one 
or more copies of a single design.

 This tutorial covers the following topics. You 
can select them individually, if you wish. 
However, we recommend advancing 
through the topics in order by clicking the 
Start button above.

What is a Label Set? 
Duplicating a Design 
Moving Between Labels in a Set 
Deleting a Design from the Label Set 
Printing Label Sets 



What is a Label Set?
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A Label Set is two or more label designs in the same file. Each label normally has a unique quality to 
it¾a different picture for example¾or perhaps a different description field. Label Sets can then be 
printed together as a set or each label in the set individually.

A good example for the use of a Label Set is a CD collection of clipart. The first CD in the set might be 
for Animals, the second People, and a third for Cartoons. You create the look and feel for the entire set 
with the first label for Animals. You then use the Duplicate command to create two more copies of the 
label, and then make the minor changes to each.

You can, of course, use Label Sets for any purpose you desire, including creating a set of identical 
labels. This is not recommended, however. If later you need to make a change to your label, you will 
need to change it in all of the label designs, instead of just one.

The buttons on the Command Bar are great for working with Label Sets.

 
Note: If you don't see these buttons above your design, open the View menu, choose View Options / 
Show Command Bar.



Duplicating a Design
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Duplicating a design is very easy.

 Click 
 on the Command Bar. The Duplicate Design dialog is displayed.
 Specify the number of new label designs you would like to create.

 
 Check Insert at Current Position to insert them after the current design. Otherwise, they will 

be appended to the end of the file.
 Click OK. You will be positioned on the first of the new designs.

The Duplicate command will create exact copies of your label design. This means there won't be a 
dramatic change after you have successfully duplicated designs. It is then up to you to make the 
changes in order to make them unique. 

Note: If you just want to print multiple copies of the same design, use the Number of Copies 
command in the Print Dialog instead. Duplicate is really for managing multiple unique but similar 
designs within the same file.



Moving Between Labels in a Set
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Once you've created a Label Set, you will want to be able to move between your various label designs. 
To do so:

 Click 
 on the Command Bar to move to the next design or 
 to move to the previous design.
 To see where you are currently in your Label Set, look at the Block Tab. It will say 2 of 3, if 

you are on the second design of a three design Label Set.

 



Deleting a Design from the Label Set
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There are times you will need to delete a design from your Label Set.

 Click 
 on the Command Bar. The Delete Design dialog appears.
 Specify the number of designs you wish to delete, and from which design you wish to begin 

deleting. Normally, you will want to delete the current design, which is specified when you first enter 
the Delete tab.

 



Printing Label Sets
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 Click 
 on the Command Bar. The Print dialog box is displayed.
 Click the Settings tab, if it's not already displayed.

 
 Choose from one of the following options:

Click All to print the entire Label Set.
Click Current to print only the design currently displayed in the design area. 
Click Range and enter the range of designs in the Label Set to print. You can use this option to 

print just one design, which is useful if the one you want to print is not the current one.
When printing Label Sets, there are a couple of things to keep in mind:

If you specify more than one copy, this refers to the entire set. So if your Label Set contains 
three designs and you choose to print two copies, you will use a total of six labels.

Each label in the set will be printed sequentially. So in the above scenario, the entire set will 
be printed once, and then printed a second time.



Printing
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As with other CD Labeler features, printing your new design is just a mouse click away. You'll find a 
wide variety of printing options available to make printing easy and flexible.

 This tutorial covers the following topics. You 
can select them individually, if you wish. 
However, we recommend advancing 
through the topics in order by clicking the 
Start button above.

Printing One or More Copies of a Single Design
Printing Multiple Designs
Printing with Merge Files



Printing One or More Copies of a Single Design
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Click 

. The Print dialog box is displayed.
Since most label sheets come with two labels on them, we'll show you how to print either one 

label or two.
 CD Labeler always defaults to print just one copy of your label. The Sample window shows 

only one label displayed in cyan. This is the label that will be printed.

You can click on either label in the Sample window to print on that label. This is useful if you have 
already used the other label.

 If you wish to print two copies of your label, either change the number to 2 or simply click 
Pages. Notice that now both labels are displayed in cyan.

Prepare your printer with labels, and click OK.
Note: When you select the number of copies of labels or pages you wish to print, CD 
Labeler tells you how many sheets of labels you will need, depending on the product you 
are using.

 



Printing Multiple Designs
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 Click 
 on the Command Bar. The Print dialog box is displayed.
 Click the Settings tab, if it's not already displayed.

 
 Choose from one of the following options:

Click All to print the entire Label Set.
Click Current to print only the design currently displayed in the design area. 
Click Range and enter the range of designs in the Label Set to print. You can use this option to 

print just one design, which is useful if the one you want to print is not the current one.
 Click OK

When printing Label Sets, there are a couple of things to keep in mind:

If you specify more than one copy, this refers to the entire set. So if your Label Set contains 
three designs and you choose to print two copies, you will use a total of six labels.

Each label in the set will be printed sequentially. So in the above scenario, the entire set will 
be printed once, and then printed a second time.



Printing with Merge Files
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CD Labeler lets you print merge data on your labels once you have set a merge file and inserted 
merge fields into your design.

Set up merge fields in your design as described in Inserting Merge Fields.
Click 

. The Print dialog box is displayed.
Click the Merge tab.

 
 Choose from one of the following options:

Click None to print the label without merging any records. 
Click All to print all records in the merge file.
Click Range and enter the range of records in the merge file to print.

 Click OK.



Scanning Images and Backgrounds
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If you’ve got a scanner, digital camera, or other TWAIN compatible device attached to your printer, 
you can easily acquire artwork from existing sources such as company logos, commercial CDs and 
photographs among others.

You can even scan artwork directly as a background for your labels, making it extremely easy to 
create exact replicas of your music, software, and data CDs and Jewel Cases. This is a perfect way to 
make backup or archives collections.

 This tutorial covers the following topics. You 
can select them individually, if you wish. 
However, we recommend advancing 
through the topics in order by clicking the 
Start button above.

Choosing a TWAIN Source
Scanning Images
Scanning an Image as a Background



Choosing the TWAIN Source
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Many people have more than one TWAIN compatible device attached to their computer. For example 
you may have a scanner and a digital camera, both of which can be used to acquire images. 

In such cases, CD Labeler will add another menu item to the File menu under Scan Images named 
Select TWAIN Source. Select the device you wish to use for the list presented.



Scanning Images
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Before you attempt to scan an image, be sure your TWAIN compatible device is attached to your 
printer, and is turned on.    Then follow these steps:

From the File menu, choose Scan Images.
From the popup menu, choose Aquire Image.
Your TWAIN compatible software will lead you through the process of acquiring the image. 
After it has been acquired, the image will be placed in the label. Move and resize it to the 

desired position.



Scanning an Image as a Background
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Scanning an image as a background is much like scanning a normal image, except that the image is 
placed and sized to fit on the background layer automatically. Before you attempt to scan an image, 
be sure your TWAIN compatible device is attached to your printer, and is turned on.    Then follow 
these steps:

From the File menu, choose Scan Images.
From the popup menu, choose Aquire Image as Background.
Your TWAIN compatible software will lead you through the process of acquiring the image.
Using your TWAIN compatible software, closely crop the image to the desired size. For 

example, if you are scanning a CD, crop the image to the bounding box that encompasses the circle. 
This will make the automatic background sizing in CD Labeler work properly.

Choose Background Properties to adjust how the image is stretched to fit the CD. In particular, 
for scanned CDs, it is often better to set the background to Stretch to Design rather than Stretch to 
Design w/Bleed (the default setting).



Creating a Custom Label Template
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The Template Creation Wizard lets you create customized layouts for label sheets not found within CD 
Labeler. If you want to use CD Labeler's great features for other types of labels you use often, your 
own custom template can be useful to fill that need. And when you're done, you can save it and use it 
any time you wish when you create a new label!

 This tutorial covers the following topics. You 
can select them individually, if you wish. 
However, we recommend advancing 
through the topics in order by clicking the 
Start button above.

Starting the Template Creation Wizard
Setting the Page Layout
Specifying the Label  ’  s Template Properties  
Defining the Label Layout Properties
Saving Your Template
Finishing the Template Wizard



Starting the Template Creation Wizard
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During the creation process, you can start from scratch or use a similar label supported by CD 
Labeler’s SmartDesigns and modify it for your needs. As you complete each screen, click Next to 
continue; click Back to make changes to previous screens.

Saved templates are added to the New Label wizard at the end of the process. These templates are 
saved by default in the User Templates folder where you installed CD Labeler, such as C:\Program 
Files\SureThing\STCD\User Templates.

 From the File menu, choose Template Creation Wizard.
 Click Next. The wizard's Page Layout screen appears.



Setting the Page Layout
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This screen lets you set the page layout to the dimensions and orientation of the label sheet you plan 
to use.

 Select the page size of the entire label sheet from the drop-down list or enter the Width and 
Height in inches.

 If you are using two-sided printing, check the Print on front and back of paper checkbox.
 Click the Portrait or Landscape option that matches the label sheet's printing orientation.
 Click Next. The wizard's Label Template screen appears.



Specifying the Label's Template Properties
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This screen lets you specify the label's template properties, which includes the label shape and size.

 Enter a descriptive name for the label template in the Label Description field.
 Select the shape of the label from the Label Shape drop-down list. For example, if you're using 

diskette labels or address labels, select Rectangular.
 Under Size, enter the label's width in the Horz. field and its height in the Vert. field.

 
 You can set a bleed for the label, if you wish. Under Bleed, enter the amount of horizontal 

bleed in the Horz. field and the amount of vertical bleed in the Vert. field.
Note: Bleed is the amount of space horizontally and vertically outside the bounds of the 
label into which CD Labeler will print. This sets the bleed space around a design, objects 
can be moved into this space. The bleeds of two designs may overlap, but the bleed of 
one design cannot overlap another design.

 Click Next. The wizard's Label Layout Properties screen appears.



Defining the Label Layout Properties
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This screen lets you define how the labels are laid out on the sheet, such as how many labels across 
and down.

 Enter the number of labels there are across on the sheet.
 Enter the number of labels down there are on the sheet.
 Make the following measurements and enter them in the appropriate fields as described below.

 
Left Starting Position. The distance from the left edge of the label sheet to the left edge of 

the first label on the sheet.
Top Starting Position. The distance from the top edge of the label sheet to the top edge of 

the first label on the sheet.
Horizontal Span. The distance from the left edge of the first label to the right edge of the last 
label across the sheet.

Vertical Span. The distance from the top edge of the first label to the bottom edge of the last 
label down the sheet.

 If all your labels don’t repeat in symmetrical rows and columns see Creating Multiple Sub-
blocks below. Otherwise, skip to step 5.

 Click Next. The wizard's Save Template screen appears. See Saving the Template.

Creating Multiple Sub-blocks

Labels on a sheet usually repeat in a symmetrical fashion. For example, there are a number of rows of 
labels, with each row having the same number of labels (or columns). Additionally, the distance 
between each column is the same and the distance between each row is the same.

Ocassionally, you will find sheets that do not exhibit this pattern. If not you will need to create sub-
blocks. Quite simply, a sub-block is any group of labels that do exhibit the pattern of rows and 
columns described above. A sub-block can be a small as a single label (1 row x 1 column) or as large 
as your sheet will accept.

One important thing to remember about sub-blocks is that all labels on the sheet must be the same 
size. If you have labels of different sizes on a sheet, you’ll need to create new templates for each size. 
See also Page Setup

 On the Label Layout Properties screen, enter the dimensions of the first label type.
 Click the Create button. This creates the first sub-block.

 
 Enter the starting position of the sub-block.



 Click the Create button. This creates the second sub-block.

 
 Continue to create sub-blocks as needed.
 When you are finished using this screen, click Next. The wizard's Save Template screen 

appears. See Saving the Template.

Deleting a Sub-block

On the Label Layout Properties screen of the wizard, you can delete unwanted sub-blocks:

 Use the 
 and 
 arrows on the sub-block scroll bar to select the sub-block you wish to create.

 
 Click Delete.
 When you are finished using this screen, click Next. The wizard's Save Template screen 

appears. See Saving the Template.



Saving the Template
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 Enter a descriptive name for your template.
 Click on the drop-down list to select the label category, which appears when you use the New 

Label wizard.
 Click Next.



Finishing the Template Wizard
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 Select either the option to create a new label right now or return to CD Labeler.
 Click Finish.



Working with Playlists
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CD Labeler lets you add audio and data CD information to your design with just a few mouse clicks. 
You can edit this information at any time, if you wish. CD Labeler also lets you maintain a CD 
information database to keep your playlists in top condition!

 This tutorial covers the following topics. You 
can select them individually, if you wish. 
However, we recommend advancing 
through the topics in order by clicking the 
Start button above.

Playlists in SureThing 
Audio Playlists vs. Data Playlists 
Adding a Playlist Using the New CD Wizard 
Importing Audio Playlist Information 
Applying a Different Playlist from the Playlist Database 
Creating a Custom Playlist with the Playlist Database 
Creating Your Own Playlist Data 
Using the Playlist Manager 
Importing Data Playlist Information 
Adding Playlist Fields to an Existing Design 
Displaying Playlist Fields 



Playlists in SureThing
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SureThing makes it easy to create labels for music CDs with playlists. A playlist is a set of information 
describing the contents of an audio CD, typically consisting of things like the album title, the name of 
the artist and the titles of each audio track. Sometimes this information is recorded directly on the CD 
(CD-Text) but more commonly a playlist can be found in a database on the Internet.

 The beauty of using playlists is you don't have to type in the information on to your label. You simply 
insert the CD into your drive, and SureThing takes care of the rest.

Playlists are most commonly associated with audio CDs. The concepts, however, apply equally well to 
a data CD where you might want to list the files included on the CD. SureThing uses playlists for both 
types of CDs.

SureThing makes using playlists easy in a number of ways. It will read your CDs and find the playlist 
information automatically (if available). Using SmartDesigns it will automatically place the playlist on 
your label in a number of attractive layouts. Finally, there is a Playlist Manager that helps organize 
your playlists and allow you to re-use them on future labels.

Put simply, a label design with a playlist is like a mail merge document in a word processor. You insert 
fields into the document. Once you insert your CD for SureThing to read, it substitutes the field codes 
with the playlist information. Using SmartDesigns shields you from the messy details, but by working 
with the playlist fields directly just about anything is possible.



Audio Playlists vs. Data Playlists
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CD Labeler lets you select between audio and data labels when you create a new label design.

 
This selection will determine the types of playlist fields that are added to your design:

 Audio fields will be related to audio information on your CD or from the Internet. 
 Data fields will be related to filename, filesize, and so on.

The General Purpose designs do not use playlist fields.

Tip: Even if you plan on completely designing your label from scratch, we recommend you choose the 
Audio or Data CD option when starting a new design. This will greatly simplify your efforts and will 
insert all necessary playlist fields for you.



Adding a Playlist Using the New CD Wizard
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When you use the New CD wizard to create your design and choose either an audio or data format 
(but not the General Purpose format), CD Labeler lets you import audio or data playlist information. 

For Audio CDs:

 
 Read playlist from CD will go directly to your CD to obtain the playlist information either by 

reading CD-Text or looking up the information from the Internet.
 Use Playlist Manager allows you to select from an entry in your Playlist collection to obtain 

the playlist information. From the Playlist Manager you can also read from your CD or manually enter 
a playlist.

 Go straight to the Label Designer does just that. You can then obtain the playlist 
information later.

For Data CDs:

 
 Edit data playlist leave this box checked to retrieve filenames from your CD. Uncheck it if 

you want to obtain the filenames later.
Note: You can add the playlist later, if you wish.



Importing Audio Playlist Information
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If you didn't import the audio playlist information when you created your design, you can still do it 
later. 

 Insert the CD you wish to read into the CD ROM drive.
 From the Design Bar, click on the Playlist icon and choose Get Contents from CD.

Note: If you already have a playlist in your design, you'll be asked if you wish to replace 
the current one. If you do, click Yes.

 If Audio CD information cannot be found on the CD, you'll have the option of searching for it 
online. You must be connected to the Internet to do this. If you see this message, click OK. 

 
Note: In cases where you want CD Labeler to always check online (especially if you're 
always connected to the Internet), you can check the Don't ask me again checkbox.

If CD information is found, it is added to your design. It is also automatically added to your 
playlist database.

Note: Occassionally, more than one playlist is found, in which case you'll be asked to 
choose which one to add.



Applying a Different Playlist from the Playlist Database
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You can quickly apply a different playlist from your playlist database to your exisiting design, which 
makes it easy to use your design for different CDs. You won't have to create a separate design for 
each CD!

 From the Design Bar, click on the Playlist icon and choose Playlist Manager.
 The Playlist Manager screen displays all the playlists already stored in your database. To select 

the playlist you wish to apply, click on it in the list.

 
Click Apply. All of the playlist fields in the design are changed to reflect the new playlist.



Creating a Custom Playlist with the Playlist Database
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Need a label for your CD of favorite songs? CD Labeler lets you choose the songs from your existing 
playlist database to create a custom playlist. 

 From the Design Bar, click on the Playlist icon and choose Edit Playlist Contents.
 Enter information about the CD on the General tab.

 
 Click on the Database tab. 
 Double-click on an album title in the CDs column to see its songs. Click on the song you wish 

to add to the Current Tracks column and click the 
 button, or simply double-click on the song to automatically add it.

 
To remove a song from the playlist:
Click on it in the Current Tracks column, and click the  button. This just removes the track from the 
playlist; it does not delete it from the database.

 
To clear the Current Tracks column of all songs:
Click the  button. This just removes all the tracks from the playlist; it does not delete them from the 
database.

 Repeat step 4 to add additional songs.



 
 When you're finished, click OK.

Changing the Track Order

If you wish to rearrange the order in which the tracks appear:

 Click the Tracks tab.
 Do one of the following:

Click the 
 button to move the highlighted track up once each time you click this button.

Click the 
 button to move the highlighted track down once each time you click this button.



Creating Your Own Playlist Data

{button Tutorials,JI(`',`Tutorials')}    {button 
Beginning,JI(`',`Tutor_Playlists00')}    {button << Prev Page,Prev()}    
{button Next Page >>,Next()}

You can create new playlists or edit existing ones for either audio or data CDs. The steps below 
describe how to create an audio playlist. 

Note: Creating a data playlist is is done the same way but has a few different options. See Data 
Playlist Options for the options that apply to a data playlist.

 From the Design Bar, click on the Playlist icon and choose Playlist Manager.
 Click the 

 button. 
 Enter information about the CD on the General tab.
 
 Click on the Tracks tab. Enter the track information and click the Add button to add each track.

 
As you continue to do this, your tracks will be added to the list.

 
 If you wish to delete a track, click on it in the list and click the Delete button.
 If you wish to edit a track, click on it, make your changes and then click the Change button.
 If you wish to clear the track info fields, click the New button.
 When you're finished, click OK.
 Click Apply to apply the custom playlist to the design.



Using the Playlist Manager
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The Playlist Manager screen lets you maintain the playlists in the following ways:

 From the Design Bar, click on the Playlist icon and choose Playlist Manager.
 Some features require that you first select the playlist with which you wish to work.

 
 Use the buttons described below to maintain the database. If a button is greyed out, it cannot 

be used. For example, some buttons are inactive when you select a playlist.

 
 When you're finished, click Apply or Close.



Importing Data Playlist Information
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CD Labeler makes it easy to import data information to your design.

 From the Design Bar, click on the Playlist icon and choose Get Playlist Contents from CD.
Note: If you already have a playlist in your design, you'll be asked if you wish to replace 
the current one. If you do, click Yes.

 Use the General, File List and Files tabs to select data from the CD. You can edit this 
information if you wish on the General and File List tabs.

 
 Click OK.



Adding a Playlist to an Existing Design
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If you have an existing design, you can add audio or data playlist information and pick the fields you 
wish to use

 From the Design Bar, click on the Playlists icon and choose Insert Playlist Fields.
 Select the field you wish to insert and click Insert.

 
 Select other fields if you wish and click Insert.

Note: You can work interactively with the design to place the fields in the order you wish to 
display them.

 Click Close.



Displaying Playlist Fields
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You can toggle between displaying playlist fields and the actual data contained in the fields.

Note: If you have playlist data displayed and want to display playlist fields, you may be asked to 
confirm this choice. If you have changed text in the playlist information, these changes will be lost 
when when you display playlist fields.

 From the Design Bar, click on the Playlist icon and choose Display Playlist Data.
Display Fields

 
Display Data
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How to Select Menus and Commands

Menus and Commands vs. Toolbar Buttons

We've constructed the CD Labeler Help so that the toolbar button is always our method of choice, if a 
button exists for that command. Otherwise, we might suggest a menu command or a shortcut key. We 
realize that often there are several other ways to perform a given command and we encourage you to 
use the method with which you feel most comfortable.

Using Alt and Ctrl Shortcut Keys

All menus and commands can be accessed using either the Alt key. Some use the Ctrl key in 
combination with another key.

Shortcut keys are shown in the CD Labeler Help like this: Alt+F, Ctrl+N or Ctrl+Del.

Right-Clicking with the Mouse

You can right-click many CD Labeler options, which brings up a menu of most-often-used commands 
for that option. These commands can change, depending on where you click.

You should get used to right clicking as you work with the program to familiarize yourself with this 
timesaving feature.

Reference Topics

Design Editor Commands
Keyboard Reference
Tools and Toolbars



Design Editor Menus and Commands

Menu Description

File Menu Perform all of CD Labeler's file operations.

Edit Menu Perform basic text and object manipulation.

View Menu Change viewing options for your designs and the design area.

Format Menu Change the appearance of characters, paragraphs, and graphic objects.

Insert Menu Draw and manipulate objects and merge features.

Playlists Menu Acess CD Labeler's playlist features, incuding a playlist database.

Tools Menu Access CD Labeler's object tools and control object properties, guides and 
gridlines, designs and more.

Window Menu Cascade or tile the document windows, arrange the icons which represent 
minimized document windows, and close all open documents. Configure CD 
Labeler's Speed Tools.

Help Menu Help get the most from CD Labeler using several different Help selections.



Design Editor File Menu

Menu Command Description

New Create a new design or database using the New Wizard.

Open Open an existing design.

Close Close the current design window.

Create Template Create customized layouts for label sheets not found within CD Labeler.

Save Save the current design.

Save As Save the current design under a new name.

Print Print the current design. If you have multiple designs, you can select them 
individually. Print merge data with your design.

Calibrate Printer Calibrate the printer.

Page Setup Create or modify a template to match an unsupported product type.

Print Preview Preview your design on the screen before you print it.

Printer Setup Setup printer to use for printing.

Export Design Export current design as a bitmap image to a separate file.

Scan Images Acquire images and backgrounds using a scanner, digital camera or other 
Twain-compatible device connected to your computer.

Select Twain Source
Select the Twain-compatible device you wish to use to acquire the image or 
background.

Acquire Image Acquire the image and save it as a picture file.

Acquire Image as Background
Acquire the image and save it as a background.

Send Send the design using Mail.

Exit Close the CD Labeler program, including all open windows.

File History List List of most recently used designs you can open by simply selecting them from 
the list.



  
    File / New

Shortcut keys: Alt+F,N or Ctrl+N

Create a new design using the SmartDesigns Creation Wizard.

Creating a New Design 

SmartDesigns Creation Wizard

Use this wizard to create a new design by answering a few simple questions. When you're finished, the 
wizard creates your design and your ready to continue.



  
    File / Open

Shortcut keys: Alt+F,O or Ctrl+O

Open an existing design or template.

File Open Dialog

 Select the file you wish to open. Navigate to a different drive and/or folder, if necessary.
 Click Open.

This dialog box also features Windows' What's This 
Help. To see an explanation of a particular option, 
right-click over the option, and then select What's 
This?.

Options

New Window. Check this option to open the file in a new window, which is useful if you wish 
to open multiple files. If this option is not checked, the file is opened in the current window. If the 
current window contains a design or template that has unsaved changes, you are prompted to save 
them first.



    File / Close

Shortcut keys: Alt+F,C or Ctrl+W

Close the current design window. If unsaved changes have been made to the design, you will be 
prompted to save them first. You can save them, ignore them, or cancel the Close command. If this is 
the first time you have saved the design, the Save As dialog box is displayed, where you can specify a 
filename and/or directory.



File / Template Creation Wizard

Shortcut keys: Alt+F,E

Create customized layouts for label sheets not found within CD Labeler.

Creating a New Template 

Template Creation Wizard

Use this wizard to create customized layouts by answering a few simple questions. When you're 
finished, the wizard creates your custom design and you're ready to continue.



  
    File / Save

Shortcut keys: Alt+F,S or Ctrl+S

Save any changes you have made to the current design. If this is the first time you have saved the 
design, choosing this command displays the Save As dialog box where you can specify a filename 
and/or directory.



File / Save As

Shortcut keys: Alt+F,A

Save the current design or template under a new name and/or directory location. 

File Save As Dialog

 Enter the file you wish to save. Navigate to a different drive and/or directory, if necessary.
 If you enter a filename and directory of an existing design or template, another dialog box is 

displayed asking whether you want to overwrite the existing file. Choose Yes to overwrite the existing 
file; choose No to return to the Save As dialog box where you can enter a different name or directory.

 Click Save.
This dialog box also features Windows' What's This 
Help. To see an explanation of a particular option, 
right-click over the option, and then select What's 
This?.

Options

File name. Enter the name of the file to save. The default filename extension is STD for 
design files and STT for template files. The default extension for the type selected is automatically 
appended to the filename you enter, unless you enter a different extension.

Save as type. Select the type of document to save as from the drop-down list: design files 
(STD) or template files (STT). The type you choose here determines the available files in the file list.



  
    File / Print

Shortcut keys: Alt+F,P or Ctrl+P

Print the current design. If you have multiple designs, you can select which one(s) to print. If you are 
printing merge data, you can select merge options.

Note: You can also print files by dragging them and dropping them on to the printer icon.

Printing 

Print Dialog

 Make your printer selections using the options described below.
Click on the label in the Sample window to select the starting label. The labels shaded in cyan 

represent the labels that will actually print on the first label sheet.

The little red arrows tell you which way to feed the paper into your printer (see also 
Paper Feeding Tips).

 Click Preview if you wish to see a sample of your design before you print it.
 Click Options if you need to make selections specific to your printer. See your printer's Help for 

details.
 Click OK.

Options

No. of labels to print. Select the number of labels to print, based on either individual labels 
or label sheets.

Label set options. For multiple labels, select an option: Print all labels in a set, print the 
current label only (make sure you have displayed the label you wish to print) or print a range of 
labels (enter the beginning and ending label).

Printer Options. Select the printer you wish to use from the Printer drop-down list and the 
bin you want to print to from in the Paper Source drop-down list.

Sample. Click on the label in the Sample window to select the starting label. The labels 
shaded in cyan represent the labels that will actually print on the first label sheet. The little red arrows 
tell you which way to feed the paper into your printer (see also Paper Feeding Tips).

No. Sheets Required. Shows you how many label sheets will be used with the current 
options.

Advanced button. Displays Advanced Settings dialog box for additional printing options.
Preview button. Lets you preview your label sheet.
Two-Sided button. Displays the Two-Sided Options dialog box for printing options used when 

printing on both sides of the sheet.
Merge button. Displays Merge Options dialog box for printing options used when printing 

merge records.
Stock button. Displays Print on Label Stock dialog box which allows you to select which label 

stock to use on the current design block.
Order Labels button. Lets you order additional labels online from LabelGear.com.



Print Merge Options

You must set a merge file using the Set Merge File dialog box before these options can be used. 

Merge Options Dialog

 Make your selections using the options described below.
 Click OK to return to the Print dialog.

Options

None, print merge fields only. Prints only the field names on your label instead of the 
actual merged data.

Print all records in merge file. Prints all the merge records in the merge file attached to this 
label design.

Print a range of records from. Prints the range of records you enter, such as 10 to 50. 
Choose this option and then enter the first and last record you wish to print. To print one record, enter 
the same number, such as 34 to 34.

Set Merge File. Select a different merge file from the one already attached using the Set 
Merge File dialog box.



Print Two Sided Options

When you are using two-sided designs, this tab lets you select additional print options. 

Two Sided Options Dialog

 Make your selections using the options described below.
 Click OK to return to the Print dialog.

Options

Print front side of the design. Prints on only the front side of the design. 
Print back side of the design. Prints on only the back side of the design. 
Print all front sides, followed by all back sides. Prints all the front sides first and then 

prints all the back sides. 
Reverse order when printing back sides. For printers where the finished label sheets come 

out in reverse order, this option prints the back sides in reverse order so that they print on the correct 
label sheet.

Prompt before printing back side. Lets you manipulate the order before running the label 
sheets through again.



Print Advanced Settings

Select advanced settings, such as printing to a file or printing the label sheet without the background 
(good for saving ink).

Advanced Settings Dialog

 Make your selections using the options described below.
 Click OK to return to the Print dialog.

Options

Print to file. Lets you print to a file rather than to a printer. When you click OK, a dialog box 
is displayed prompting you to enter an output filename. Enter the path and filename, and then click 
OK to create the output file.

Print crop marks at label boundaries. Check this box if you wish crop marks to be printed 
with the design.

Print backgrounds included in SmartDesigns. If you are using a background in your 
design, check this box to include it when you print your label. To save supplies, such as ink, or if 
you're printing test copies, you can uncheck the box so the background won't print. If the option is 
grayed, there is no background being used in the design.

Clip graphics and text to label boundaries. Check this box to clip printing according to the 
design you are using. Everything outside of the printable label area will not be printed. This is useful 
for saving ink if you are using an ink jet printer.

Test that all text fits within the text frame boundaries. Check this box to have all 
designs checked to see if text frames overflow (all the text won't fit in the frame). If so, you will be 
prompted on whether you want to continue with the Check for Overflow dialog.



Check for Overflow Dialog

When you check the Test for Overflow option on the Print dialog box, all designs are checked to see if 
any text frames are overflowed. If text frames do overflow (all the text won't fit in the frame), you will 
be prompted on whether you want to continue. 

Here are your options:

Overflow Detected. Displays the design, record (if applicable), block (if applicable), and side 
(if applicable) where overflow was detected.

Cancel Printing & show offending design/record. Cancels the print job and sets the 
current design/record to where overflow was detected.

Cancel Printing & return to current design. Cancels printing but does not change your 
current design.

Ignore warning & continue printing. Prints with the current options, ignoring the overflow.



    File / Calibrate Printer

Shortcut keys: Alt+F,L

Print a calibration sheet in order to align your designs when they print.

Calibrate Printer Dialog

Because each printer is full of working parts, the precision in each is slightly different. Sometimes this 
may cause CD Labeler to miss the mark when printing. If this happens to you, calibrating your printer 
may help. Here's how:

 Make your printer selections using the options described below.
 Click Options if you need to make selections specific to your printer. See your printer's Help for 

details.
 Click Print Calibration Sheet.
 Read the instructions on the sheet.
 Make alignment adjustments, if necessary, using the Offset Page and Expand/Shrink options.
 Click OK.

Note: Printer calibration may not solve all problems relating to hitting a label squarely on the mark. 
Because of the mechanics involved in feeding a sheet of paper through a printer, the paper often 
passes through the printer in a slightly different position each time.

We recommend that you provide a margin of error around the edge of any label, which is not critical to 
the design of the label itself. This will allow your labels to print correctly even when such shifts in the 
paper position do occur.

Options

Printer. Select the printer from the drop-down list you wish to calibrate, if it's not already 
selected.

Paper Bin. Select the paper bin from the drop-down list where paper is loaded, if it's not 
already selected.

Feed Type. Select whether paper feeds from the left, center or right.
Use with all bins. Use the Feed Type setting with all paper bins.
Offset Page. After printing and folding the calibration sheet, enter the value where the folded 

crease intersects the axis.
Expand/Shrink. After printing on actual stock, increase this value if text creeps up or left on 

the page the further down the printing happens.



File / Page Setup

Shortcut keys: Alt+F,G

Create or modify a template to match an unsupported label type. Open an existing product that most 
closely matches your custom design to modify.

Custom Page Setup Dialog

 Enter a name for your custom design.
 Make your selections to specify the design using the options described below. If you wish, you 

can place the cursor in a field to see a brief explanation of the field under the design preview. 
 Click the Hide checkbox if you do not need the Block information shown in the bottom half of 

the tab.
 Click Print Test Sheet if you wish to test your custom design as currently modified.
 Click Paper Size if you wish to make template changes in the Template Paper Size dialog box. 

This dialog lets you specify orientation, size of label sheet, two sided and the number of parts. You can 
also change the paper size and other page oriented fields for the template.

 When you're finished, click OK.

Options

Name. This starts as the name of the label type chosen when the file was new. The user can 
change this, and it appears in the status strip and in the About Template box. Not much utility to this 
field, I'm tempted to take it out.

Block Tabs. These correspond directly to the tabs in the label design area. You cannot add 
tabs, but you can hide them, if you wish (see Hide below).

Size. Enter the width and height of the label itself.
Bleed. Enter the amount of space horizontally and vertically outside the bounds of the label 

into which CD Labeler will print. This sets the bleed space around a design, objects can be moved into 
this space. The bleeds of two designs may overlap, but the bleed of one design cannot overlap another 
design.

Sub-Block 1 of N. First, a block is a group of labels on a sheet that share a common shape 
and size. They may or may not be uniformly laid out on the page. 

Secondly, every block has at least 1 sub-block. A sub-block describes a group of labels in a block that 
are uniformly laid out. In other words, they have to repeat in some sort of regular grid like fashion. 
With media labels especially, the manufacturers put extra labels wherever they can, and must be 
broken into more than 1 sub-block to fully describe the entire block of labels. 

Across. Number of labels across in the sub-block.

Down. Number of labels down in the sub-block.

Hide. If checked, CD Labeler makes the block totally invisible and unusable. This is useful, for 
example, if you are going from a CD label, which includes Jewel Case spines to one without them.

Alternating. When the first row starts at a different X coordinate than the second row, or they are 
'staggered'. Additionally, since they are staggered, the rows may actually overlap, and only the 
staggering prevents them from printing over the top of each other. Examples of alternating labels 
include the Neato 3-up and the Press-IT 2-up.

Start Position. Position of the first label on the page with respect to the upper-left hand corner of the 
page.

Label Span. Horizontal distance from the left edge of the left most label in the sub-block to the right 
edge of the right most label in the sub-block. Same for vertical except top-most and bottom-most. 
This method of measuring avoids cumulative rounding errors in very small labels.



Label Span Exception. If Alternating is checked, these are measured a bit differently. It is measured 
from the left edge of the first label to the left edge of the second label, and from the top edge of the 
first label to the top edge of the second label.

Preview. This window serves two purposes. First, it is a graphical display of the current 
settings. You can position labels off the page and even out of view if your measurements don't work.

Second, it serves as a navigational tool. You click on a label in the preview to set the block folder and 
sub-block to that set of labels. The current block is always highlighted with dark blue and the current 
sub-block is always filled in with cyan. So in most simple cases (where there is only 1 sub-block) the 
entire block is outlined in dark blue and filled in with cyan.

Tips Below Preview. These are tips providing field information and sensitive to the field you 
are editing. Feel free to recommend better wording to be consistent with your treatment in the help 
file.
Print Test Sheet button. Test your custom design as currently modified.
Paper Size button. Make template changes in the Template Paper Size dialog box. This dialog lets 
you specify orientation, size of label sheet, two sided and the number of parts. You can also change 
the paper size and other page oriented fields for the template.
Flip Design button. Flip the design horizontally.



    File / Print Preview

Shortcut keys: Alt+F,V

View your design on the screen before you print it.

Print Preview Dialog

 Use Next Page and Prev Page, if they are available, to see additional designs, copies or merge 
data.

 Click Zoom In and Zoom Out if you wish to change the magnification view of your design.
 Click Print if you wish to print your design now.
 Click Cancel if you wish to close the Print Preview dialog box.

Note: When using Print Preview, you will notice a red-hatch pattern around the perimeter of the page. 
This denotes the area on the page that your printer is unable to reach (and will change from printer to 
printer). If part of your design extends into this area, be forwarned your printer will be unable to print 
that portion of your design. It is recommended that you modify your design so that no part extends 
into the red-hatch.



    File / Printer Setup

Shortcut keys: Alt+F,R

Select the active printer and specify printer-specific options.

Printer Setup Dialog

 Make your printer selection using the options described below.
 Click Options if you need to make selections specific to your printer. See your printer's Help for 

details.
 Click OK.

Options

Default Printer. Prints your design on the default printer (the printer shown below this 
option).

Specific Printer. Select a specific printer from the drop-down list.



File / Export Design

Shortcut keys: Alt+F,T

Export the current design as a bitmap image to a separate file. This is useful for copying the image to 
a computer that doesn't have CD Labeler installed, or perhaps sharing the design with a friend.

Export Design Dialog

 Enter the file you wish to export to. Navigate to a different drive and/or directory, if necessary.
 If you enter a filename and directory of an existing file, another dialog box is displayed asking 

whether you want to overwrite the existing file. Choose Yes to overwrite the existing file; choose No to 
return to the Export Design dialog box where you can enter a different name or directory.

 Click Save.
This dialog box also features Windows' What's This 
Help. To see an explanation of a particular option, 
right-click over the option, and then select What's 
This?.

Options

Size / Width. This field shows the actual width of the image in pixels. You can change it, if 
you wish, to reduce or enlarge the size of the image. CD Labeler will maintain the aspect ratio, that is, 
it will change the height in proportion to the new width.

Size / Height. This field shows the actual height of the image in pixels. You can change it, if 
you wish, to reduce or enlarge the size of the image. CD Labeler will maintain the aspect ratio, that is, 
it will change the width in proportion to the new height.

Resolution. Select a resolution in dots per inch (DPI) from the drop-down list or enter the 
desired resolution.



File / Scan Images / Select Twain Source

Shortcut keys: Alt+F,I,S

Many people have more than one TWAIN compatible device attached to their computer. For example 
you may have a scanner and a digital camera, both of which can be used to acquire images. 

In such cases, you'll need to select the device you wish to use before acquiring images.

From the File menu, choose Select Twain Source. 
Select the device you wish to use from the list presented. 
Note: If you do not see your device listed, it may not be installed properly. Check your 

device's documentation for details.
Click OK.



File / Scan Images / Acquire Image

Shortcut keys: Alt+F,I,I

Acquires the image from the TWAIN compatible device attached to your computer. Before you attempt 
to scan an image, be sure your TWAIN compatible device is attached to your printer, and is turned on.

Note: If you have more than one TWAIN compatible device, you must select the one you wish to use. 

From the File menu, choose Scan Images.
From the popup menu, choose Aquire Image.
Your TWAIN compatible software will lead you through the process of acquiring the image. 
After it has been acquired, the image will be placed in the label. Move and resize it to the 

desired position.



File / Scan Images / Acquire Image As Background

Shortcut keys: Alt+F,I,B

Scanning an image as a background is much like scanning a normal image, except that the image is 
placed and sized to fit on the background layer automatically. 

Before you attempt to scan an image, be sure your TWAIN compatible device is attached to your 
printer, and is turned on.

Note: If you have more than one TWAIN compatible device, you must select the one you wish to use.

From the File menu, choose Scan Images.
From the popup menu, choose Aquire Image as Background.
Your TWAIN compatible software will lead you through the process of acquiring the image.
Using your TWAIN compatible software, closely crop the image to the desired size. For 

example, if you are scanning a CD, crop the image to the bounding box that encompasses the circle. 
This will make the automatic background sizing in CD Labeler work properly.

Choose Background Properties to adjust how the image is stretched to fit the CD. In particular, 
for scanned CDs, it is often better to set the background to Stretch to Design rather than Stretch to 
Design w/Bleed (the default setting).



File / Send

Shortcut keys: Alt+F,D

Send the current design to someone using Mail. Consult your Windows Reference manual on how to 
setup and use mail.



    File / Exit CD Labeler

Shortcut keys: Alt+F,X or Alt+F4

Quit CD Labeler. If any unsaved changes have been made to open SmartDesigns when you choose this 
command, you are prompted to save them first.



File / History List

Shortcut keys: Alt+F,1 through Alt+F,5

List of most recently used designs. Click on a file to load the design.



Design Editor Edit Menu

Menu Command Description

Undo/Redo Undo / Redo last operation.

Cut Cut object(s) or text to clipboard.

Copy Copy object(s) or text to clipboard.

Paste Paste object(s) or text from clipboard.

Paste Background Paste object(s) or text from clipboard as a background in the current design.

Paste Special Paste OLE object(s) with non-default attributes.

Duplicate Design Duplicate design(s). Same as the Tools / Designs / Duplicate command.

Delete Design Delete design(s) when more than one design exists. Same as the Tools / 
Designs / Delete command.

Find Search for text in design(s).

Replace Search for and replace text in design(s).

Find Next Repeat last search or replace command to find and/or replace the next 
occurrence.

Select All Select all object(s) or text in a design.

Select None Deselect all objects in the current design.

Change Label Stock Select which label stock to use for the current SmartDesign.



    Edit / Undo and Edit / Redo

Shortcut keys: Alt+E,U (Undo), Alt+E,R (Redo), Alt+Backspace or Ctrl+Z (Undo or Redo)

Reverse the effect of the last action you performed, such as typing, deleting or formatting text, 
creating or moving graphic objects, inserting a page break, etc.

The actual name of this command as it is displayed in the menu reflects the exact nature of the action 
you can undo. Here are two examples:

If you just deleted some text by selecting it and pressing the Delete key, the name changes to 
Undo Typing.

If you just formatted some text to Bold, the name changes to Undo Format.
If you select the Undo command, the command in the menu changes to Redo. The Redo command lets 
you undo the last Undo.



    Edit / Cut

Shortcut keys: Alt+E,T, Shift+Del or Ctrl+X

Delete the selected text or object(s) from your design and place it on the Clipboard where it can be 
pasted elsewhere.

Text and pictures can be cut and pasted to other Windows programs such as Paintbrush or Write, but 
objects created with CD Labeler can only be cut and pasted to other CD Labeler designs.

The name of this command changes to identify what you are about to cut. Here are two examples:

If you just selected some text, the command name changes to Cut Text.
If you just selected an object such as a graphic or text frame, the name changes to Cut 

Object.



    Edit / Copy

Shortcut keys: Alt+E,C, Ctrl+Ins or Ctrl+C

Place a duplicate of the selected text or object(s) onto the Clipboard where it can be pasted 
elsewhere.

Text and pictures can be copied and pasted to other Windows programs such as Paintbrush or Write, 
but objects created with CD Labeler can only be copied and pasted to other CD Labeler designs.

The name of this command changes to identify what you are about to copy. Here are two examples:

If you just selected some text, the command name changes to Copy Text.
If you just selected an object such as a graphic or frame, the name changes to Copy Object.



    Edit / Paste

Shortcut keys: Alt+E,P, Shift+Ins or Ctrl+V

Place the contents of the clipboard (the last text or object you cut or copied) back into a design.

The name of this command changes to identify what you are about to paste. Here are two examples:

If you just cut or copied some text, the command name changes to Paste Text. 
If you just cut or copied an object such as a graphic or frame, the command name changes to 

Paste Object.
Certain objects can be pasted in text mode as well as object mode, such as pictures. By pasting a 
picture in text mode, you can anchor it to the text.

OLE objects are pasted using the Paste Special command.



Edit / Paste Background

Shortcut keys: Alt+E,B

Place the contents of the clipboard (the last text or object you cut or copied) as a background in the 
current design.

Paste Background

 Copy or cut any object(s) or text you wish to use as the background for your design. You can 
do this in CD Labeler or any other program that allows you to copy or cut to the clipboard.

 From the Edit menu, choose Paste Background. The contents of the clipbaord is displayed on 
your design as a background.



Edit / Paste Special

Shortcut keys: Alt+E,I

Paste in OLE objects with non-default attributes.

Paste Special

 Click either the Paste or Paste Link radio button, depending on how you wish the contents of 
the clipboard to behave. The Result at the bottom of the dialog box explains what will happen.

If Display as Icon is displayed, click it to display the contents as an icon in your design. You 
can change the icon, if you wish.

Click OK.
This dialog box also features Windows' What's This 
Help. To see an explanation of a particular option, 
right-click over the option, and then select What's 
This?.

 Edit / Duplicate Design or Tools / Designs / Duplicate Design

Shortcut keys: Alt+E,L or Alt+O,S,P

Duplicates the current design any number of times and inserts or appends them into the current 
SmartDesign.

Duplicate a Design

 Click on the Duplicate Design tab if it is not already displayed.
 Select the duplicating options as described below.
 Click OK.

Options

No. of Copies. Enter the number of times you would like the current design duplicated. 1 is 
the default.

Insert at current position. If this option is checked, the new design(s) is inserted into the 
SmartDesign before the current design.



Edit / Delete Design or Tools / Designs / Duplicate Design

Shortcut keys: Alt+E,D or Alt+O,S,D

Deletes one or more designs from the current SmartDesign.

Delete a Design

 Click on the Delete Design tab if it is not already displayed.
 Select the deleting options as described below.
 Click OK.

Options

No. of designs to delete. Enter the number of designs to delete from the current 
SmartDesign. 1 is the default.

Beginning with design. Enter the number of the first design to delete. For example, if you 
wish to start with the second design, enter 2. The current design is the default.



    Edit / Find

Shortcut keys: Alt+E,F or Ctrl+F

Search your design for specific text and/or formatting attributes.

Find Dialog

 Make your search selections using the options described below.
 Click the Character and Paragraph buttons to search for specific character and/or paragraph 

formatting. For example, if you check Italic, CD Labeler only searches for italicized text. If you select 
left alignment, CD Labeler only searches for paragraphs that are aligned left. Click the Clear button to 
clear any existing formatting search criteria.

 Click Replace to use the search and replace feature.
 When you're ready to search, click Find Next. If CD Labeler can't find the search text, it 

displays an error message.
 When you're finished, click Done.

Options

Search For. CD Labeler can search for any text you can enter from the keyboard, but cannot 
locate tabs. Spaces are OK, enabling you to search for groups of words. You can search for carriage 
returns using ^n and ^r. '^n' matches all carriage returns, '^r' matches only those returns which are 
NOT immediately followed by another '^r'. You can also search for specific character and/or paragraph 
formatting attributes using the Character and Paragraph buttons as described in step 2 above.

Ignore Case. Check this box to ignore if a letter is upper or lower case; uncheck to locate 
text exactly as you type it, looking for exact matches of upper and lower case letters.

Whole Word. Check this box to search for whole words; uncheck it to search just for text 
embedded within other words.



    Edit / Replace

Shortcut keys: Alt+E,E or Ctrl+H

Search for and replace one text string and/or formatting attributes with another.

Replace Dialog

 Make your search and replace selections using the options described below.
 Click the Character and Paragraph buttons to replace specific character and/or paragraph 

formatting. Click the Clear button to clear any existing formatting replace criteria.
 When you're ready to search, click Start. If CD Labeler can't find the search text, it displays an 

error message.
 Use Replace to selectively replace occurrences; use Replace All to replace all occurrences 

without asking first.
 When you're finished, click Done.

Options

Search For. CD Labeler can search for any text you can enter from the keyboard, but cannot 
locate tabs. Spaces are OK, enabling you to search for groups of words. You can search for carriage 
returns using ^n and ^r. '^n' matches all carriage returns, '^r' matches only those returns which are 
NOT immediately followed by another '^r'. You can also search for specific character and/or paragraph 
formatting attributes using the Character and Paragraph buttons as described in step 2 above.

Replace With. Specify the text and/or paragraph formatting with which you wish to replace 
the current match.

Ignore Case. Check this box to ignore if a letter is upper or lower case; uncheck to locate 
text exactly as you type it, looking for exact matches of upper and lower case letters.

Whole Word. Check this box to search for whole words; uncheck it to search just for text 
embedded within other words.



     Edit / Find Next

Shortcut keys: Alt+E,N or F3

Repeat the last Find or Replace command you issued. CD Labeler searches for the next occurrence of 
the text you entered in the Find dialog box or displays the Replace dialog box after it has located the 
next occurrence of the search text.



    Edit / Select All

Shortcut keys: Alt+E,A or Ctrl+A

Highlight or select all text in the current text frame (text mode) or all objects in the current design 
(object mode).



Edit / Deselect All

Shortcut keys: Alt+E,O

Deselect all objects in the current design.



    Edit / Change Label Stock

Shortcut keys: Alt+E,K

Select which label stock to use on the current design block.

Applying a Different Label Stock to Your SmartDesign 

Stocks Dialog

 In the Blocks to apply column, make sure that only the blocks that apply to your new label are 
checked. Uncheck the ones that do not apply. This affects which labels you see in the New Stock 
column, as only the labels that support the selected blocks are displayed. 

For example, if you select both CD Label and CD Spine, you will not be shown stock that does 
not contain both of these.

 Select the product on which you are printing in the New Stock column. Use the scroll bar to 
see additional products. 

 Click OK.



Design Editor View Menu

Menu Command Description

Clip to Label Clip the design area to the current label design, including design features 
such as text, pictures and backgrounds.

Blocks

Show/Hide Show/Hide blocks from a list of all blocks.

List of Blocks List blocks you select to Show or Hide with the Show / Hide command. 
Check it to show the block; uncheck it to hide the block.

Sides

Front View the front of the design (2-sided designs only).

Back View the back of the design (2-sided designs only).

View Options

Show Pictures Toggle the display of pictures you've inserted in your document.

Show Field Codes Toggle the display of field codes in your design.

Set Merge Record Toggles the display of the merged data of a particular record from a merged 
database or list.

Show Design Bar Toggle display of the Design Bar.

Show Variation Bar Toggle display of the Variation Bar.

Show Command Bar Toggle display of the Command Bar.

Show Block Folders Toggle Display of the Block Folder.

Show Rulers Toggle the display of the Rulers.

Show Frame Bounds Toggle the display of the frame boundaries that are placed over your design.

Show Control Strip Toggle the display of the Control Strip.

Show Status Strip Toggle the display of the Status Strip.

Show Speed Tools Toggle the display of the Speed Tools.

Zoom

Current Zoom Level Display the current zoom level as a percentage.

Zoom fit in Window Zoom in on page (full page) or design (single design) to fit exactly in the 
window frame.

Zoom In Increment to the next zoom level.

Zoom Out Decrement to the next zoom level.

Actual Size Set zoom level to 100%.

Custom Zoom Enter a zoom percentage.



View / Clip to Label

Shortcut keys: Alt+V,C

Clips your design to show only the areas that will print on the usable part of your label sheet. This 
immediately shows you which parts of your design, such as backgrounds, won't be part of the label. It 
also saves on ink because it won't print parts of your design that do not fall within the label areas.

Using the "Clip to Label" Feature



    View / Blocks / Show/Hide

Shortcut keys: Alt+V,B,S

Show / Hide design item(s).

Selecting a Design Block Folder

Show/Hide Dialog

This is a list of all blocks in the current design, if the field has a check beside it, it is visible, otherwise 
it is hidden. 

A check beside a block does not necessarily mean it will show up in the current design. Some 
blocks are only available on certain layouts and/or accents.

If there is only one block in the list, it cannot be hidden.

Design Editor Block Folder

The Design Editor Block Folder is the folder that contains your design. Some label designs have more 
than one block folder, such as the CD label, the Jewel Case Title label and the jewel Case Spine label. 

 
The block folder lets you view the design blocks in your design by simply clicking on the tab associated 
with the block folder.



Hide

Toggles the display of these items when you right-click and choose Hide over the area:

Design Bar on the left-hand side of the Design Editor window.
Variation Bar on the bottom of the Design Editor window.
Block Folder that surrounds the Design Editor design.
Command Bar allows you quick access to often-used functions while working with your design.

Working in the Design Area



View / Sides / Front

Shortcut keys: Alt+V,S,F or click the Front tab (block folder)

View the front of the design (2-sided designs only).



View / Sides / Back

Shortcut keys: Alt+V,S,B or click the Back tab (block folder)

View the back of the design (2-sided designs only).



View / View Options / Show Pictures

Shortcut keys: Alt+V,V,P

Toggle the display of pictures you've inserted in your document. 

Check this option to hide pictures (a gray rectangle is displayed in its place). Pictures are still printed, 
even if they are hidden. 

All text-wrap, size and position attributes for any pictures remain intact. 

This option is useful if you need to speed up screen display.



View / View Options / Show Field Codes

Shortcut keys: Alt+V,V,F

Toggle the display of field codes rather than the actual data, text or values of inserted fields. For 
example, if you inserted the Print Date field in your document and this option is not checked, the date 
is displayed like this: 28-May-94. 

If this option is checked, the name of the inserted field is displayed like this: {Print Data}.



View / View Options / Set Merge Record

Shortcut keys: Alt+V,V,M

Toggle the display of the merged data of a particular record from a merged database or list. This 
option is gray if no database or list has been merged.

Inserting Merge Fields



View / View Options / Design Bar

Shortcut keys: Alt+V,V,D

Toggle the display of the Design Bar on the left-hand side of the Design Editor window. 

Design Editor Design Bar

The Design Bar is displayed along the left side of the Design Editor Window. It lets you quickly access 
several design options by simply clicking on the appropriate icon.

 
If you do not see the Design Bar, click on the 

 icon near the bottom of the window. 
When you wish to hide the Design Bar again, click on the 

 icon.
There are other options at the bottom of the Design Bar:

Click the 
 icon to set Program options and User Information in the Program Options dialog box.

Click the 
 icon to toggle the program's sound on and off.

Click the 

 icon to view tips on how to use the program.
Customizing Your Design with the Design Bar



View / View Options / Show Variation Bar

Shortcut keys: Alt+V,V,V

Toggle the display of the Variation Bar along the bottom of the Design Editor window. 

Using SmartDesigns

SmartDesign Variation Bar

The Variation Bar is displayed along the bottom of the Design Editor Window for non-blank 
SmartDesigns. If you are using a blank design, the Variation Bar will not be displayed. 

 
Scroll through the options of a variation using the  and 

 arrows or click on the name between the arrows to choose from a list.
 

If you do not see the Variation Bar, choose View / View Options / Show Variation Bar (Alt+V,V,V) to 
display it. 

You can hide the entire Variation Bar by right-clicking on it, and choosing Hide Variation Bar.
You can hide individual variation controls by right-clicking on the Variation Bar area, and 

choosing the variation you wish to hide.



View / View Options / Show Command Bar

Shortcut keys: Alt+V,V,O

Toggle the display of the Command Bar. The Command Bar allows you quick access to often-used 
functions while working with your design. 

Command Bar

You can also show or hide the command bar by right-clicking the bar area and choosing Show 
Command Bar or Hide Command Bar.

 
Note: If the Command Bar is hidden, you'll need to precisely point to the edge of where the 
Command Bar is usually displayed, before you right-click. If Show Command Bar does not appear in 
the menu, try again until you see this command.

Options

New. Start a new design, database or template using the New Design Wizard.
Open. Open a previously saved design, database or template. Same as the File / Open 

command.
Save. Save the current design. Same as the File / Save command.
<<Prev. Display the previous design when using multiple designs.
Duplicate. Duplicate design(s). Same as the Designs / Duplicate command.
Next >>. Display the previous design when using multiple designs.
Print. Print designs. Same as the File / Print command.
Preview. Preview the design.
X. Hide the Command Bar.



View / View Options / Show Block Folders

Shortcut keys: Alt+V,V,B

Toggle the display of the Design Editor Block Folder, which is the folder that contains your design. 
Some label designs have more than one block folder, such as the CD label, the Jewel Case Title label 
and the Jewel Case Spine label. 

 
The block folder lets you view the design blocks in your design by simply clicking on the tab associated 
with the block folder.



View / View Options / Show Rulers

Shortcut keys: Alt+V,V,R

Toggle the display of the rulers in the design area. Both vertical and horizontal rulers are used.

Toggling the Ruler Style

When the rulers are displayed, you can right-click anywhere on them, and choose Toggle Style to 
change the style of the rulers displayed.

 

 



View / View Options / Show Frame Bounds

Shortcut keys: Alt+V,V,A

Toggle the display of the frame boundaries that display over the design in the Design Editor window. 
Objects such as text and pictures display the boundaries of the object, such as the text object shown 
below:

 



View / View Options / Show Control Strip

Shortcut keys: Alt+V,V,C

Toggle the display of the control strip, which contains buttons and menus for commonly used functions 
for the current window. 

Design Editor Control Strip

The control strip is displayed along the top of the CD Labeler window, the controls available change 
depending upon whether the current window is a Design Editor window. 

Click on any feature of the Control Strip shown below to see its function:

 

  



Switch to text mode, which lets you click on and edit text frames. The cursor changes to an "I-Beam."



Switch to pointer mode, also called object mode, which lets you click on and change objects, such as 
pictures and text effects frames.



Select the Rotation Tool, which lets you rotate text frames and bitmaps at 90 degree increments, and 
metafiles and Text Effects at any arbitrary angle. Note: Groups cannot be rotated.



Select the Transparency tool to make a color in your object transparent, thus displaying the 
background color in its place.



Select the mode or tool to be used. The current one displayed is the active one.

The Text Frame tool allows you draw a frame to enter text.
The Picture tool lets you draw a picture frame to add a graphic.
The Text Effect tool lets you draw a text effect frame to create a text effect.
The Line tool lets you draw a line.
The Rectangle tool lets you draw a rectangle, including a square.
The Rounded Rectangle tool lets you draw a rectangle with rounded corners.
The Ellipse tool lets you draw an ellipse, including a circle.
The OLE object tool lets you import an OLE object.
Text mode lets you click on a text object to enter or change text.Pointer mode, also called object mode 
lets you click on an object to resize, move, delete, change its properties and so on.The Rotation Tool 
lets you rotate text frames and bitmaps at 90 degree increments, and metafiles and Text Effects at 
any arbitrary angle.
The Transparency tool lets you select a color in your object to be transparent.



Select or type in a font name to use or apply to the current selection.



Select or type in a point size to use or apply to the current selection.



Select the color of the selected text or object.



Toggle the bold attribute for selected text, or for text about to be entered.



Toggle the italic attribute for selected text, or for text about to be entered.



Toggle the underline attribute for selected text, or for text about to be entered.



Change the horizontal alignment of the current paragraph. The options are left, right, centered, and 
justified.



Change the vertical alignment of the current frame. The options are top, bottom, centered, and flush. 
This is only available for text frames that do not size vertically.



Increment to the next zoom level. 

Using the Zoom Feature



Decrement to the next zoom level. 

Using the Zoom Feature



Display your entire design in the design area. Note: Only the design for that block folder is displayed, 
which may differ from the entire sheet of labels.

Using the Zoom Feature



Retrieve playlist information stored on the CD or search for this information online.

Working with Playlists 



Retrieve playlist information stored on the CD or search for this information online.

Working with Playlists 



View / View Options / Show Status Strip

Shortcut keys: Alt+V,V,S

Toggle the display of the status strip at the bottom of the window. 

Design Editor Status Strip

The status strip is displayed along the bottom of the CD Labeler window. Click on any of the three 
boxes in the Status Strip shown below to see what type of information is displayed.

 



Display information on what CD Labeler is currently doing (if hourglass is on) and gives information 
about the control the cursor is over.



Display the name of the currently selected object.



Display the name of the current SmartDesign label stock.



View / View Options / Show Speed Tools

Shortcut keys: Alt+V,V,T

Toggle the display of speed tool bar, which consists of a set of buttons that provide a shortcut for 
many commands. You can configure the speed tools to best suit your needs using the Window / 
Configure Speed Tools dialog box or by double clicking on any portion of the speed tools bar which 
does not contain a button. 

Design Editor Speed Tools

Click on any of the Speed Tools shown below to see its function:

 



Start a new design. See File / New.



Open a previously saved design. See File / Open.



Save the current design. See File / Save.



Print out designs, including designs with merge data. See File / Print.



Calibrate the printer. See File / Calibrate Printer.



Set up the printer. See File / Printer Setup.



Undo and redo previous operations. See Edit / Undo and Edit / Redo.



Copy text or objects to the clipboard to paste elsewhere, and then delete them. See Edit / Cut.



Copy text or objects to the clipboard to paste elsewhere. See Edit / Copy.



Paste text or objects from the clipboard into the current frame/design. See Edit / Paste.



Create a text frame where you can enter text or merge fields. See Tools / Object / Text Tool.



Create a picture frame where you can insert a picture. See Tools / Object / Picture Tool.



Create a text frame with special effects. See Tools / Object / Text Effect Tool.



Search for text and/or formatting. See Edit / Find.



Search for and replace text and/or formatting. See Edit / Replace.



Repeat the last Search or Replace operation. See Edit / Find Next.



Bring the object to the top of all other objects. See Tools / Bring to Front. 



Send the object to the back of all other objects. See Tools / Send to Back.



Select all objects in the current design or all text in the current frame. See Edit / Select All.



Display the Tools / Program Options dialog box.



Show/hide items in the current design. See Tools / Designs / Show/Hide Items.



Set the database file to use for merges. See Insert / Set Merge File.



Insert a merge field at the current position. See Insert / Insert Merge Field.



Change the label stock for the current SmartDesign. See Edit / Change Label Stock.



Display information about the current SmartDesign template. See Help / About Template.



View / Zoom / Current Zoom Level

Shortcut keys: Alt+V,Z

Display the current zoom level (as a percentage) in the first line (grayed out) of the commands. Use 
one of the other Zoom commands to change the percentage. 

Using the Zoom Feature



View / Zoom / Zoom to fit in Window

Shortcut keys: Alt+V,Z,W

Display your entire design in the design area. Note: Only the design for that block folder is displayed, 
which may differ from the entire sheet of labels.

Using the Zoom Feature



View / Zoom / Zoom In

Shortcut keys: Alt+V,Z,+ or Ctrl+Plus (numeric keypad)

Increment to the next zoom level. 

Using the Zoom Feature



View / Zoom / Zoom Out

Shortcut keys: Alt+V,Z,- or Ctrl+Minus (numeric keypad)

Decrement to the next zoom level. 

Using the Zoom Feature



View / Zoom / Actual Size

Shortcut keys: Alt+V,Z,Z

Set zoom level to 100%. 

Using the Zoom Feature



View / Zoom / Custom Zoom

Shortcut keys: Alt+V,Z,U

Select a view size from a list of available sizes or enter a view size of your own from 30 to 400%. 

Using the Zoom Feature

Zoom Dialog Box

 Select a view size from the list or type a view size. View sizes you enter must be in the range 
30 to 400%.

 Click OK.



Design Editor Format Menu

Menu Command Description

Character Edit character attributes of selected text.

Bold Toggle bold attribute on selected text.

Italic Toggle italic attribute on selected text.

Underline Toggle underline attribute on selected text.

Word Underline Toggle word underline attribute on selected text.

Paragraph Edit paragraph attributes on selected text.

Borders Edit border attributes on selected paragraphs or objects.

Tabs Edit tabs on selected paragraphs.

Bullets Edit bullets on selected paragraphs.

Lines Edit lines on selected paragraphs or objects.

Shades Edit shades on selected    paragraphs or objects.

Wrap to label bounds If checked, wraps text in a text frame according to its current size; if 
unchecked, expands the text frame to accommodate the amount of text.

Set wrap margin Add additional wrap space within a text frame.

Background Objects Make background SmartDesign Objects selectable.



Format / Character

Shortcut keys: Alt+T,A

Change the character formatting attributes of selected text or set the attributes for new text you type. 
Character formatting attributes consist of typeface selection (font and font variations such as bold, 
italic, etc.), font size in points, underlining options, and super/subscripting.

Character Formatting Shortcut Keys 

Character Dialog

 Click on the appropriate tab in the dialog box to make your selections using the options 
described below. The Sample area shows the current format, letting you see the effect of your 
formatting choices before applying them.

Note: Click Default if you wish to return all formatting options to the defaults.

 Click Apply.

Notes

You can also use the Control Strip to change the character formatting of highlighted text.

This dialog box can also appear when you are searching and replacing formatting attributes using the 
Find and Replace commands.

Font/Style Tab

Use this tab to select the font, point size and style, as well as underlining and capitalization effects 
(described below).

Underline. There are two different types of underlining effects: continuous underline and 
word underline. Continuous underline underlines text, spaces, and tabs. Word underline does not 
underline spaces or tabs. For either underlining option, you can specify whether you want the 
underline to be a single or double line.

Capitals. You can choose Small Caps to show text in all uppercase, but making the lowercase 
letters a specified percentage of the uppercase letters.

Position/Spacing Tab

Use this tab to select superscript and subscript positioning, as well as spacing between individual 
characters. 

Super/Subscript. Choose Superscript to move text above the baseline (an imaginary line 
where characters rest); choose Subscript to move text below the baseline. If neither option is 
selected, text is positioned on the baseline. The Position value determines how much, relative to the 
normal text height, text should be moved up or down - 20% is the default. The Size value lets you 
specify whether super- or subscripted text should be reduced in size. The default value of 80% means 
that text will be reduced by 20%, e.g., if the point size is 10 points, super- or subscript text would be 
set to 8 points.

Spacing. Enter in Amount how much wider you want the characters to be spaced than the 
default. Enter in Pitch how much wider you want the characters to appear than default. You can enter 
decreasing spacing and pitch as well.



 Format / Bold

Shortcut keys: Alt+T,B or Ctrl+B

Toggles bold print on or off for highlighted text. 

If no text is selected, sets bold print for subsequent text you type until you toggle bold off again.

Character Formatting Shortcut Keys 



 Format / Italic

Shortcut keys: Alt+T,I or Ctrl+I

Toggles italic print on or off for highlighted text. 

If no text is selected, sets italic print for subsequent text you type until you toggle italic off again.

Character Formatting Shortcut Keys 



 Format / Underline

Shortcut keys: Alt+T,U or Ctrl+U

Toggles underlining on or off for highlighted text. All words and spaces are underlined. 

If no text is selected, sets underlining for subsequent text you type until you toggle underlining off 
again. 

To underline words and not spaces, see the Word Underline command.

Character Formatting Shortcut Keys 



Format / Word Underline

Shortcut keys: Alt+T,W or Ctrl+Shift+W

Toggles underlining on or off for highlighted text. Only words, and not spaces, are underlined.

If no text is selected, sets underlining for subsequent text you type until you toggle underlining off 
again.

To underline words and spaces, see the Underline command.

Character Formatting Shortcut Keys 



Format / Paragraph

Shortcut keys: Alt+T,P or Ctrl+M

Change the paragraph formatting attributes of selected text or set the attributes for the paragraph 
containing the cursor. Paragraph formatting attributes are applied to entire paragraphs, rather than 
single characters or words. Alignment, indents, line spacing, tab placement, etc., are examples of 
paragraph formatting attributes.

Paragraph Formatting Shortcut Keys 

Paragraph Dialog

 Click on the appropriate tab in the dialog box to make your selections using the options 
described below.

 You can go directly to other formatting options by clicking Paragraph Character, Bullet, Shades 
or Border.

 Click Apply.

Notes

You can also use the Control Strip to change the paragraph formatting of highlighted text.

This dialog box can also appear when you are searching and replacing formatting attributes using the 
Find and Replace commands.

Spacing Tab

Use this tab to change the paragraph indent , line spacing and alignment settings.

Indent. Enter values in these boxes to control the amount of space between a paragraph and 
the left or right margin. By default, paragraph indents are lined up on the margins, i.e., set to 0.00 
centimeters.

Spacing. Line spacing is the vertical distance between lines of text in a paragraph, and is 
controlled by two factors: the size of the font, and the Leading value specified for a paragraph. A 
leading value of 100% means no additional spacing beyond that built into the font itself (individual 
fonts may vary considerably). Entering a larger value increases the space between lines, a smaller 
value decreases the space.

You can also add spacing between paragraphs. To add extra space between paragraphs, 
enter values for the amount of space you want above, below, or both above and below 
the current paragraph or selected paragraphs in the Before and After boxes. These 
values do not affect the amount of space between lines within a paragraph. The default 
is 0.

Alignment. Choose options from the list to apply left or right alignment to a paragraph, or to 
center or justify it.

Tabs Tab 



Paragraph Border Dialog

Use this dialog box to select borders around the paragraph selected in your design.

 Select the edge(s) you wish to change from the Edit Edge drop-down list or from the Sample 
window as described below.

 Make changes to the border using the options described below.
 Repeat steps 1 and 2, if you wish to change other edges.
 Click the Lines button if you wish to apply a custom line style to the currently selected edges. 

The Lines dialog box is displayed.
 Click OK.

This dialog box can also appear when you are searching and replacing formatting attributes using the 
Find and Replace commands.

Using the Sample window

The Sample window displays an example of the currently selected border. It is also used to specify 
which edges will be affected when a line style is applied. The small cursor symbols  are used to 
mark the edges that will be affected. 

You can select an edge directly in the Sample window by clicking on it with the mouse. Multiple edges 
can be selected by holding the Shift key down while you click. The outer edges (i.e. the top, bottom, 
left, and right) may be selected by clicking on the interior.
You can also select one or more edges using the Edit Edge drop-down list.

Options

Edit Edge. Click on the drop-down list to select an edge. Select Outline to select all edges. 
You can also select one or more edges using the Sample window as described above. Select Middle to 
set the line type for lines between selected paragraphs.

Style. Choose a line style from the drop-down list.
Apply Style. Click on one of these predefined styles to apply that line style to the currently 

selected edges.
Clearance. Specify the distances between each edge and the paragraph in the Above, Below, 

Left and Right fields.
Bounds. Choose how you want the border to bound the text. Choose Margins if you want the 

border to extend to the page margins. Choose Indents if you want the border to extend only to the 
paragraph indents. Choose Text if you want the border to extend only to the text within.

Color. Choose a border color from the drop-down list. You can also define your own custom 
colors, if you wish.



Format / Borders

Shortcut keys: Alt+T,O

Create border lines around objects. You can create several styles of borders, as well as controlling 
their placement relative to the text.

Frame Border Dialog

Use this dialog box to select borders around the frame selected in your design.

 Select the edge(s) you wish to change from the Edit Edge drop-down list or from the Sample 
window as described below.

 Make changes to the border using the options described below.
 Repeat steps 1 and 2, if you wish to change other edges.
 Click the Lines button if you wish to apply a custom line style to the currently selected edges. 

The Lines dialog box is displayed.
 Click OK.

Using the Sample window

The Sample window displays an example of the currently selected border. It is also used to specify 
which edges will be affected when a line style is applied. The small cursor symbols  are used to 
mark the edges that will be affected. 

You can select an edge directly in the Sample window by clicking on it with the mouse. Multiple edges 
can be selected by holding the Shift key down while you click. The outer edges (i.e. the top, bottom, 
left, and right) may be selected by clicking on the interior.
You can also select one or more edges using the Edit Edge drop-down list.

Options

Edit Edge. Click on the drop-down list to select an edge. Select Outline to select all edges. 
You can also select one or more edges using the Sample window as described above.

Style. Choose a line style from the drop-down list. You can also simply click on appropriate 
line style in the Apply Style section.

Color. Choose a border color from the drop-down list. You can also define your own custom 
colors, if you wish.



Format / Tabs

Shortcut keys: Alt+T,T

Set and alter tabs and their alignment. Default tabs are positioned every quarter inch from the left 
margin to the right margin. You can replace these pre-set tabs by adding your own.

You can create left, right, centered, and decimal aligned. There are two ways you can create and edit 
tab stops: 

On the ruler using the mouse.
From the Tabs dialog box as described below.

Changing Tabs with the Mouse 

Tabs Dialog

Note: This dialog box also appears if you click the Tabs tab on the Paragraph dialog box.

How to Set Tabs 
How to Clear Tabs 
How to Delete Tabs 



How to Set Tabs

 In the Set Tabs At box, enter the position¾relative to the left margin¾where you want to place 
a tab. You can specify a tab's position to 1/100th of an inch.

 Choose a type of leader, if you wish.
 Choose an alignment type.
 Click Set. The tab is added to the Set Tabs At list.
 Repeat steps 1 through 4 to set additional tabs, if necessary.

When you're finished, click OK.
Tabs Dialog 
How to Clear Tabs 
How to Delete Tabs 



How to Clear Tabs

 Click on an existing tab position in the Set Tabs At list.
 Click Clear. The tab is placed in the Clear Tabs At list. If you change your mind, you can select 

a tab from this list and click Set to place it back in the Set Tabs At list. To clear all the tabs, click Clear 
All.

 Repeat steps 1 through 2 to clear additional tabs, if necessary.
When you're finished, click OK.

Tabs Dialog 
How to Set Tabs 
How to Delete Tabs 



How to Delete Tabs

 Click on an existing tab position in the Set Tabs At list.
 Click Delete. The tab is permanently removed.
 Repeat steps 1 through 2 to delete additional tabs, if necessary.

When you're finished, click OK.
Tabs Dialog 
How to Set Tabs 
How to Clear Tabs 



Format / Bullets

Shortcut keys: Alt+T,L

Create bullet paragraphs, which can begin with round, diamond, or character bullets. The bullet 
appears on the left side of the paragraph. You can control the size and color of the bullet, and also its 
position relative to the text.

Formatting Bullets

Bullet Dialog

 Select the type of bullet by clicking on one of the Type options.
 Make additional selections for the type of bullet selected, if you wish. 
 Select the bullet color, if you wish.
 Make horizontal and vertical positioning selections, if you wish.
 Click OK.

This dialog box can also appear when you are searching and replacing formatting attributes using the 
Find and Replace commands.

Options

Type. Select the type of bullet: round, diamond or character. Select None to remove the 
bullet.

Round. Click on one of the standard size round bullets or enter a custom size.
Diamond. Click on one of the standard size diamond bullets or enter a custom size.
Character. Enter the ANSI character number in the Character field or select the character 

using the control to the right. Use the Font and Point Size drop-down lists, if necessary. Note: if you 
are scrolling through characters, you should select the font first in order to see the proper characters.

Color. Select the desired bullet color from the drop-down list of standard colors. You can also 
define your own custom colors, if you wish.

Horz. Pos. Specify the distance between the bullet and the paragraph.
Vert. Pos. Specify the vertical position of the bullet relative to the default position (0), which 

is centered. A positive value moves the bullet up; a negative value moves the bullet down.



Format / Lines

Shortcut keys: Alt+T,N

Choose a line thickness and type for graphic objects you create with the drawing tools, as well as 
frame borders. This command is only active when your are in object (pointer) mode. However, this is 
the same dialog box that appears when you click Lines from the Paragraph Border dialog box.

Lines Dialog

 Make your line selections using the options described below.
 Click OK.

Options

Type. Choose the line type desired. You may choose to have no line, or a single or one of 
several double lines.

Thickness. Choose from predefined line thickness or enter any thickness in the Thickness 
field. If you select a double line, enter a thickness for each line, as well as the distance between lines 
in the Separation field. By default, the thickness is specified in points, but you may enter the value in 
inches or centimeters by following the number with the letters in or cm (e.g. 1.00in or 2.54cm).



Format / Shades

Shortcut keys: Alt+T,H

Apply a shade or fill pattern to an object, frame, or paragraph background.

Shades Dialog 



Shades Dialog

 Make your shading selections using the options described below. The Sample window displays 
your current selections.

 Click OK.
This dialog box can also appear when you are searching and replacing formatting attributes using the 
Find and Replace commands.

Options

Shades. Click on one of the pre-defined shades or enter any custom shade value from 0 
(white) to 100% (solid color).

Patterns. Click on one of the pre-defined fill patterns.
Foreground Color. If you have selected a shade, then this field specifies the color for the 

shade. If you have selected a pattern, then this field specifies the color to be used for the black 
portion of the pattern. You can also define your own custom colors, if you wish.

Background Color. If you have selected a pattern or blend, then this field specifies the color 
to be used for the white portion of the pattern. If you have selected a shade, this color is a blend of 
the Foreground and Background colors.. You can also define your own custom colors, if you wish.

Patterns. Click on one of the pre-defined fill patterns.
Blend. Lets you blend colors across the shade. If this is set to anything other than Solid, it will 

override the Patterns. Blends go from Foreground Color to Background Color. See the Blend dialog box 
for more information.



Blend Dialog

Use this dialog box to specify information for blended shades. Blends go from Foreground color to 
Background color. 

 Make your blend selections using the options described below. The Sample window displays 
your current selections.

 Click OK.

Options

Foreground. Choose the color and level (shade) to go from. Select a pre-defined level or 
enter one in the Level field. See also Defining New Colors.

Background. Choose the color and level (shade) to go to. Select a pre-defined level or enter 
one in the Level field. See also Defining New Colors.

Blend. Choose the type of blend you want. Watch the Sample window to see how the 
selection affects the blend.



Format / Wrap To Label Bounds

Shortcut keys: Alt+T,R

This command controls whether or not text wraps in a text frame.

 If checked, wraps text in a text frame according to its current size. Use the Set Wrap Margin 
command to set the wrap space. 

If unchecked, expands the text frame to accommodate the amount of text. 



Format / Set Wrap Margin

Shortcut keys: Alt+T,E

Add additional wrap space within a text frame. The Wrap to Margins feature must be "checked" to be 
able to set the warp margins.

Wrap Margins Dialog

Use this dialog box to specify the amount of space between the text and the text frame. 

 Enter the additional distance for the wrap margins.
 Click OK.



Design Editor Insert Menu

Menu Command Description

Insert Field Insert an automatic field.

Insert Picture Insert a picture.

Insert Symbol Insert a special character symbol into the design.

Insert Playlist Field Insert one or more playlist fields into the current or new text frame.

Insert Merge Field Insert merge fields into the design.

Set Merge File Set the merge file.



Insert / Insert Field

Shortcut keys: Alt+I,E

Insert a special field at the current cursor position into your document. You must be in Text Mode to 
use this feature. If you highlight an existing field, this command changes to Edit Field.

Inserting Special Text
Inserting Merge Fields

Insert Field Dialog / Special Fields Tab

 In the Field Type list, click on the field type, such as Date. A list of available Data selections 
appears in the Data list for the field type you have selected. See Field Types and Data Selections 
described below.

 Click on the Data selection. For example, if you selected the Date field type, you might select 
October 5, 1998 as the Data selection. Selections involving the date and/or time display your system's 
date and/or time when this dialog box was opened.

 If the Settings button is active for a selected Field Type, you may make additional selections. 
See Field Types and Data selections described below.

 Click OK.

Field Types & Data Selections

Auto Number. Inserts a field that generates a number. You may choose either Legal (e.g. 1., 
1.1, 1.1.1, etc.) or Outline (e.g. I, A, i, a, etc.) numbering.

Date. Inserts the current date. Choose from a number of date formats or click Settings to 
enter your own custom format in the Date/Time Format dialog box.

Time. Inserts the current time. Choose from a number of time formats or click Settings to 
enter your own custom format in the Date/Time Format dialog box.

File Name. Inserts the file name of the design. Choose either the full path or only the base 
file name.

User Information. Inserts any of the fields from the User Info tab of the Program Options 
dialog box.

Merge Field. Inserts a merge field. If a database is selected, the Data list will contain the 
available fields from that database. Otherwise, the list will contain Field One, Field Two, etc., which 
represents the fields of the database in the order they are defined. Click Settings to select a database 
from the Set Merge File dialog box.

Print Date. Inserts the date the design was last printed. This field is updated each time you 
print your design. Choose from a number of date formats or click Settings to enter your own custom 
format in the Date/Time Format dialog box.

Print Time. Inserts the time the design was last printed. This field is updated each time you 
print your design. Choose from a number of time formats or click Settings to enter your own custom 
format in the Date/Time Format dialog box.

Serial Number. Inserts a serial number, which is incremented each time it is printed. Click 
Settings to change the operating characteristics of the number in the Serial Number dialog box.



Date / Time Format Dialog 

Use this dialog box to enter your own custom date and/or time format in the Insert Field dialog box. 

 Enter a string which consists of codes from the table below. These strings are used to build the 
date and/or time. You can also enter miscellaneous characters, such as commas, hyphens, slashes and 
so on. Notice that the resulting data is displayed above the string as you enter it, according to your 
system's current date and time when the Insert Field dialog box was opened. 

For example:    dddd, mmm d, yyyy / H:MM AM 

might result in:    Monday, October 05, 1998 / 9:32 PM
 Click OK. The custom format is displayed in the Data list of the Insert Field dialog box.
Inserting Special Text

Options

Field String Meaning Example
Date m Month (numeric) 1

mm Month (numeric 2 
digits)

01

mmm Month (abbr.) Jan
mmmm Month (full) January
d Day 2
dd Day (2 digits) 02
ddd Day of week (abbr.) Wed
dddd Day of week (full) Wednesday
yy Year (2 digits) 98
yyyy Year (4 digits) 1998

Time H Hour (12 hour) 1
HH Hour (12 hour, 2 digits) 01
h Hour (24 hour) 13
hh Hour (24 hour, 2 digits) 13
M Minutes 5
MM Minutes (2 digits) 05
S Seconds 9
SS Seconds (2 digits) 09
AM AM/PM PM

Serial Number Field Dialog

Use this dialog box to change the operating characteristics of the serial number entered in the Insert 
Field dialog box.

 Make your selections using the options described below.
 Click OK. 

The custom format is displayed in the Data list of the Insert Field dialog box.

Inserting Special Text

Options

Current Value. The current value of the field.
Minimum Value. The initial value.
Increment. The number that should be added to the field to increment it.
Maximum Value. The largest value the field should be allowed to increment to before it is 

reset to the minimum value.
Reset after printing. If checked, the serial number field is reset to the minimum value after 

a print job is complete.
Zero Fill. This will zero fill the number (i.e. 0000001 instead of 1).



Insert / Insert Picture

Shortcut keys: Alt+I,P

Insert a picture into the text at the current cursor position. 

Note: This command differs from the Object Tools menu command to create a picture in that the 
picture is inserted into the text rather than attached at an absolute position on the design. In this way, 
the picture will move with the surrounding text.

Adding Images 
More About Inserting Your Own Images 

New Picture Dialog

 Select the file name of the picture you wish to insert using the options described below. 
Navigate to a different drive and/or folder, if necessary.

 Click OK.
This dialog box also features Windows' 
What's This Help. To see an explanation of a 
particular option, right-click over the option, 
and then select What's This?.

Options

Preview. Click on a file name and click Preview to see a thumbnail of the picture in the 
Preview window.

Always Preview. Check this option to always show a preview of the selected file in the 
Preview window.

Save with Document. Check this option if you want the picture saved with the document. 
The original file containing the picture will no longer be needed.

Merge. Check this option to display the New Picture / Merge dialog box, which lets you use 
the file as a merged picture field.



More About Inserting Your Own Images

Adding Images 
If you are inserting images which are your own, chances are you will need to edit the image in an 
image editor before you insert it into CD Labeler. In the interest of making sure that the image you 
use does not cause problems in CD Labeler, you will need to take into account a few attributes of the 
image.

Resolution. If you are scanning an image into CD Labeler be sure to set the resolution of the 
scanner to 200 dpi or less. This will keep the file size of the image down while still providing excellent 
image quality which matches most printers highest print settings. (A 720 dpi printer does not print at 
720 screen resolution, it prints closer to 200 dpi screen resolution).

If you already have an image, with a resolution higher than 200 dpi, you can or course use that image 
in CD Labeler. While it is not imperative that you change the resolution, it might be wise to use an 
image editor to change the resolution to something more manageable.

Color Depth. Another setting, found on most scanning software, is the color depth. Color 
depth is measured in bits. Many newer scanners can scan in 30 bit color. This is nice to have, but most 
computer video cards won't use anything beyond 24 bit color, and most printers can't do any better 
than 16 bit color (which still looks really nice). The higher the color depth the larger the file size of the 
image will be. We recommend that you scan at 16 bit color, we are sure that you will not be 
disappointed by the results.

If you have an image that was already scanned at a higher color depth, an image editing program can 
reduce the color depth of the image which you can then save as another file name (so as to keep the 
original in all it's glory)

Print Size. Much like using a Xerox machine, the print size can be changed when scanning an 
image as well. Most scanning software will allow you to blow up or reduce the size of the final print by 
percent. We recommend using 100%. The reason behind this is the final file size of the image.

Final print size can be altered on an image that already exists as well. Using an image editing 
program. Some editing programs deal in inches and centimeters and some deal in pixels or dots. Just 
remember, DPI is dots per inch (or pixels per inch). If you have an image that is 5 inches by 5 inches 
at 200 dpi, it will be 1000 pixels by 1000 pixels. The math being 5 inches X 200 dots per inch = 1000 
dots

If your image program makes you re-size in pixels, keep the final count down to no more than 1000 
by 1000.

Final File Size. If an image that is 5 inches by 5 inches is scanned at 100% print size at 200 
dpi and 16 bit color depth, will result in a file size of roughly 3 megabytes. This is somewhat large but 
definitely manageable by CD Labeler. If you were to scan at 150% the size would increase to roughly 
6.5 megabytes (don't ask about the math). This, while still somewhat manageable allows little room to 
add any more images to your design.



New Picture / Merge Dialog

This dialog box is used to select a merge field from the current Merge Database to use as a picture 
field. The field should contain a fully specified path to a supported picture type in all the records. 

This dialog is displayed when you check the Merge option in the New Picture dialog box.

 Click on the field you wish to use as the picture merge field.
 Click OK. 

The Merge field in the New Picture dialog box will be checked and the field name will be 
displayed.

Note: You can change the field name by clicking on the Merge box twice. The Merge dialog box is 
displayed again. 



Insert / Insert Symbol

Shortcut keys: Alt+I,Y

Insert a symbol character at the current cursor position into your design. You must be in Text Mode to 
use this feature. 

Insert Symbol Dialog

 Select the font that contains the symbol you wish to insert from the drop-down list.
 Click on a symbol in the preview window to select it.
 Click Insert to insert the currently selected symbol into your design. 
 If you wish to insert another symbol, change the insert point if necessary in your design. Then 

repeat steps 1 through 3.
 Click Close.

Note: You can switch back to your design and change the cursor position at any time without closing 
this dialog box. This is useful for multiple insertions of one or more symbols.

Options

Font. This drop-down list lets you view the characters in a particular font. In most cases, you 
can find the symbols you need in Normal Fonts – All Characters (the default font in this dialog box) or 
Normal Fonts – Special Characters.



Insert / Insert Merge Field

Shortcut keys: Alt+I,M

Insert merge fields at the current cursor position into your design. Merge fields can be User Info, 
Merge Data from a merge file or Special Fields, such as date, time, filename and so on. You must be in 
Text Mode to use this feature. 

Inserting Merge Fields

Working with Merge Fields

 Click on the tab you wish to use and select the field you wish to insert as described below.
Note: Check the New Frame box if you wish to insert the field into a new text frame.

 Click Insert.
 If you wish to insert another field, change the insertion point if necessary in your design. You 

can switch back to your design and change the cursor position at any time without closing this dialog 
box. Then repeat steps 1 and 2.

 Click Close.

User Info Tab

Inserts any of the fields from the User Info tab of the Program Options dialog box. This is the same as 
choosing User Info from the Insert / Insert Field dialog box.

Merge Fields Tab

Set Merge File. Click this button to display the Set Merge File dialog box, which lets you 
select the database to use. Then follow the steps described above.

Merge Fields. If you have a database selected, the Merge Fields list box will contain a list of 
the available fields from that database. Otherwise, the list will contain Field One, Field Two, etc., which 
represents the fields of the database in the order they are defined.

Special Fields Tab

Inserts one of many different types of special fields. This is the same as using the Insert / Insert Field 
command.

Play List Tab

Inserts playlist fields by highlighting the field and clicking Insert. This is the same as using the Insert / 
Insert Playlist Field command.

Working with Playlists 



 Insert / Set Merge File

Shortcut keys: Alt+I,I

Specify the database to be used for merging. Each time a design is printed, each merge field (see the 
Insert / Insert Field command) in the design will be replaced by the associated field from a record of 
the database.

Inserting Merge Fields

Set Merge File Dialog

 Select the file you wish to open. Navigate to a different drive and/or folder, if necessary.
 Click Set.

This dialog box also features Windows' What's This 
Help. To see an explanation of a particular option, 
right-click over the option, and then select What's 
This?.

Options

List files of type. Select the type of database you want to merge from the drop-down list. 
The type you choose here determines the available files in the file list.

Use first record for field name. Check this option to use the first record of the database for 
the field names. This is useful for Comma Delimited databases, which do not have field names.

Clear Merge File. Check this box and click Clear to clear the merge file that is currently 
associated with this design.



Design Editor Playlists Menu

Menu Command Description

Playlist Manager Select a playlist from your playlist database to use on the label. Edit and 
manage your playlist database enrites.

Insert Playlist Field Insert one or more playlist fields into the current or new text frame.

Edit Playlist Contents Create and edit playlist information. Create a database of playlists.

Get Contents from CD 
Retrieve playlist information stored on the CD or search for this information 
online.

Display Playlist Data Toggle playlist fields and actual playlist data.



 Playlist Manager / Apply Playlist 

Shortcut keys: Alt+P,A

Apply any playlist from the Playlist Manager to the current design.

Working with Playlists 

Playlist Manager Dialog

The Current playlist, if any, is displayed under the Playlists in Document heading.

To apply an existing playlist:

 Click on the playlist you wish to apply under the Playlist Database Selections heading.
 Click OK.

Note: You can also simply double-click on the playlist to automatically apply it and close the 
dialog.

To create a new playlist:

 Click on New under the Playlists in Document heading.
 Click OK. The Edit Playlist dialog is displayed.

Note: You can also simply double-click New to automatically go to the Edit Playlist dialog.
 Create your playlist as described in the Edit Playlist dialog.

Options

 Playlist Manager. Click this button to display the Playlist Manager dialog, which allows you to 
edit and maintain the playlists in your database.



Insert / Insert Playlist Field or Playlists / Insert Playlist Field

Shortcut keys: Alt+I,L or Alt+P,I

Insert one or more playlist fields into the current or new text frame. You can insert one or more fields 
at the text insertion point, highlight existing text or fields and replace them, or even create a new 
frame.

Working with Playlists 

Insert Field Dialog / Play List Tab

 Click on the Play List tab, if it is not already displayed.
 Click on the field you wish to insert.
 Click Insert.
 Insert other fields, if you wish.
 Click Close.

Options

New Frame. Check this box if you wish to insert the currently-selected field into a new frame.



Playlists / Edit Playlist Contents

Shortcut keys: Alt+P,E

Create and edit playlist information. Create a database of playlists.

Note: We suggest you import the CD contents whenever possible to save time creating your playlists. 
Then you can edit any information you wish.

Working with Playlists 

Edit Playlist Dialog

This dialog will look different, depending on if your label is for an audio/music CD or a digital data CD.

If your label is for an Audio (music) CD, the tabs displayed will be General, Tracks and 
Database, as described below. See Audio Playlist Options for details.

If your label is for a digital data CD, the tabs will be General, File List and Files, as described 
below. See Data Playlist Options for details.

 Click on any of the tabs, depending on the information you wish to edit. See below and the 
tutorial Working with Playlists for details about using each of these tabs.

 When you're finished, click OK.

Options

Click the 
 button to copy the current playlist to the Windows clipboard.

Click the 
 button to paste the current playlist from the Windows clipboard.

Click the 
 button to retrieve playlist information stored on the CD or search for this information online.



Audio Playlist Options 

These tabs and their corresponding options are used when you are working with the Playlist Contents 
of an audio CD.

Note: We suggest you import the CD contents whenever possible to save time creating your playlists. 
Then you can edit any information you wish.

See Data Playlist Options if you're working with a data CD.

General Tab

Enter general information about your audio CD.

Options

Title. Enter the CD's title.
Artist. Enter the CD's artist(s).
No. of Tracks. Enter the number of tracks on the CD.
Playtime. Enter the CD's total playtime.
Type. Enter the type, or genre, of the music.

Tracks Tab

Enter specific information about each track on your audio CD. They are displayed on the tracks tab as 
you add them.

Options

Title. Enter the song title.
Artist. Enter the song's artist.
Playtime. Enter the song's playtime.
Type. Enter the type, or genre, of the song.
New button. Adds the existing track information to the playlist, if information has already 

been entered, and clears the fields for your next entry.
Add button. Adds the current track information to the playlist.
Change button. Highlight the track you wish to change, change the information, and then 

click the Change button.
Delete button. Highlight the track you wish to delete and then click the Delete button. This 

deletes the label information, not the file itself.
Click the 

 button to move the highlighted track up once each time you click this button.
Click the 

 button to move the highlighted track down once each time you click this button.

Database Tab

Apply tracks from your existing playlist database. This is useful when you are creating a playlist from 
various CDs. 

Double-click on a CD title in the CDs column to display or hide the individual tracks in the CD.

Options

Click the 
 button to add the CD or track information highlighted in the CDs column to the Current Tracks 

column.
Click the 

 button to remove the track information highlighted in the Current Tracks column.
Click the 

 button to remove all the track information in the Current Tracks column.



Data Playlist Options

These tabs and their corresponding options are used when you are working with the Playlist Contents 
of a data CD.

Note: We suggest you import the CD contents whenever possible to save time creating your playlists. 
Then you can edit any information you wish.

See Audio Playlist Options if you're working with an audio CD.

General Tab

Enter general information about your data CD.

Options

Type. Enter the type of data CD. This can be any type of identifying label you wish to use.
Name. Enter the CD's volume label name or some other type of descriptive name, if you wish.
Size. Enter the number of megabytes used on the CD.

File List Tab

Enter specific information about each file on your data CD. They are displayed on the File List tab as 
you add them.

Options

Filename. Enter the name of the file.
Path. Enter the path name where the file is located on the CD.
Short Name. Enter the file's eight character filename. This corresponds to the old MS-DOS 

eight character limit, such as BACKG~12.BMP.
Size. Enter the size of the file, usually in kilobytes (KB), such as 12,526.
Date. Enter the date the file was created or last modified, such as 1/26/99.
Time. Enter the time the file was created or last modified, such as 8:05PM.
Type. Enter the type of, such as BMP, Image, Picture or simply File.
New button. Adds the existing file information to the playlist, if information has already been 

entered, and clears the fields for your next entry.
Add button. Adds the current file information to the playlist.
Change button. Highlight the file you wish to change, change the information, and then click 

the Change button.
Delete button. Highlight the file you wish to delete and then click the Delete button. This 

deletes the label information, not the file itself.
Click the 

 button to move the highlighted file up once each time you click this button.
Click the 

 button to move the highlighted file down once each time you click this button.

Files Tab

Apply files from any removeable storage device, such as a floppy disk or your CD-ROM drive on your 
computer. Double-click on the storage device (or click the + sign) to display its folders and files.

Options

Click the 
 button to add the folder or file highlighted in the left column to the Files (right) column.

Click the 
 button to remove the folder or file highlighted in the Files column.

Click the 
 button to remove all the folders and files in the Files column.



 Playlists / Get Contents from CD
Shortcut keys: Alt+P,G or Ctrl+D

Retrieve playlist information stored on the CD or search for this information online.

Working with Playlists 
You must have a CD in the CD-ROM drive to retrieve playlist information from it. If the CD does not 
contain title and track information, you can alternately search online for this information. CD Labeler 
searches the Internet Playlist Server specified on the Internet tab of the Program Options dialog.
You can also add your own CD contents using the Edit Playlist dialog.



Playlists / Display Playlist Data or Display Playlist Fields

Shortcut keys: Alt+P,D

Toggle playlist fields and actual playlist data.

Working with Playlists 



Playlists / Playlist Manager

Shortcut keys: Alt+P,M

Select a playlist from your playlist database to use on the label. Edit and manage your playlist 
database enrites.

Playlist Manager Dialog

 Perform any of the actions described under Options below.
 Click Apply or Close, as described below.

Options

Click the 

 button to retrieve playlist information stored on the CD or search for this information online.
Click the 

 button to add the selection to the playlist database.
Click the 

 button to create a new playlist the Edit Playlist dialog. You can also do this by double-clicking the 
New option under Local on the screen.

Click the 

 button to edit the selected playlist using the Edit Playlist dialog.
Click the 

 button to delete the selected playlist from the database.
Apply button. Applies the selected playlist to the active design and closes the Playlist 

Manager dialog.
Cancel/Close button. Closes the Playlist Manager dialog without applying the selected 

playlist. 
Note: Whether you exit the Playlist Manager using either the Apply or Cancel/Close button, any edits 
performed on playlists stored within the Playlist Database will be saved and reflected in any designs 
which use them.



Design Editor Tools Menu

Menu Command Description

Object Tools 

Line Tool Create a line.

Rectangle Tool Create a rectangle.

Rounded Create a rounded rectangle.
Rectangle
Tool

Ellipse Tool Create an ellipse.

Text Frame Tool Create a frame for text.

Text Effect Tool Create a text frame with special effects.

Picture Tool Create a frame for a picture.

OLE Object Create an OLE object.

Transparency Tool Set transparency in a picture.

Crop Tool Set cropping in a picture.

Table

Insert Table Insert a table into the design.

Edit Rows Edit the table row attributes.

Edit Cells Edit the table cell attributes.

Insert Rows Insert a row into the table.

Insert Columns Insert a column into the table.

Delete Cells Delete cells from the table.

Select Table Select the current table.

Select Rows Select rows in the current table.

Select Columns Select columns in the current table.

Object Properties Edit properties of the selected object.

Object When the OLE object is selected in your design, the command changes to 
reflect the types of actions you can perform.

Object Links Edit the OLE object links (on linked objects only).

Group/Ungroup Groups or ungroups objects that are currently ungrouped ot grouped.

Bring to Front Bring object(s) to the front of other objects.

Send to Back Send object(s) to the back of other objects.

Guides

Show Guides Toggle the display of alignment guides on the design.

Snap to Grid Toggle snap to grid.

Snap to Guides Toggle snap to guides.

Set Grid Set grid and guide options.

Edit Horz. Guides Edit Horizontal Guide positions.

Edit Vert. Guides Edit Vertical guide positions.



Backgrounds

Browse SmartDesign Backgrounds 
Browse a wide variety of backgrounds that come with CD Labeler.

Choose Custom Background 
Select a background created using another program.

Choose Background Shade 
Select shades and blends for your background when you're not using a picture 
for a background.

Clear Background Clear the background image. The result is either no background or the current 
background shade, if one is set.

Background Properties 
Change the properties of the background image applied to your design.

Designs

Duplicate Design Duplicate design(s). Same as the Edit / Duplicate Design command.

Delete Design Delete design(s) when more than one design exists. Same as the Edit / Delete 
Design command.

First Design Go to the first design in the current block.

Previous Design Go to the previous design in the current block.

Next Design Go to the next design in the current block.

Last Design Go to the last design in the current block.

Regenerate Design Regenerates the original design.

Define Colors Define your own custom colors for text or objects.

Program Options Set preferences for several options used throughout the program.



Tools / Object Tools

Create a line. Hold the Shift key while drawing to 
create a horizontal, vertical, or 45° angled line.

Create a rectangle. Hold the Shift key while drawing 
to create a square.

Create a round-corner rectangle. Hold the Shift key 
while drawing to create a round-corner square.

Create an ellipses. Hold the Shift key while drawing 
to create a circle.

Create a text frame. A text frame is a graphic object 
that contains text.

Create a text frame with special effects. 

Create a picture frame into which you can import an 
image file.

Create an OLE object frame. After you draw the 
frame you will be prompted by the system for the 
type of object to insert.

Set transparency in a picture.

 

Set cropping in a picture.

    Tools / Object Tools / Line Tool

Shortcut keys: Alt+O,J,L

Create a line. Hold the Shift key while drawing to create a horizontal, vertical, or 45° angled line. 
Double-click on the line or open the Tools menu and choose Object Properties to edit its properties as 
described below.

Edit Line Dialog

 Make changes to the selected line using the options described below.
 Click OK.

Options

From / To. The From and To fields determine the coordinates of the line relative to the top-
left corner of the page. This is useful for specifying an exact size and position. Otherwise, it may be 
easier to use the mouse.

Thickness. Click on a pre-defined thickness option to change the width of the selected line or 
enter a line thickness (in points) in the Thickness field.

Color. Select a line color from the drop-down list. You can also define your own custom colors, 
if you wish.



    Tools / Object Tools / Rectangle Tool

Shortcut keys: Alt+O,J,R

Create a rectangle. Hold the Shift key while drawing to create a square. Double-click on the rectangle 
or open the Tools menu and choose Object Properties to edit its properties in the Rectangle dialog box.

Rectangle Dialog 



Rectangle Dialog

Use this dialog box to change the properties of the selected rectangle object in your design. 

 Click on the appropriate tab in the dialog box to make changes to the selected rectangle using 
the options described below. The Sample window displays your current selections.

Click Shades on the Properties tab if you wish to select a shade or fill pattern for the rectangle 
in the Shades dialog box.

Click Lines on the Properties tab if you wish to select a line style for the rectangle in the Lines 
dialog box.

Click Corners on the Properties tab if you wish to customize the rounded corners of the 
rectangle in the Rectangle Corners dialog box.

 Click OK.

Size/Position Tab

Position. Enter the rectangle's size and position on the design. Its position is measured from 
the top-left corner of the design. This is useful for specifying an exact size and position. Otherwise, it 
may be easier to use the mouse. 

How to Resize an Object with the Mouse
Wrap Margin. Enter values for the rectangle's wrap margin. The wrap margins determine how 

close text in your document may appear above, below, or to either side of the object before wrapping. 

How to Change Wrap Margins with the Mouse

Properties Tab

Line Style. Select a pre-defined line style or click Lines to choose more options in the Lines 
dialog box.

Color. Select the rectangle's line color from the drop-down list. You can also define your own 
custom colors, if you wish.

Wrap. Select the type of wrap from the drop-down list. None allows text to flow over the 
rectangle, ignoring its wrap margins. Line allows text to jump over the rectangle and continue below 
it. Text allows text to wrap around all sides of the rectangle.

Square. Check this option to make the rectangle a square. Note: You can create squares by 
holding down the Shift key while drawing or resizing a rectangle with the mouse.

Rounded Corners. Check this option to make the rectangle have rounded corner. All four 
corners will be beveled.



    Tools / Object Tools / Rounded Rectangle Tool

Shortcut keys: Alt+O,J,O

Create a round-corner rectangle. Hold the Shift key while drawing to create a round-corner square. 
Double-click on the rectangle or open the Tools menu and choose Object Properties to edit its 
properties in the Rectangle dialog box.

Rectangle Dialog 



Rectangle Corners Dialog

Use this dialog box to customize the rounded corners of the selected rectangle.

 Make changes to the width and height of the corner curve.
 Check the Rounded Corners option if you want the rectangle to be round-corner rectangle, all 

four corners will be beveled.
 Click OK.



    Tools / Object Tools / Ellipse Tool

Shortcut keys: Alt+O,J,E

Create an ellipses. Hold the Shift key while drawing to create a circle. Double-click on the ellipse or 
open the Tools menu and choose Object Properties to edit its properties in the Ellipse dialog box as 
described below.

Ellipse Dialog

 Click on the appropriate tab in the dialog box to make changes to the selected ellipse using 
the options described below. The Sample window displays your current selections.

Click Lines on the Properties tab if you wish to select a line style for the ellipse in the Lines 
dialog box.

Click Shades on the Properties tab if you wish to select a shade or fill pattern for the ellipse in 
the Shades dialog box.

 Click OK.

Size/Position Tab

Position. Enter the ellipse's size and position on the design. Its position is measured from the 
top-left corner of the design. This is useful for specifying an exact size and position. Otherwise, it may 
be easier to use the mouse. 

How to Resize an Object with the Mouse
Wrap Margin. Enter values for the ellipse's wrap margin. The wrap margins determine how 

close text in your document may appear above, below, or to either side of the ellipse before wrapping. 

How to Change Wrap Margins with the Mouse

Properties Tab

Line Style. Select a pre-defined line style or click Lines to choose more options in the Lines 
dialog box.

Color. Select the ellipse's line color from the drop-down list. You can also define your own 
custom colors, if you wish.

Wrap. Select the type of wrap from the drop-down list. None allows text to flow over the 
ellipse, ignoring its wrap margins. Line allows text to jump over the ellipse and continue below it. 
Text allows text to wrap around all sides of the ellipse.

Circle. Check this option to make the ellipse a circle. Note: You can create circles by holding 
down the Shift key while drawing or resizing an ellipse with the mouse.



    Tools / Object Tools / Text Tool

Shortcut keys: Alt+O,J,T

Create a text frame. A text frame is an object that contains text. Double-click on the text frame or 
open the Tools menu and choose Object Properties to edit its properties in the Text Frame dialog box 
as described below.

Adding Text Frames 

Text Frame Dialog

 Click on the appropriate tab in the dialog box to make changes to the selected text frame 
using the options described below. You can return the properties to their defaults at any time by 
clicking Default.

 Click Border if you wish to select the style of border for the text frame in the Frame Border 
dialog box. 

Click Shades if you wish to select a shade or fill pattern for the ellipse in the Shades dialog 
box.

Click Set Default if you wish to return the text frame to its default settings.
 Click OK.

Position Tab

Position. Enter the text frame's size and position on the page. Its position is measured from 
the top-left corner of the design. This is useful for specifying an exact size and position. Otherwise, it 
may be easier to use the mouse.

How to Resize an Object with the Mouse
Wrap Margin. Enter values for the text frame's wrap margin in inches. The wrap margins 

determine how close text in your document may appear above, below, or to either side of the frame 
before wrapping.

How to Change Wrap Margins with the Mouse

Properties Tab

Wrap Text. Check this option if you want text contained within the text frame itself to wrap 
around any objects placed within the frame.

Wrap. Select the type of wrap from the drop-down list. None allows text to flow over the text 
frame, ignoring its wrap margins. Line allows text to jump over the text frame and continue below it. 
Text allows text to wrap around all sides of the text frame.

Rotation. Select from one of four rotations from the drop-down list: 0, 90, 180 and 270 
degrees.

Alignment. Select from one of four vertical alignments from the drop-down list: Top, 
Bottom, Center and Flush.

Margins Tab

Margins. Enter the one or more margins between the edge of the text frame and the text. 
You can also change the margins with the mouse by holding down the Shift key while you follow the 
same procedure for resizing an object with the mouse. Instead of being resized, the text margins will 
be set. 

How to Resize an Object with the Mouse

Growth Tab

Horizontal. Controls horizontal growth of the text frame as you enter text. Select an option 
from the drop-down list: Fixed selects a normal fixed width text frame. Align Left. allows the text 
frame to grow horizontally leaving the left edge of the text frame at the current position. Align 
Center allows the text frame to grow horizontally leaving the center of the text frame at the current 
position. Align Right allows the text frame to grow horizontally leaving the right edge of the text 
frame at the current position.



Vertical. Controls the vertical growth of the text frame as you enter text. Select an option 
from the drop-down list: Fixed selects a normal fixed height text frame. Align Top allows the text 
frame to grow vertically leaving the top edge of the text frame at the current position. Align Center 
allows the text frame to grow vertically leaving the center of the text frame at the current position. 
Align Bottom allows the text frame to grow vertically leaving the bottom edge of the text frame at 
the current position.

Maximum. Enter the largest width/height that the text frame should be allowed to grow to. 
This only has an effect on growing text frames.

Minimum. Enter the smallest width/height that the text frame should be allowed to shrink to. 
This only has an effect on growing text frames.

Columns Tab

Columns allow you to flow text more efficiently in text frames. They are especially useful for track or 
file listings, where you have many titles.

Number. Sets the number of columns for the text frame.
Gutter. Controls the distance between columns.
Height. Controls the height of the column area. Auto will balance the text in columns 

automatically.
Line Between. Allows you to choose a line style to be drawn between columns.
Facing Columns. Available for two-column text frames. Allows the alignment of the text in 

the two columns to be complementary, as set in the Alignment Setting below.
Alignment. Available when facing columns is set. Align to Inside sets the left column to right 

justified and the right column to left justified. Align to Outside sets the left column to left justified and 
the right column to right justified.

Tip: For CDs, use facing columns to allow playlists to wrap naturally around the shape of the CD. Align 
to Inside keeps the titles close to the center, Align to Outside wraps the titles near the edge of the CD.

Note: There is a special paragraph alignment setting when using facing columns called Default. This 
allows the text to follow the column alignment rules as described above and is automatically set 
when you choose Facing Columns. If you want to override this setting, select the text and set it 
using the Paragraph Alignment option from the Control Strip.



    Tools / Object Tools / Text Effect Tool

Shortcut keys: Alt+O,J,F

Create a text frame with special effects. Double-click on the Text Effect frame or open the Tools menu 
and choose Object Properties to edit its properties in the Text Effect dialog box as described below. 

The Text Effects Wizard guides you through the process of creating just the right text effect for your 
design. We recommend you use the wizard whenever possible, then double-click on the object to 
make minor changes to its properties.

Tutorial: Creating Text Effects 

Text Effect Dialog

Click the Effect tab and type in the text you want to display in the text window. You can enter 
multiple lines by pressing Ctrl-Enter. Click Preview to see the text in the sample window.

Click on the appropriate tab in the dialog box to make changes to the text using the options 
described below. 

Click Lines on the Properties tab if you wish to select a line style for the ellipse in the Lines 
dialog box.

Click Shades on the Properties tab if you wish to select a shade or fill pattern for the ellipse in 
the Shades dialog box.

 Click OK.
Note: Font and color can be applied to text effects without going into the dialog box. Click on the text 
effect frame first. Then choose the font from either the Variation Bar or the Control Strip. Choose the 
color from the Control Strip.

Using the Sample window

The Sample window displays your text effect frame with the current options. Click the Preview button 
to update the window.

Effect Tab

Variation. Select a variation style from the drop-down list.
Style. Select a text style from the drop-down list.
Height. Select a character height from the drop-down list. Height is only available for some 

effects (the ones that are considered sizeable).
Shadow Direction. Use the arrow buttons to position the text effect shadow.
Special Effects Control Bar. Use the control bar just below the sample window to choose 

from a variety of special effects, font and alignment. Hold the mouse over each effect to see what it 
does. Some effects open additional dialog boxes from which you can choose settings.

Text. Type in the text you want to display here. You can enter multiple lines by pressing Ctrl-
Enter. Click Preview to see the text in the sample window.

Position Tab

Position. Enter the text effect frame's size and position on the page. Its position is measured 
from the top-left corner of the design. This is useful for specifying an exact size and position. 
Otherwise, it may be easier to use the mouse.

How to Resize an Object with the Mouse
Frame Margin. Enter the text effect frames margins. This affects the overall size of the text 

effect image.
Wrap Margin. Enter values for the text frame's wrap margin in inches. The wrap margins 

determine how close text in your document may appear above, below, or to either side of the frame 
before wrapping.

How to Change Wrap Margins with the Mouse
Text Margin. Specify the distance as a percentage from the bounding rectangle to the bounds 



of the actual effect. 
Wrap. Select the type of wrap from the drop-down list.
Rotation. Enter the degree you wish to rotate the text effect.
Square. Check this box to create a square text effect frame. If you subsequently resize the 

frame, it remains square, keying off the width of the box.

Type Tab

Use this tab to select the shape of your effect. Use the navigational buttons near the bottom left of the 
window or the scroll bar to the right of the thumbnails to scroll through the types of effects. Click on 
an effect to select it. Your effect is displayed in the preview window on the Effect tab. 

Note: You can double-click on the effect to select it and close the dialog box.

Samples Tab

Use this tab to select from a variety of pre-set shading and color combinations for your effect. Scroll 
the list to see more color variations. Check or uncheck the boxes along the bottom to toggle on/off 
different aspects of the effect such as drop shadows, text outline and text color..



Text Effect Frame Dialog

Use this dialog box to make changes to the frame's position, margins and text wrapping properties.

You can also use the Text Effect Wizard to create a text effect object.

 Click on the appropriate tab in the dialog box to make changes to the frame using the options 
described below. 

 Click OK.
Tutorial: Creating Text Effects 

Options

Position. Enter the text effect's size and position on the page, which is measured from the 
top-left corner of the design. It may be easier to change the frame's size and position using the 
mouse, but you can use this dialog if you need to specify an exact size and position. 

How to Resize an Object with the Mouse
Wrap Margin. Enter values for the text effects' wrap margin, which determine close text in 

your document may appear above, below, or to either side of the picture before wrapping. 

How to Change Wrap Margins with the Mouse
Frame Margin. Specify the amount of margin from the bounds of the frame to the text effect
Text Margin. Specify the percentage of margin from the bounds of the text effect to the 

actual text effect. Left and Right values are a percentage of the unrendered width of the text block. 
Top and Bottom are a percentage of the unrendered height of the text block.

Shadow Offset. Specify the percentage to offset the shadow from the actual text effect. 
Horizontal is a percentage of the unrendered width of the text block, Vertical is a percentage of the 
unrendered height of the text block.

Rotation. Specify the amount of degrees to rotate the text effect.
Shades. Displays the Shades dialog box, which lets you specify a color/shade for the text 

effect frame.
Lines. Displays the Frame Border dialog box, which lets you specify the border type for the 

text effect frame.



    Tools / Object Tools / Picture Tool

Shortcut keys: Alt+O,J,P

Create a frame into which you can import an image file. After you draw the frame, the New Picture 
dialog box is displayed, which lets you select the image file. Double-click on the Picture object or open 
the Tools menu and choose Object Properties to edit its properties in the Picture dialog box as 
described below.

Using the Picture Tool 

Picture Dialog

 Click on the appropriate tab in the dialog box to make changes to the selected picture using 
the options described below. 

Click Border on the Properties tab if you wish to select the style of border in the Frame Border     
dialog box.

Click File on the Properties tab if you wish to select a different image file in the Picture File 
Name dialog box.

 Click OK.

Size/Position Tab

Position. Enter the object's position on the design in inches, measured from the top-left 
corner of the design. It may be easier to change the picture's position using the mouse, but you can 
also use this dialog box if you need to specify an exact position. 

How to Move Objects with the Mouse
Size. Enter the size of the picture, in inches or as a percent of the original picture's size. It 

may be easier to change the picture's size using the mouse, but you can also use this dialog box if you 
need to specify an exact size. 

How to Resize an Object with the Mouse
Wrap Margin. Enter values for the picture's wrap margin in inches. The wrap margins 

determine how close text in your document may appear above, below, or to either side of the picture 
before wrapping. 

How to Change Wrap Margins with the Mouse
Maintain Aspect Ratio. Click this option to keep the original aspect ratio of the picture if it is 

resized. This prevents your picture from becoming distorted.

Properties Tab

Save w/Document. Click this option to save the picture in the document. This will lose the 
link to the original file. This option will be automatically checked and dimmed.

Save as compressed. Click this option to save and compress the picture in the document, 
resulting in a significantly smaller file. This option is only available for bitmap, TIFF, and PCX picture 
formats.

Wrap. Select the type of text wrapping. Select None for no text wrapping, that is, text flows 
over the picture, ignoring its wrap margins. Select Line for text to jump over the picture and continue 
below it. Select Text for text to wrap around all sides of the picture.

Note: The Wrap option is only available for pictures added using the Object Tools / 
Picture Tool command on the Tools menu or the Picture Tool on the Control Strip). The 
Wrap option is not available for pictures which are inserted into the text via the Insert 
Picture command on the Insert menu.

Rotations. Select from one of four rotations for bitmaps (0, 90, 180 and 270 degrees) or 
choose any arbitrary angle for Windows Metafiles.

Foreground Color. Select the foreground color for the picture. If you select Full Color, the 
picture is displayed, using its original colors.

Background Color. Select the background color for the picture. If you selected Full Color for 



the foreground color, the background color is ignored.
Transparent Color. Checking this box makes the background color transparent.

Margin/Crop Tab

Margins. Enter the margins between the edge of the frame and the picture. You can use the 
mouse by holding down the Shift key while following the same procedure for resizing the object with 
the mouse. Instead of being resized, the picture margins are set. 

How to Resize an Object with the Mouse
Crop. Enter the left, top, right, and bottom crop values as a percentage of the original 

picture's width and height.



    Tools / Object Tools / OLE Object Tool

Shortcut keys: Alt+O,J,B

Create an OLE object. After you draw the frame you will be prompted by the system for the type of 
object to insert using the Insert Object dialog box, as described below. Double-click on the OLE Object 
frame or open the Tools menu and choose Object Properties to edit its properties in the OLE Object 
dialog box as described below.

Insert Object Dialog

 Click either the Create or Create from File radio button. The Result at the bottom of the dialog 
box explains what will happen.

If Display as Icon is displayed, click it to display the contents as an icon in your design. You 
can change the icon, if you wish.

Click OK.
This dialog box also features Windows' What's This 
Help. To see an explanation of a particular option, 
right-click over the option, and then select What's 
This?.

OLE Object Dialog

 Click on the appropriate tab in the dialog box to make changes to the selected OLE object 
using the options described below. 

 Click OK.

Size/Position Tab

Position. Enter the object's position on the design in inches, measured from the top-left 
corner of the design. It may be easier to change the picture's position using the mouse, but you can 
also use this dialog box if you need to specify an exact position.

How to Move Objects with the Mouse
Size. Enter the size of the object. You may either enter the size in inches or as a percent of 

the OLE object's size. It may be easier to change the object's size using the mouse, but you can also 
do it from this dialog if you need to specify an exact size. 

How to Resize an Object with the Mouse
Wrap Margin. Enter values for the object's wrap margin in inches. The wrap margins 

determine the distance of text each side of the object, or in other words, how close text in your 
document may appear above, below, or to either side of the object before wrapping. 

How to Change Wrap Margins with the Mouse
Maintain Scale Factor. Click this option if you wish for the scale factor to remain constant if 

the object's size changes.
Maintain Aspect Ratio. Click this option if you wish for the original aspect ratio of the object 

to be preserved when it is resized.

Properties Tab

Wrap. Choose the type of wrap from this pull-down menu. Choose None for no text wrapping, 
that is, text will flow over the object, ignoring its wrap margins; choose Line if you want text to jump 
over the object and continue below it; choose Text if you want text to wrap around all sides of the 
object.

Margins. Enter the margins between the edge of the frame and the object. You can change 
the margins with the mouse by holding down the Shift key while you follow the same procedure for 
resizing the object. Instead of being resized, the object margins will be set.



 Tools / Object Tools / Transparency Tool

Shortcut keys: Alt+O,J,Y

Set transparency in a picture.

 Select the picture you wish to change. 
 From the Tools menu, choose Object Tools and then Transparency Tool.
 Click on the color in the picture you wish to make transparent. The color will change to white.



 Tools / Object Tools / Crop Tool

Shortcut keys: Alt+O,J,C

Set cropping in a picture.

Note: You can also crop the picture manually using the Size/Position tab in the Picture dialog box.

 Select the picture you wish to change. 
 From the Tools menu, choose Object Tools and then Crop Tool.
 Click on the sizing handle in the picture and move it to crop the picture. You can click on other 

handles to continue cropping, if you wish.



Tools / Table / Insert Table

Shortcut keys: Alt+O,T,T

Insert a table into the design.

New Table Dialog

 Enter the number of rows and columns for the table. You must have at least one row and one 
column.

 If you wish to include space around the text in each cell, enter the amount of space in the 
Left, Right, Top and Bottom fields under Margins.

 Click OK.

Options

Number of Rows. Enter the number of rows in the table, or use the spinners to select a 
number.

Number of Columns. Enter the number of columns in the table, or use the spinners to select 
a number.

Margins. Enter the new margin amount: Left. Space between the text and the left margin of 
each cell. Right. Space between the text and the right margin of each cell. Top. Space between the 
text and the top of each cell. Bottom. Space between the text and the bottom of each cell.



Tools / Table / Edit Rows

Shortcut keys: Alt+O,T,R

Edit the table row attributes.

Edit Table Row Dialog

 Make changes to the selected row(s) using the options described below.
 Click OK.

Options

# Columns. Enter the new number of columns, or use the spinners to select a number.
Min. Height. Enter the new minimum height of the row. The row will not go below this height 

no matter the size of the text or how many lines.



Tools / Table / Edit Cells

Shortcut keys: Alt+O,T,C

Edit the table cell attributes.

Edit Table Cell Dialog

 Make changes to the selected cell(s) using the options described below.
 Click the Border, Grid or Shade buttons if you wish to format your table with these features. 

The Border, Grid or Shades dialog box is displayed.
 Click OK.

Options

Width. Enter the new cell width.
Align Baselines. Check this checkbox if you wish to align the cell text with the text baseline.
Margins. Enter the new margin amount: Left. Space between the text and the left margin of 

each cell. Right. Space between the text and the right margin of each cell. Top. Space between the 
text and the top of each cell. Bottom. Space between the text and the bottom of each cell.



Tools / Table / Insert Rows

Shortcut keys: Alt+O,T,I

Insert a row into the table.



Tools / Table / Insert Columns

Shortcut keys: Alt+O,T,N

Insert a column into the table.



Tools / Table / Delete Cells

Shortcut keys: Alt+O,T,D

Delete cells from the table.



Tools / Table / Select Table

Shortcut keys: Alt+O,T,L

Select the current table.



Tools / Table / Select Rows

Shortcut keys: Alt+O,T,S

Select rows in the current table.



Tools / Table / Select Columns

Shortcut keys: Alt+O,T,E

Select columns in the current table.



Edit Table Dialog

Use this dialog to specify selected table properties.

 Click either the Properties tab or Wrap tab.
 Make changes to the selected table using the options described below.
 Click the Grid, Border or Shade buttons if you wish to format your table with these features. 

The Grid,    Border or Shades dialog box is displayed.
 Click OK.

Properties Tab

Position. Enter the position properties of the table: Horizontal. Distance from the left edge 
of the text frame. Vertical. Distance from the top edge of the text frame. Width. Total width of the 
table. Height. Total height of the table.

Tabbing Adds Rows. Check this checkbox if you wish to add rows below the current row by 
pressing the Tab key.

Wrap Tab

Wrap. Select the type of wrapping from the drop-down list.
Wrap Margin. Enter additional wrap space for each table margin.



Tools / Object Properties

Shortcut keys: Alt+O,E

Display properties for the selected object or group of objects. The properties in the dialog box are 
related to the selected object.

You can also double-click an object to display its properties. 

Working with Objects 

Objects with Properties

Line
Rectangle
Round Corner Rectangle
Ellipse
Text Frame
Picture Frame
Text Effect
Group
OLE Object



Tools / Object

Shortcut keys: Alt+O,O

This option is dependent on the type of OLE object selected. When the OLE object is selected in your 
design, the command changes to reflect the types of actions you can perform. For example, if it is 
linked to a bitmap in a Paint program, the command will show Bit Image Object, with additional 
options being Edit, Open and Convert.



Tools / Object Links

Shortcut keys: Alt+O,L

This option is only enabled for linked OLE objects. This lets you change the properties of the OLE links.



Tools / Group/Ungroup

Shortcut keys: Alt+O,G

Ungroups objects grouped in SmartDesigns to maintain design relationships when they grow or shrink.

Ungrouping Objects 



Group Dialog

Use this dialog box to change the properties of frames that have been grouped in your design using 
the Tools / Group command. 

 Make changes to the selected group using the options described below. Click on the 
Size/Position or Properties tab to see more options.

 Click OK.

Size/Position Tab

Position. Enter the group's position on the page in inches. Its position is measured from the 
top-left corner of the design.

Wrap Margin. Enter values for the group's wrap margin in inches. The wrap margins 
determine how close text in your document may appear above, below, or to either side of the group 
before wrapping. 

How to Change Wrap Margins with the Mouse

Properties Tab

Note: These fields will affect only groups with autogrow text frames inside of them. These options are 
only for limiting growth, they will not shrink a group that has already exceeded any of the numbers 
here.

Horizontal. Select group auto growth horizontal alignment from the drop-down list: None, 
Left, Center, or Right. Enter the maximum width to allow the group to grow to in the Max field. 
Check the Independent option to allow all growing text frames to be set to a maximum width equal 
to the Max field. If this option is not checked, all growing text frames are set to a maximum width 
equal to the width in the Max field, minus the group's current width, plus the text frame's current 
width.

Vertical. Select group auto growth vertical alignment from the drop-down list: None, Top, 
Center or Bottom. Enter the maximum height to allow group to grow to in the Max field. Check the 
Independent option to allow all growing text frames to be set to a maximum height equal to the Max 
field. If this option is not checked, all growing text frames are set to a maximum height equal to the 
height in the Max field, minus the group's current height, plus the text frame's current height.



Tools / Bring to Front

Shortcut keys: Alt+O,F

Brings the selected object to the top of the stacking order of overlapping objects, such as graphics and 
text frames.



Tools / Send to Back

Shortcut keys: Alt+O,B

Sends the selected object to the bottom of the stacking order of overlapping objects, such as graphics 
and text frames.



Tools / Guides / Show Guides

Shortcut keys: Alt+O,U,S

Toggles the display of alignment guides on the design.



Tools / Guides / Snap to Grid

Shortcut keys: Alt+O,U,R

Precisely position objects, frames, and tables to the grid increments you specified with the Set Grid 
command. A check mark next to this command indicates that it is active.



Tools / Guides / Snap to Guides

Shortcut keys: Alt+O,U,U

Precisely position objects and frames to any guide lines you may have created in your design. A check 
mark next to this command indicates that it is active.

You can create a guide with the mouse by clicking on the ruler bar (either horizontal or 
vertical) while in object mode and then dragging the mouse into the design. Clicking on the guide 
while in object mode, and then dragging it with the mouse can move a guide. A guide can be deleted 
by clicking on the guide while in object mode and dragging it up to the ruler.

You can create, move and delete guides via the Edit Horz. Guides and Edit Vert. Guides 
commands.



Tools / Guides / Set Grid

Shortcut keys: Alt+O,U,G

Determine the horizontal and vertical grid increments for positioning (snapping) objects and frames.

Set Grid Dialog

 Enter the horizontal and vertical grid measurements you wish your objects to snap to, as 
described below.

Note: By default, the horizontal and vertical grid lines are specified in inches, but you 
may specify them in centimeters or points by following the number with the letters cm 
or pt (e.g. 2.54cm or 72.0pt).

 Enter snap guidelines, if you wish, as described below.
 Click OK.

Options

Horizontal. Enter the distance between the horizontal grid lines. If Snap To Grid is on, when 
objects are moved or sized, they will be forced to align with a multiple of this value.

Vertical. Enter the distance between the vertical grid lines. If Snap To Grid is on, when 
objects are moved or sized, they will be forced to align with a multiple of this value.

Tolerance. Set the tolerance used for the Snap To Guides option. If Snap To Guides is on, this 
is the distance from a guide (in pixels) at which an object's position will be set to the guide position.

Snap Center to Guide. Check this option if you would like guides to snap to the center in 
addition to the bounds of an object.



Tools / Guides / Edit Horizontal Guides

Shortcut keys: Alt+O,U,H

Add, delete, and move horizontal guide lines.

Working with Guides Using the Mouse

Edit Horizontal Guides Dialog 



Tools / Guides / Edit Vertical Guides

Shortcut keys: Alt+O,U,V

Add, delete, and move vertical guide lines.

Working with Guides Using the Mouse

Edit Vertical Guides Dialog 



Guides Dialog

Add, delete, and move horizontal and/or vertical guide lines. Each type has its own dialog box you 
access using the Tools / Guides / Edit Horiz. Guides or Tools / Guides / Edit Vert. Guides commands.

 Choose the Tools / Guides / Edit Horiz. Guides or Tools / Guides / Edit Vert. Guides command. 
The appropriate dialog box is displayed.

 Create, move or delete horizontal and vertical guides as described below.
To create a new guide, enter the position of where you want the new guide in the Position field 

and click Add. The new guide will be added to the list of guides in the list box below. 
To delete an existing guide, click on the guide to be deleted (or enter its position in the 

Position field) and click Delete.
To move an existing guide, click on the guide to be moved, enter a new horizontal position in 

the Position field and click Move.
 Click OK.
Working with Guides Using the Mouse



Working with Guides Using the Mouse

You can add, move and delete horizontal and vertical guides using the mouse, instead of using the 
Guides dialog box. You must be in the object mode.

To add a guide line, click anywhere within the horizontal ruler (for a horizontal line) or vertical 
ruler (for a vertical line) and then drag into the document to the position where you want the guide 
line to be. When you release the mouse button, the guide line appears at that position.

To move a guide line, click on it and drag it to its position.
To delete a guide line, click on it and drag it back to the vertical ruler.

Working with Guides Using the Guides Dialog



Tools / Backgrounds / Browse SmartDesign Backgrounds

Shortcut keys: Alt+O,K,W

Select a background from professionally-designed backgrounds that come with CD Labeler.

Using the Background Browser 



Tools / Backgrounds / Choose Custom Background

Shortcut keys: Alt+O,K,C

Select a picture file as a background, such as clip art or an image created with another program.

Using the Clipart Browser 



Using the Background and Clipart Browsers 

The browser displays thumbnail (representative) views of either the backgrounds or clipart images and 
logos that come with your CD Labeler program, depending on which design tool you have selected.

Using the Backgrounds Browser

Selecting a Background Using the Design Bar 

Using the Clipart Browser

Adding Logos and Clipart 

Using the CD & Media Symbols Browser

Adding Media Related Images 

Adding Backgrounds and Images to the Favorites Folder

You can add your favorite backgrounds and images to the Favorites folder by selecting the thumbnail 
and then clicking the Add to favorites button. You can remove it from the Favorites folder by selecting 
the thumbnail and then clicking the Remove from favorites button.



Tools / Backgrounds / Choose Background Shade

Shortcut keys: Alt+O,K,S

Choose from colors, shades, patterns and blends to create a background shade rather than using a 
background image.

Shades Dialog 



Tools / Backgrounds / Clear Background

Shortcut keys: Alt+O,K,L

Clear any background image.



Tools / Backgrounds / Background Properties

Shortcut keys: Alt+O,K,P

Make adjustments to background properties applied to your design.

Background Properties Dialog

 Make changes to the background properties as described below.
 Click Apply if you wish to temporarily apply these changes to view them on your design.

Click Reset to Defaults if you wish to return the settings to their defaults.
 Click OK to make the changes permanent.

Options

Stretch to Design w/ Bleed. Typically if you try to print to the precise edge of a label, the 
printer will miss on at least one side. By incorporating a bleed, even if it misses, the label gets even 
coverage on the edges.

Stretch to Design. Stretch the background precisely the edge of the CD label. If you scan a 
commercial CD and wish to use the scanned image as the background for a label, stretching it into the 
bleed area may mean you lose some important information or design elements. So in this case, it may 
be preferable to stretch it only to the limits of the label, and take your chances on where the printer 
hits the label when printing.

Tile Image. Tile the image to cover the label design. This is useful for creating background 
effects.

Center on Design. Center the background on the design label. This is useful to adjust 
backgrounds that need centering.

Background is Printable. Uncheck this option to prevent the background from printing, 
which is useful for saving supplies during testing. You can also uncheck this option in the Print dialog 
box.

Use Background on Both Sides. Print the same background image on both sides of two-
sided labels.

Stretch Factor. Fine tunes the stretch factor in the Stretch options described above.
Brightness. The brightness control lets youne down the density of a background image. This 

makes it easier to put text on top of the image, as well as saves ink.
Retain Properties. Check this box to retain the original properties of the background. This is 

useful to quickly apply or unapply changes you've made to the background.



Tools / Designs / First Design

Shortcut keys: Alt+O,S,F or Ctrl+PgUp

Go to the first design in the current block.



    Tools / Designs / Previous Design

Shortcut keys: Alt+O,S,R or PgUp

Go to the previous design in the current block.



    Tools / Designs / Next Design

Shortcut keys: Alt+O,S,X or PgDn

Go to the next design in the current block.



Tools / Designs / Last Design

Shortcut keys: Alt+O,S,L or Ctrl+PgDn

Go to the last design in the current block.



Tools / Show/Hide Items

Shortcut keys: Alt+O,S,L or Ctrl+PgDn

Show or hide SmartDesign objects in the design area. This is also useful to restore a SmartDesign 
object you deleted by accident.

Show Item Dialog

When you use SmartDesigns, pre-set objects (text frames, clipart, etc.) are created. If you don't want 
to use them, you can select one and delete it. In reality, SmartDesign objects are never deleted, just 
hidden. You can put them back in by checking the item in this dialog box.

 Use the scroll bar, if necessary to see all the design items. 
Check a design item if you wish to show it; uncheck an item if you wish to hide it.

 Click OK.



Tools / Designs / Regenerate Design

Shortcut keys: Alt+O,S,G

Regenerate the SmartDesign for the current design.



Tools / Define Colors

Shortcut keys: Alt+O,D

Define your own custom colors for text or objects.

Colors are mapped. If you change the color named Black to a shade of orange, everywhere the color 
named Black was used in your design will be changed to the color orange. The color palette changes 
affect all designs in the current file. It does not affect colors in other files.

Define Color Dialog

 Do one of the following:
To change an existing color name, click on the name in the Colors list. You may wish to pick a 

color close to the custom color.
To create a new color name, click New and enter a name in the New Color dialog box. Click 

OK. The new name appears at the end of the Colors list, using the currently selected color to start. 
The color can be changed in step 2.

 Change the color using one of the following methods: 
Click on the Select tab and choose the color in the color palette using the mouse.
If you know this information, manually enter the numbers from 0 to 255 to define the Hue, 

Saturation and Luminance and RGB values for a color as described in the options below. 
Click on the Standard tab to choose a standard color. This tab is useful for returning a custom 

color to its default. For example, click on Red in the Colors list, and then click the color red on the 
Standard tab.

 Click Change to apply the new color.
Note: If you click on another name in the color list or click OK, the Define Color Changes 
dialog box is displayed, which lets you: Continue without changing the color, Change the 
color, or Cancel and return to the Define Color dialog box.

Options

Select tab. Use this tab to choose a color from the palette using the mouse.
Standard tab. Use this tab to select a standard color. These are 16 basic colors. The 48 colors 

you see are pre-set colors to which you can easily add for your set of custom colors in the document. 

Clicking on one of these sets the color. This is useful for a starting point on a custom color. For 
instance to create an orange color, you might start with the color in column two, row 4. It is also 
useful for changing a color back to its original definition.

Hue/Sat/Lum. The hue, saturation and luminance of the currently selected color. Numbers 
range from 0 to 255. These numbers change as you select colors using the mouse or can be manually 
entered if you know the correct numbers for the color you want.

Red/Green/Blue. The RGB value of the currently selected color. Numbers range from 0 to 
255. These numbers change as you select colors using the mouse or can be manually entered if you 
know the correct numbers for the color you want.

Color\Solid. Displays the currently selected or specified color, in both dithered and solid 
form. (Windows cannot use dithered colors for text, so the solid form will be used).

New. Create a new color name, which is then added to the end of the Colors list.
Rename. Change the name of a new color you created. You cannot change any of the 48 

basic color names.
Change. Change the color selected in the Color list to the name and color specified.
Delete. Deletes the color selected in the Color list. You can only delete color names you have 

created. You cannot delete any of the 48 basic color names.
OK. Make your changes and apply the currently selected color in the Colors list to the text or 

object in your design.



Defining New Colors

The last item in the list of colors is Define Colors, selecting this item displays the Define Color dialog 
box. After you have defined colors, the color selected in the Define Color dialog box is automatically 
applied.



    Tools / Program Options

Shortcut keys: Alt+O,N

Set preferences for several options used throughout the program. Options are organized using four 
tabs, as shown below.

Options Dialog

 Click on the appropriate tab in the dialog box.
 Make changes as described below.
 Click OK.

Program Options Tab

On Startup Show. Click the appropriate radio button to tell CD Labeler what to do when the 
program is launched. Last used file or template automatically loads the file used when you last quit 
the program. New Label Wizard starts the New Label Wizard which lets you create a new 
SmartDesign. File Open Dialog lets you open a design or template of your choice. Nothing launches 
the program without opening any file.

Generate Backups when Saving. Check this option to automatically generate a backup file 
each time you save a document. The current file will be renamed to a file with the extension .BAK.

Show Pre-printed Stock Backgrounds. Check this option to show any objects that appear 
on the stock, which provides a better representation of what the final output will look like. This will not 
affect how designs are printed.

Drawing Tools Remain Selected. Check this option to continue using a tool until another 
tool is selected. Drawing tools such as the line tool will not switch back to the pointer tool after a line 
is drawn.

Show text wrap margins on objects. Check this option to control how wrap margins of 
objects are displayed. This option is unchecked by default because wrapping is typically not used in 
text frames.

Enable all warning messages. Check this option to control whether or not CD Labeler warns 
you about design conflicts.

Paper Type. Select the default paper type designs are based on.
Display Optimization. Choose the appropriate display optimization. Fastest will result in the 

fastest performance with the greatest screen flicker. Best will result in the least screen flicker but may 
result in slow performance, especially on complex pages or pages with a large number of pictures.

User Information Tab

Enter the information in each field. CD Labeler uses the information for merge fields (see Insert / 
Insert Field) and SmartDesigns (where applicable).

Internet Tab

Internet Playlist Server. This is the URL of database from which CD Labeler retrieves 
playlist information. We recommend you leave this set to Use Default Server, which will then direct 
you a server we know to be good. Press the Servers button to see an alternative list of Servers if you 
are having trouble connecting in your area.

Connect to server without prompting. This is useful if you have a constant online 
connection, or simply don’t want to be bothered with the confirmation prompt. Otherwise, you may 
wish to be prompted.

CD-Text is playlist information recorded directly on your Audio CDs. Unfortunately, not all 
drives support this and, even worse, some cause system crashes when attempting to read CD-Text. 
You should leave this checked unless you are sure your system does not support CD-Text. If a problem 
does arise, CD Labeler will turn it off for you.

Helpful Hint: Even though it is a great feature, most CDs you buy in stores still do not come 
with CD-Text recorded on them. Refer to your CD burning software for details on how you can record 
CD-Text on your Audio CDs.

Proxy Server. Enter the address and port number of the proxy server you wish to connect to. 
If you don’t know what a Proxy Server is or don’t know if you have one, leave this field blank (you 



probably don’t have one).

Appearance Tab

Background Texture. This changes the background texture for the CD Labeler screen. Click 
any texture in the list, or click None for no texture (Windows desktop colors prevail).

Texture Color Treatment. Select between Full Color controlled by CD Labeler or Blend to 
Desktop controlled by Windows Desktop colors.

Icon Color Treatment. Select between Full Color controlled by CD Labeler or Blend to 
Desktop controlled by Windows Desktop colors.



Tools / Options Dialog / General Tab

These options apply to the General Preferences tab found in the Tools / Options dialog box.

Show Speed Tools. Click this option to displays speed tools. Toggle the Show Speed Tools 
command on the View/View Options menu to control this option while you are using the program. See 
Speed Tools.

Show Status Strip. Click this option to display the status strip. Toggle the Show Status Strip 
command on the View/View Options menu to control this option while you are using the program. See 
Status Strip.

Show Control Strip. Click this option to display the control strip. Toggle the Show Control 
Strip command on the View/View Options menu to control this option while you are using the 
program. See Control Strip.

Default New Windows. Click this option if you want the New Window check box to be 
checked for File / New and File / Open.



Design Editor Window Menu

Menu Command Description

Cascade Cascade open document windows.

Tile Tile open document windows.

Arrange Icons Arrange all minimized document windows.

Close All Close all document windows.

Configure Speed Tools Configure the Speed Tools.

Window List List of windows currently open in CD Labeler.



Window / Cascade

Shortcut keys: Alt+W,C

Arranges all non-minimized document windows in a cascade fashion starting in the upper left corner of 
the workspace and moving down and to the right.



Window / Tile

Shortcut keys: Alt+W,T

Tiles all non-minimized documents so all are visible simultaneously.



Window / Arrange Icons

Shortcut keys: Alt+W,I

Arranges all the icons which represent minimized documents.



Window / Close All

Shortcut keys: Alt+W,A

Closes all open designs.



Window / Configure Speed Tools

Shortcut keys: Alt+W,O

Customizes the Speed Tools strip. You can choose which Speed Tools appear on the strip, as well as 
the order they appear on the strip.

Customize Speed Tools Dialog Box

 To add a tool, click on the tool you wish to add in the list, and then click Add (or simply 
double-click the tool). The tool will be added immediately to the speed tool palette.

 To remove a tool, click on the tool you wish to remove in the list, and then click Remove (or 
simply double-click on the tool). The tool will be removed immediately from the speed tool palette.

 Make other changes using the options described below.
 Click Close.

Note: You can configure the tool palette using the mouse by doing any of the following:

Add a tool to the palette by clicking the tool icon below the Add All button and dragging it to 
the palette. 

Remove a tool from the palette by clicking the tool icon on the palette and dragging it off the 
palette. 

Rearrange the order of tools on the palette by clicking any tool on the palette and dragging it 
to a new position.

Options

Tools. Select from this list of tools to add to or remove from the tool palette.
Default. Click this button to install the default set of tools.
Add. Click this button to add the currently selected tool to the palette. If the tool is currently 

on the palette, this button will be grayed.
Add All. Click this button to add all of the tools to the palette.
Remove. Click this button to remove the currently selected tool from the palette. If the tool is 

not currently on the palette, this button will be grayed.
Remove All. Click this button to remove all of the tools from the palette.
Position. Choose the palette's position in the window, which may be along the Top, Bottom, 

Left Edge, Right Edge, or may be Floating.
Close. Click this button when all modifications are complete.



Window / Window List

Shortcut keys: Alt+W,1 through Alt+W,[# windows open]

This is a list of open windows in CD Labeler.



Design Editor Help Menu

Menu Command Description

Contents Bring up the Help table of contents.

SureThing Tutorials Displays a list of online tutorials to help you get started and learn about many 
important features.

Popup Help Toggle whether the popup help is enabled.

Tips of the Day Toggle whether the Tip of the Day dialog box will come up at startup.

Register SureThing Provides information about how to register your SureThing product.

Order Labels Provides information about how to order Microvision labels.

MicroVision on the Web Select from a list of MicroVision web site functions to help get the most 
from your CD Labeler program.

About Template Display information about the particular template that you are working on.

About Display information about CD Labeler (eg. the version number and copyrights).



Help / Popup Help

Shortcut keys: Alt+H,P

Toggle whether the popup help is enabled. Popup help are small windows that appear if you pause 
over a button. This is meant to give you feedback on what exactly the button you are over does. If 
this option is on a checkmark will appear to the left of the text.



Help / Tips of the Day

Shortcut keys: Alt+H,T

Toggle whether the Tip of the Day dialog box will come up at startup, if this option is on a checkmark 
will appear to the left of the text. You can also turn this off in the Tips window when it comes up at 
startup and then turn it on later if you wish.



Help / Register SureThing

Shortcut keys: Alt+H,R

Lets you register CD Labeler online. You must be connected to the Internet to use this command.



Help / Order Labels

Shortcut keys: Alt+H,L

Lets you order labels online. You must be connected to the Internet to use this command.



MicroVision on the Web 

Shortcut keys: see below

This command lets you select from a list of MicroVision's web related activities:

 SureThing News and Special Offers (Alt+H,M,F)
 Support and Updates (Alt+H,M,S)
 Microvision Home Page. (Alt+H,M,M)

The appropriate web site page is opened in your default browser. 

Of course, you must be connected to the Internet to use these commands.



Help / About Template

Shortcut keys: Alt+H,B

Display information about the current template. Click OK to close the window.

Template Information Dialog

Stock Name. As found on the Status Strip and in the New Wizard.
Blocks. The type of labels on the sheet.
Description. Vendor, dimensions, and so on.
Related Templates. Lists 100% compatible label stock, if any.



Help / About

Shortcut keys: Alt+H,A

Display information about CD Labeler (eg. the version number and copyrights).



Keyboard Reference

Design Editor Keyboard



Design Editor Keyboard

Movement Keys

Text Selection Keys

Formatting Keys

Editing Keys

View Keys

Menu Shortcut Keys



Design Editor Movement Keys

To Move Press
Left one character
Left one word Ctrl+
Right one character
Right one word Ctrl+
Up one line
Up one paragraph Ctrl+
Down one line
Down one paragraph Ctrl+

To the beginning of a line Home
To the end of a line End

To the next frame Tab
To the previous frame Shift+Tab

To the first design Ctrl+PgUp
To the previous design PgUp
To the next design PgDn
To the last design Ctrl+PgDn 



Design Editor Text Selection Keys

To Select Press
Previous character Shift+
Previous word Shift+Ctrl+
Next character Shift+
Next word Shift+Ctrl+
Previous line Shift+
Previous paragraph Shift+Ctrl+
Next line Shift+
Next paragraph Shift+Ctrl+

To the beginning of a line Shift+Home
To the end of a line Shift+End

Entire frame Ctrl+A



Design Editor Formatting Keys

To Format Press
Bold Ctrl+B
Italic Ctrl+I
Underline Ctrl+U
Paragraph Ctrl+M
Face name Ctrl+Shift+F
Point size Ctrl+Shift+P
Left justify Ctrl+Shift+L
Right justify Ctrl+Shift+R
Center Ctrl+Shift+E
Flush justify Ctrl+Shift+J
Word underline Ctrl+Shift+W
Single line spacing Ctrl+1
One and a half line spacing Ctrl+2
Double line spacing Ctrl+3



Design Editor Editing Keys

To Delete Press
Next character or selection Del
Selected object Del
Previous character or selection Backspace
Selected object Backspace
Selection and copy to clipboard Shift+Delete or Ctrl+X
Object and copy to clipboard Shift+Delete or Ctrl+X

To Insert Press
Line break Shift+Enter
Paragraph break Enter
Text from clipboard Shift+Ins or Ctrl+V

To Copy Press
Selection to clipboard Ctrl+Ins or Ctrl+C
Object to clipboard Ctrl+Ins or Ctrl+C

To Press
Undo / Redo ALT+Backspace or Ctrl+Z
Select all text in a frame Ctrl+A
Select all objects on a page Ctrl+A



Design Editor View Keys

To View Press
View next document Ctrl+F6
View previous document Ctrl+Shift+F6
Maximize application window ALT+F10
Maximize document window Ctrl+F10
Minimize application window ALT+F9
Minimize document window Ctrl+F9
Restore application window ALT+F5
Restore document window Ctrl+F5



Design Editor Menu Shortcut Keys

All menus and commands have shortcut keys, which you can use instead of using the mouse. For 
example, to select the Format / Bold command, use Alt+F,B. Hold down the Alt key and then press the 
F key. Then press the B key.

Some commands also have shortcut keys that can be used as an alternative way to access the 
command. For example, Ctrl+B also formats bold. Hold down the Ctrl key and then press and B key.

You can view the shortcut keys by simply opening the menus. The shortcut keys are underlined in the 
menu and command name. Additional shortcut keys are shown next to the command name.

 



Tools and Toolbars

Design Bar
Variation Bar
Command Bar
Block Folder
Rulers 
Control Strip
Status Strip
Speed Tools



Design Editor Command Bar

The Command Bar allows you quick access to often-used functions while working with your design. 
You can show or hide the command bar by right-clicking the bar area and choosing Show Command 
Bar or Hide Command Bar.

 
Note: If the Command Bar is hidden, you'll need to precisely point to the edge of where the 
Command Bar is usually displayed, before you right-click. If Show Command Bar does not appear in 
the menu, try again until you see this command.

Options

New. Start a new design, database or template using the New Design Wizard.
Open. Open a previously saved design, database or template. Same as the File / Open 

command.
Save. Save the current design. Same as the File / Save command.
<<Prev. Display the previous design when using multiple designs.
Duplicate. Duplicate design(s). Same as the Designs / Duplicate command.
Next >>. Display the previous design when using multiple designs.
Print. Print designs. Same as the File / Print command.
Preview. Preview the design.
X. Hide the Command Bar.



Glossary

Accent A slight variation based on the layout. Accents typically are lines, rectangles 
and other static objects that highlight certain aspects of the layout.

Database A database is a type of document with one or more records containing one or 
more fields. 

Design This is what the Design Editor helps you create.    A design can be a label, 
brochure, envelope, etc. You may have multiple designs in a SmartDesign Job. 
An item can only appear once in a design.

Document A SureThing file (the filename extension is .STD). A document contains one or 
more designs saved within a single file.

Field This is a part of a database that is in every record. For Instance, in an Address 
Book Database you could have a field Name, which would contain the name of 
the person for each record.

Font A variation based upon the layout and accent that controls what typefaces are 
to be used in the items in a design.

Item This is a part of a design, There are three item types: Text Frame, Text Effects, 
and Pictures. Items are defined by the SmartDesign, and can not be renamed 
or reassigned. In a label SmartDesign there is often an item Name, which is 
where you would put your Name.

Layout A variation that describes things such as what items are on the design, where 
the items are on a design, and the overall look of the design.

Point Size A variation based upon the layout, accent and font that controls what point 
size the typefaces are to use in the items in a design.

Record This is an entry in a database. For Instance, in an Address Book Database you 
could have a record for your Mother, which would have fields with her Name, 
Address, Phone Number, etc.

SmartDesign A SmartDesign is a CD Labeler design creation tool. The SmartDesign is 
responsible for things as simple as the placement and layout of designs on a 
page, to the more complicated aspects of variations of stocks, layouts, 
accents, fonts, and point sizes. SmartDesign is also used to describe the 
documents that the Design Editor creates. A SmartDesign can contain multiple 
designs.

Stock A variation created specifically for a different paper type. All stocks are the 
same type, (ie. the position and size of designs is the same), but the 
appearance of the paper is slightly different (different color, or different design 
on the paper).

Variation A variation is a similar design with different formatting properties. Current 
variations are Stocks, Layouts, Accents, Fonts, and Point Sizes.



Configuring the Control Strip / Status Strip / Speed Tools

Select any of the commands to configure the strip or toolbar on which you have right-clicked.

Hide Hides the strip.

Top Sets the strip to the top.

Bottom Sets the strip to the bottom.

Left Sets the strip to the left.

Right Sets the strip to the right.

Float Sets the strip to a floating window.

Properties Edit the strip or toolbar properties.



Insert Page Dialog

Prompt to reinsert pages after flipping them to print the second side(s) of two sided designs.



Object Change Warning Dialog

This message is displayed when you change a variation in the Variation Bar that could cause some or 
all of the changes you've made to be lost. The types of data that cannot be retained are design object 
size and positioning, design object attributes and certain paragraph and character formatting. 

Click Yes to continue with the new variation or click No to cancel the variation request. 

In order to avoid this message you should make your SmartDesign selections on the Variation Bar 
before moving objects around or overriding formatting, but not necessarily before entering your own 
text. We suggest making them in the following order:

 Find a background, if you plan to use one. Knowing what your background will look like will 
help you select the right layout for your design.

Using Backgrounds
 Choose a layout. This sets the actual information and special logos that will appear on your 

design. There are many different types of objects, which are not used on all layouts. The layout you 
choose should provide the type of information you need on your label. You'll see the layout change as 
you browse through the choices.

Using Layouts
 Set a font for your overall design. You'll see how the font looks as you browse through the 

choices. You can always change individual text later, if you wish.
Using Fonts



Toggle On or Off Variation Controls Switches

Background, Layout, Accent, Font and Size

 
When you right-click over various toolbars in CD Labeler, these switches allow you to toggle (on/off) 
the Variation Controls for backgrounds, layouts, accents, fonts, and point sizes.



Outline Dialog

Type Choose the line type desired. You may choose to have no line, or a single or 
double line.

Thickness Choose from one of the predefined line thicknesses, or enter any thickness in 
the Thickness / Separation / Thickness edit fields below. If a single line has 
been selected, only the first thickness is used. If a double line is selected, you 
may set the thickness of each line as well as the distance between lines. By 
default, the thickness is specified in points, but you may enter the value in 
inches or centimeters by following the number with the letters in or cm (e.g. 
1.00in or 2.54cm).



Zoom in one factor. Same as the View / Zoom In command.



Zoom out one factor. Same as the View / Zoom Out command.



Allow you to zoom in on an area. Click and drag to select are to zoom in on.



Zoom in so entire design / page is visible. Same as the View / Zoom to fit command.



Delete design(s). Same as the Design / Delete command.



Toggle rulers on and off. Same as the View / Show Rulers command.



Insert a merge field into text. Same as the Utilities / Insert Merge Field command.



Display what design you are on, and how many designs are in the current block.



Allow you to traverse through the designs in the current block. The buttons are for First Design, 
Previous Design, Next Design, and Last Design respectively.



Allow you to hide / show items in the current design. Same as the Design / Show Item(s) command.



For two-sided designs only, toggle between Inside and Outside views.



Template Paper Size Dialog

The Template Paper Size Dialog lets you change the paper size and other page oriented fields for the 
template.

Width The width of the paper.

Height The height of the paper.

Orientation The orientation (Portrait or Landscape) of the paper.

Number of Parts The number of parts to the page. This is often used for label mini-sheets.



Template Names/Folders Dialog

The Template Names/Folders Dialog lets you set the name, description and folder for the template.

Name This is the name of the template. Template names must be unique in a folder.

Description This is a description of the template. This description is shown in the new 
dialog when the template is selected.

Place in Folder For templates that are using on SmartDesigns, This checkbox can be 
unchecked to place the Template in every folder where the SmartDesign 
template is located. If checked, you can select a folder from the browse list to 
place the template in.



Picture Warning Dialog

This dialog is displayed on loading a design when a picture inserted into a file could not be found.

Skip Skips this picture, the picture will be shown as a gray rectangle.

Skip All Skips all pictures, all pictures will be shown as a gray rectangle.

File Lets you select a new file to use for the picture.

Cancel Cancels the loading of the file.



Tip of the Day Dialog

This dialog may give you some useful insight on how CD Labeler    works.

Did you know... The tip for this session.

Show Tips at Startup If you uncheck this, you won't see the Tip of the Day dialog every time you 
start up, until you turn it back on with the Help / Tips of the Day menu 
command.

Close This will close the dialog enabling you to start working in CD Labeler.

Next Tip This will bring up the next tip of the day.

More Tips This will bring up the More Tips help topic.



More Tips

These are a selection of tips to using CD Labeler.

If you always want a new window created with the New and Open commands of the File menu, 
you can specify this by choosing the Program Options command from the Tools Menu and checking the 
Default New Windows option in the General folder.

The four most recently used documents are listed at the bottom of the File menu for easy 
access. See File / File History.

When drawing objects, press the Shift key to constrain the object.
Even though CD Labeler usually displays values in inches, you can also specify points or 

centimeters in edit boxes that accept units by appending pt or cm.
You can create horizontal and vertical guides with the pointer tool by clicking and dragging 

from the horizontal or vertical ruler.
Double clicking anywhere inside the speed tools palette opens the Customize Speed Tools 

dialog box.
Check the Use first record for field names option in the Set Database dialog box if you are 

merging from a CSV file, when the first record contains the field names.
If you want to start your designs from scratch rather than basing them on a SmartDesign, 

uncheck the Use SmartDesigns option in the New Label Wizard Note: when creating a design which 
uses a playlist, we recommend you customize a SmartDesign rather than start from scratch. Doing so 
will save you a lot of time and hassle.

You can save a frequently used    as a user template so that you can find it quickly and easily.
You can add a frequently used background to the Favorites list by clicking on Add To Favorites 

in the Background Browser.
You can switch between the I-Beam and Pointer tools using the Right Mouse menu and 

toggling the first option.
You can customize the colors CD Labeler uses by choosing the Define Colors command from 

the Tools menu. You can add all your favorite colors, which will then be available from any color 
selection window.

You can insert serial number fields, with the Insert Field command.
If you want to, you can turn off the tips of the day by turning off the Show Tips of the Day 

checkbox.
You can center objects on a point by using guides, and checking the Snap to center checkbox 

in the Set Grid Dialog box.
You can rotate Windows Metafiles and Text Effects at any arbitrary angle.
By clicking on the sample in the Print dialog box you can tell CD Labeler where you want to 

start printing.
CD Labeler was created by the same company that brought you the award winning Word 

Processor WordExpress.
White text on a black background will only work with LaserJet compatible printers if you turn 

font downloading off.
You can easily set the background color for a label design using the Set Background Color 

command from the Design Bar. This also affects any solid black or white areas that are found in many 
SmartDesigns. 

Setup the user information in the Program Options dialog box. Many SmartDesigns will use the 
information to automatically personalize your designs.

You can change the default units of measurement used by the Rulers and SureThing dialog 
boxes by changing the Regional Settings in the Control Panel.



Designate CD Labeler to open the SmartDesign, template or database in a new window.



Use the first record of the database for the field names.



Clear the current merge file from the SmartDesign.



Preview window of the currently selected picture.



Copy the picture into the DSN/DSU file instead of linking to it.



Automatically preview a file when it is selected.



Preview the currently selected picture.



Set up a merged picture.



Custom Template Error - Total Height

"Total height (# Parts time Page Height) must not exceed page size."

A label sheet may not exceed 16 inches. You have specified that either the page is longer than 16 
inches, or the total height of all the parts is greater than 16 inches.



Custom Template Error - Design(s) off of the Page

"Designs in block exceeds the page bounds."

Signals that the total height of all labels, gutter and margins exceeds the height of the paper. This 
should also be visible in the sample on the page. Check your specifications and try again.



Custom Template Error - Overlapping Designs (different blocks)

"Design in block 1 overlaps design in block 2."

Lets you know that the labels defined in one label block will overlap those in another label block, 
causing printing errors and wasted labels.



Custom Template Error - Overlapping Designs

"Designs in block 1 overlap each other."

Lets you know that the labels overlap each other within the same block. This can only occur when one 
of the gutter settings is a negative number. 



Custom Template Warning - Overlapping Bleed in Design(s)

Bleed in block 1 causes an overlaps in another design.

Alerts you to the fact that you have specified a bleed amount which overlaps into other designs in the 
same label block. This may be intended, but you are alerted since this can cause undesirable printing 
into neighboring labels.



Custom Template Warning - Overlapping Bleed in Design(s) (different 
blocks)

Bleed in block 1 overlaps design in block 2.

Alerts you to the fact that you have specified a bleed amount which overlaps into other designs in a 
different label block. This may be intended, but you are alerted since this can cause undesirable 
printing into neighboring labels.



Custom Template Warning - Overall Size is smaller

"Overall size (bleed+size) in block 1 is smaller...."

Alerts you that the label size is now smaller than the previous template. If this is what you intended, 
some objects may be partially or completely positioned outside of the label bounds. 



Custom Template Warning - Sides Reduced

"The number of sides has been reduced..."

Warns you that you have changed the number of printable sides from 2 to 1. If this is what you 
intended, you will lose any SmartDesign layouts and/or objects you have created on side 2.



Custom Template Warning - SmartDesigns Differ Substantially

""Designs in block(s) differ substantially from..."

This warns you that you have changed the design(s) for the blocks by a larger amount. If this is what 
you intended, some of your design(s) may not appear as they were originally intended to.



Invalid Picture Format

Although picture files can sometimes be corrupt, most likely you received this error message because 
you tried to insert a picture file that is in a format CD Labeler does not support.

Follow these steps to see which formats are supported.

 Click OK to close the error message.
 Click on the drop-down arrow in the Files of type field to see the file types CD Labeler 

supports.
Note: With All Pictures selected in the Files of type field, only supported picture filenames are 
displayed in the dialog box. If you don't see it, it is not supported.

You may wish to use image conversion software to convert your picture file to a supported picture 
format and then insert it into your design.    Click here to go to Jasc Software, makers of Paint Shop 
Pro, an excellent image conversion tool.



Paper Feeding Tips

Running label sheets and card stock through an inkjet or laser printer is not an exact science. In fact, 
due to all the mechanical parts in a printer, it is extremely difficult to hit the sheet in exactly the same 
spot twice. Here are a few tips to help you achieve the greatest success.

This End First…

CD Labeler tells you which end of the paper to feed into the printer first. Just look at the sample in the 
Print Dialog and notice the little red arrows. This helps eliminate guesswork while inserting labels into 
your printer.

Remember: you will always feed paper in a portrait orientation into your printer.    The red arrows tell 
you which end should be fed first.

Printer Paper Feeding Quirks

When a printer grabs a sheet of labels or card stock, the precision that it feeds it through the paper 
path is less than desirable. The sheets will shift slightly each pass through the printer, and there is not 
much you can do about it.

In most of today’s better printers, this shift is very slight, perhaps a 1/16 or 1/32 of an inch. As a 
printer gets older, however, some of the mechanical parts develop a bit more slop and you may notice 
larger shifts from sheet to sheet.

The best advice we can provide is not design anything critical too close to the edge of the label. You 
can often bleed backgrounds over the edge of a label to ensure complete coverage, but text or logos 
too near the edge may very likely end up either partially or completely off the label. How close is too 
close? Experience with your printer will provide the answer.

Printer Non-Printable Areas

You cannot print to the edge of a sheet of paper on any printer. There is typically a margin around the 
edge of the sheet that is called the ‘non-printable’ area. If you have label sheets that have labels 
positioned within that non-printable area, you will be unable to print on the entire label.

For laser printers, this is typically a 0.25-inch margin on all sides. Inkjet printers need more. They 
typically need about a 0.25-inch margin on the left and right side, but need at least a 0.5-inch margin 
on the top and bottom (and often need even more).

Again, there is nothing you can do about the non-printable area. You can change label vendors, 
however. You can usually find a vendor that has taken this into consideration, and has left ample room 
around all sides to accommodate most any printer.

Printer Calibration

A similar problem is that not all printers start at the same offset from the top left edge of the paper. 
This means that, without correction, you would never hit the labels on target. Luckily this is something 
that can be addressed by the software.

You will need to register the offsets your printer uses by performing a Print Calibration. You will find 
the Print Calibration command on the File Menu.

Label Storage Tips

To help avoid many of the paper feeding problem described above, store your labels somewhere to 
minimize physical damage. Find a cool location, and store them flat on a shelf. This will help minimize 
the edges from developing a ‘curl’, something printers find difficult to deal with.



Get CD Info from Internet?

This message confirms that you want to access CD information from the Internet. You must be online 
to search for CD information on the Internet. The database searched is designated on the Internet tab 
in Tools>Program Options.

You can suppress this message if you wish by checking the Don’t Ask Me Again checkbox.



Select Playlist Type

This dialog is displayed if you have not yet designated your label as either an audio or data CD.

Click on the Audio/Music CD option if you are creating a label for a CD used to store audio 
tracks.

Click on the Digital Data CD option if you are creating a label for a CD used to store data files.



Replace Playlist Data Warning

This message is displayed when you have playlist data displayed and you either switch to Display 
Fields or you try to insert a new playlist field.

If you have changed text in those fields, then those changes will be lost if you click Yes to proceed. 

Check the Don't ask me again checkbox if you do not wish to see this warning (not recommended if 
you're in the habit of adding text to your playlist data. 

Click No to return to the design without doing anything. 



Replace Playlist Data Warning

This message is displayed when you use the Edit Playlist, Get CD Info or Playlist Manager commands. 
CD Labeler warns you that you are about to replace existing playlist information with new information, 
which will be lost if you click Yes to proceed. 

Check the Don't ask me again checkbox if you do not wish to see this warning (not recommended if 
you're in the habit of adding text to your playlist data. 

Click No to return to the design without doing anything. 



SureThing Setup Wizard
Welcome
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Welcome to SureThing CD Labeler! This is the SureThing Setup Wizard and is only displayed the first 
time you run SureThing CD Labeler. We encourage you to take a minute to walk through it.

The following few screens will quickly gather some useful information to help you get the most out of 
using CD Labeler. Additionally, it will introduce you to a few important features and where you can 
customize them later.

In just a few clicks, you’ll be creating eye-popping CD labels with an ease you never thought possible. 
Enjoy!



SureThing Setup Wizard
The SureThing Desktop
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You can easily customize the general appearance of CD Labeler. Keep it fresh, change with your 
moods, or find the look that feels right for you.

There are a couple of things to note:

 Background Textures apply to the SureThing Desktop and to most Wizards. If you think the 
text is a little hard to read with one, try another. 

 Text Treatment allows you to blend the background texture to your Windows Desktop theme 
or use them in full color. Blending ensures the SureThing Desktop will be color coordinated with your 
Windows desktop at all times, and also ensures the most readable text in Wizards.

 Icon Treatment allows you to display the Design Bar icons blended or in full color. Blending 
makes the icons appear more subtle on your desktiop, while coming to life in full color when the 
mouse passes over them.

Note: These options can be changed later in Tools/Program Options from the Appearance tab.



SureThing Setup Wizard
Album Collections
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SureThing CD Labeler v3 does a lot of things to make labeling music CDs easier. An important feature 
is the ability to grab information from your Audio CDs and import the playlist information into your 
designs.

CD Labeler does this in one of two ways: by reading the information directly from the CD if possible 
(CD-Text) or looking it up from a database on the Internet.

Things to note:

 Internet Access. You can choose to have CD Labeler prompt you each time before accessing 
the Internet or have it automatically. If you have a constant Internet connection (DSL, Cable Modem, 
etc) we encourage you to always check. 

 CD-Text is playlist information recorded directly on your Audio CDs. Unfortunately, not all 
drives support this and, even worse, some cause system crashes when attempting to read CD-Text. 
You should leave this checked unless you are sure your system does not support CD-Text. If a problem 
does arise, CD Labeler will turn it off for you.

Helpful Hint: Even though it is a great feature, most CDs you buy in stores still do not come 
with CD-Text recorded on them. Refer to your CD burning software for details on how you can 
record CD-Text on your Audio CDs.

Note: These options can be changed later in Tools/Program Options from the Internet tab.



SureThing Setup Wizard
User Information
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CD Labeler uses information about you in many of its preformatted designs (SmartDesigns). Take a 
moment to enter the information now, and you’ll save yourself time later.

If any of the fields do not apply to you, delete the sample text that might have been included. CD 
Labeler will print any text specified, whether it was entered by you or is a remnant from the sample 
text.

Helpful Hint: If you are an individual and not associated with a company, you might include 
your name in the Company Name field also. In designs which incorporate both Name and 
Company Name, you can then decide which you like best and want to keep, and which you 
would like to delete.

Note: These options can be changed later in Tools/Program Options from the User Info tab.



SureThing Setup Wizard
Finish
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Congratulations! You are now ready to begin using SureThing CD Labeler. We hope you find it an 
enjoyable and productive experience.

If you’ve never used CD Labeler before, we encourage you to leave the Quick Start option checked. 
This will direct you to a series of mini-tutorials to help you get up to speed on many of the features 
found in CD Labeler. You can also always find the tutorials from the Help menu.

Once you click finish, the next screen presented will be to choose a label type to start you on your 
way.    For more information on starting your first design, go to Creating a New Design.

Click Finish to get started.



Create a New Design?

This message can be displayed as you are scrolling through multiple sets and reach the last design. 
The Next button becomes a New button, allowing you to create a new design and duplicate the current 
one, if you wish.



Audio or Data CD?

If you’ve received this message, it is because you’re attempting to read the contents of a CD or 
inserting playlists fields into a design and CD Labeler doesn’t know what type of CD label you want to 
create. Select the type and press OK.

In the future, you’ll find it much easier to use an Audio or Data SmartDesign from the New Label 
Wizard. This will insert all the necessary fields and lay them out on the label in an attractive layout. 
Even if you want to customize it yourself, it is a great time-saving shortcut to start with a SmartDesign 
for these types of labels.



CD-Text Incompatibility Detected

If you’ve received this message, your system probably crashed while attempting to obtain playlist 
information from an Audio CD. This happens because there is a driver incompatibility with your CD-R 
drive which prevents applications from accessing CD-Text.

SureThing has turned off reading CD-Text until you can find out the source of the problem and find a 
solution. You will still be able to get playlist information from the Internet.

Once you have solved the problem, go to Program Options from the Tools menu, select the Internet 
tab and check the Enable CD-Text option.



Format / Background Objects

SmartDesigns often include objects that are placed in a background layer, to simplify the selection of 
text objects in the foreground. These are typically black or white backgrounds that help the text stand 
out against a colorful background. Other times, wrap objects have been placed on a design to control 
how text wraps around the center of a CD, for example.

If you would like to modify these objects, select this command. The background objects will then be 
selectable and you can change any of their properties.

Tip: If you just want to change the color of all background objects, you can set the background color 
for the design. 



SureThing Playlist Plus!

SureThing Playlist Plus! is a new utility that automatically integrates Windows Media Player XP with 
SureThing CD Labeler. This means no more re-typing playlists into CD Labeler, just use Playlist Plus! 
and your information is instantly transferred to your CD label. 

Playlist Plus! integrates with CD Labeler by reading Windows Media Player Playlists to create a new CD 
label or jewel case insert. It works with either pre-existing playlists or by allowing Windows Media 
Player to read playlist information from a CD. This works great for compilation CDs so that you can 
print a label when you burn the CD with minimal effort.

Playlist Plus! is actually a separate program that talks to both Windows Media Player and CD Labeler. 
You can start Playlist Plus! in one of three ways:

 From within Windows Media Player. The easiest way to start Playlist Plus! is when you 
need it from within Windows Media Player XP. Just go to the File menu and look for Print Label. This 
is especially convenient when you are burning a CD and want to print a label immediately.

 From within CD Labeler. You can also start Playlist Plus! from within CD Labeler. Look on the 
Playlist menu and choose Playlist Plus!. This allows you to grab a playlist from within Windows Media 
whenever you need it.

 From the Windows Start Menu. We have also included an entry in the SureThing group on 
the Windows Start menu. While this is not always the most convenient way to start Playlist Plus!, you 
can always find it there.

Helpful Hint: Playlist Plus! will always create a new label, even if you are currently working on a label 
design in CD Labeler. Check the Playlist Plus! Help system for more tips on using Playlist Plus!
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